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Data Analysis and
Processing

e “Configuring a Model for Importing Data” on page 1-2
e “Creating an Estimation Project” on page 1-3

* “‘Importing Data into the GUI” on page 1-5

® “Plotting and Analyzing Data in the GUI” on page 1-11
® “Preprocessing Data in the GUI” on page 1-14



1 Data Analysis and Processing

Configuring a Model for Importing Data
Before you can analyze and preprocess the estimation data, you must assign
the data to the model’s channels. In order to assign the data, the Simulink®

model must contains one of the following elements:

® Top-level Inport block

Note You do not need an Inport block if your model already contains a
fixed input block, such as a Step block.

® Top-level Outport block

® Logged signal. The logged signal can be a top-level signal in the model
or a signal in the model subsystem.

For more information about the blocks and logged signals, see the Inport
and Outport block reference pages and “Logging Signals” in the Simulink
documentation.

In the Control and Estimation Tools Manager GUI, the rows in the Input
Data tab correspond to the model’s top-level Inport blocks. Similarly, the
rows in the Output Data tab correspond to either the top-level Outport
blocks or logged signals in the model.

Adding an Inport or Outport block or marking a signal for logging creates a
new row in the corresponding Input Data or Output Data tab. You can use
the new row to import estimation data for the corresponding signal. To view
the new row, click Update Task in the Estimation Task node of the Control
and Estimation Tools Manager GUI.



Creating an Estimation Project

Creating an Estimation Project

Before you begin data import, you must create and set up an estimation
project by configuring the appropriate parameters, solvers, and cost functions.
Simulink® Design Optimization™ software provides a Graphical User
Interface (GUI) that makes setting up the estimation project quick and easy.

To create an estimation project:
1 Open the nonlinear idle speed model of an automotive engine by typing :
engine_idle_speed
at the MATLAB® prompt.

The model appears as shown next.

E!engine_idle_speed ;IEI ll

File Edit Wiew Simulation Format Tools Help

O SE&| +BER|Es 4|9 2| » nf o | e B

Idle Speed Engine Model
Copyright o) 2002-2004 The MathWorks, Inc.

Maonlinearities  Linear Dynamics

in1
gaint dle

Speed

Walve
Waoltage

den(z)
Transfer Fen

gainz
> 1)
BPAY deniz) Engine Speed
Transport Transfer Fend
Delay
gain3
deniz)
Double click here Frac) Transfer Fon2
to open
Parameter Estimation
Gl with preload data Click on the Start button in the GUIto
run an estimation.
Ready [100% [ [ |ode4s Y

The model contains the Inport block BPAV and Outport block Engine Speed
for importing input and output data, respectively. To learn more, see
“Configuring a Model for Importing Data” on page 1-2.
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2 Open the Control and Estimation Tools Manager GUI by selecting Tools
> Parameter Estimation in the Simulink model window.

E! Control and Estimation Tools Manager =] 3]
File Wiew Help
& 0 = @ |[@
4:\ Warkspace ~Task setting:
=T Project - engine_idle_speed Title: I
[ER=N |=stimation Task
(1) Transient Data Subject: I
Wariables Author: I
Estimation
Ea Walidation Campany! I
Description: ;I
=
Model: engine_idle_speed Open Model Update Task |
4
[
Select the nodes below ko configure and run estimations. v

Control and Estimation Tools Manager GUI

The project tree displays the project name Project - engine_idle_speed.
Estimation tasks are organized inside the Estimation Task node.

Note The Simulink model must remain open to perform parameter
estimation tasks.
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Importing Data into the GUI

In this section...

“Importing Time-Domain Data into the GUI” on page 1-5
“Importing Time-Series Data into the GUI” on page 1-10

“Importing Complex Data into the GUI” on page 1-10

Importing Time-Domain Data into the GUI

After you create an estimation project, as described in “Creating an
Estimation Project” on page 1-3, you can import the estimation data into
the GUI. To learn more about the types of data for parameter estimation,
see “Types of Data for Parameter Estimation” in the Simulink Design
Optimization Getting Started Guide.

To import transient (measured) data for your dynamic system:

1 In the Control and Estimation Tools Manager, select Transient Data
under the Estimation Task node of the Workspace tree.

2 Right-click Transient Data and select New to create a New Data node.
Alternatively, you can use the New button to create this node.

1-5
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E! Control and Estimation Tools Manager

~=ol |
File Wiew Help
D | HE|
{\ Warkspace ~Transient data set:
=gl Project - engine_idle_speed Name Properties |
e A
=
Drescription:
[
=
New | Delete | Edit... |
- Mews Data node has been added to Transient Data, ;I
- Mew Data nodz has been added ko Transient Data, j
-
Transient data sets are stored in this folder, Press Mew' to create a new data set 4

3 Select the New Data node under the Transient Data node.

The Control and Estimation Tools Manager GUI now resembles the next
figure.



Importing Data into the GUI

E! Control and Estimation Tools Manager =] 3]

File Wiew Help

= il Y = = N )

. workspace Input Data | Qutput Data | State Data |
=- gl Project - engine_idle_speed —Assign data ta blacks
=+ E3) Estimation Task.
= Block Mame I Data I Time | Ts | ‘Weight I Length
l e ine_idle_: BPAY
Channel - 1 | | | 1 | A+
- Estimation
Ea Walidation
Impott. .. Pre-process, .. Flot Drata Clear all
— New Data node has been added to Transient Data.

Select the tabbed panels ta configure the transient data set.

s L L

Import Data into the Control and Estimation Tools Manager

The table rows in the Input Data tab corresponds to the Inport block BPAV
in the engine_idle speed model. Similarly, the rows in the Qutput Data
tab corresponds to the Outport block Engine Speed.

Note The Simulink model must contain an Inport or Outport block
or logged signals to enable importing data. For more information, see
“Configuring a Model for Importing Data” on page 1-2.

The idle-speed model of an automotive engine contains the measured data
stored in the iodata array. The array contains two columns: the first for
input data, and the second for output data. You must import both the input
and the output data, as described in the following sections:

¢ “Importing Input Data and Time Vector” on page 1-8

1-7
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¢ “Importing Output Data and Time Vector” on page 1-9

Importing Input Data and Time Vector
To import the input data for the port BPAV:

1 In the New Data node, click the Input Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box. Alternatively, you can use the Import button to open this dialog box.

=) Control and Estimation Tools Manager

=10 x|
File Wiew Help
e O | E|[E
s workspace Input Data | Qutput Data | State Data |
EG Project - engine_idle_speed | ascion data to blacks
=] [ Estimation Task - -
Transient Data Block Mame I Data I Time | Ts | Weight Length
] Mew Daka engine_idle_speed BPAY
Wariables Channel - 1 | 1 r
Estmation ety
- validation Export...
Pre-process...
Flot Data
Clear al
Impart... Pre-process... Flok Data Clear all |
T DG T o e e T T D ;I
- Mew Data nodz has been added ko Transient Data,
- Mews Data node has been added ko Transient Data,
-
Select the tabbed panels ta configure the transient data set. &

3 In the Data Import dialog box, select iodata from the list of variables.



Importing Data into the GUI

x
Import From; I Warkspace VI
Yariahle Mame I Size | Eytes | Class |
HH gainz 1x1 & double &l
@iodata 7801x2 120016 double
@mean_speed 1x1 8 douhle
@time 7a01x1  BO002 double j

* Assign the Following columns ko selected channel(s): |[1:2]

™ Assign the Following rows ko selected channel(s): I[l:?SDl:

Impork | Close I Help I

4 Enter 1 in the Assign the following columns to selected channel(s)
field, and then click Import.

5 In the Input Data tab, select the Time/Ts cell.

6 Select time in the Data Import dialog box.

7 Click Import to import the time vector for the input data.
8 Click Close to close the Data Import dialog box.

Importing Output Data and Time Vector
To import the output data for the port Engine Speed:

1 In the New Data node, select the Output Data tab.

2 Right-click the Data cell and select Import to open the Data Import dialog
box.

3 In the Data Import dialog box, select iodata from the list of variables.

4 Enter 2 in the Assign the following columns to selected channel(s)
field to use the second column of iodata, and then click Import.

5 In the Output Data tab, select the Time/T's cell.

1-9
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6 Select time in the Data Import dialog box.
7 Click Import to import the time vector for the output data.

8 Click Close to close the Data Import dialog box.

Importing Time-Series Data into the GUI

Time-series data is stored in time-series objects. For more information, see
“Time Series Objects” in the MATLAB documentation.

When you import time-series data for parameter estimation, specify the data
and time vector as t.data and t.time in the Data and Time/Ts columns of the
New Data node, respectively. For more information on how to import data
into the GUI, see “Importing Time-Domain Data into the GUI” on page 1-5.

Importing Complex Data into the GUI

Complex-valued data is data whose value is a complex number. For example,
a signal with the value 1+2j is complex. You can use complex data to estimate
parameters of electrical systems, such as the magnitude and phase.

Note You must sample the real and imaginary parts of the data as a function
of the same time vector.

To use complex data for parameter estimation:

1 Split the data into two data sets that contain the real and imaginary parts.
To split the data, use the MATLAB functions real, and imag.

2 Import both data sets into the GUI, as described in “Importing
Time-Domain Data into the GUI” on page 1-5.

3 Specify both the data sets together as estimation data, as described in
“Specifying Data for Parameter Estimation” on page 2-4.

4 Estimate the parameters, as described in “Estimating Parameters in the
GUTI” on page 2-36.
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Plotting and Analyzing Data in the GUI

In this section...

“Why Plot the Data Before Parameter Estimation” on page 1-11
“How To Plot Data in the GUI” on page 1-11

Why Plot the Data Before Parameter Estimation

After you import the estimation data, as described in “Importing Data into
the GUI” on page 1-5, it is useful to remove outliers, smooth, detrend, or
otherwise treat the data to make it more tractable for analysis and estimation
purposes. To view and analyze the data characteristics, you must plot the
data on a time plot.

How To Plot Data in the GUI

To plot a data set, select the Data cell that you want to plot in the Transient
Data node of the Control and Estimation Tools Manager GUI, and click
Plot Data.

1-11
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E! Control and Estimation Tools Manager

_laolx
File View Help
l, workspace InputData OutputData | State Data |
=gl Project - engine_idle_speec ~Assign data to blocks
ey
Block Mame I Data I Time [ Ts I Weight | Length
engine_idle_speed/Engine Speed
34 variables Channel - 1 time(:, 1) [ 1 [ 7s01/7501
-| g} Estimation
[ validation
Import... Pre-process... Clear All |
4 | 2]
- New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels to configure the transient data set. 4

The data is plotted on a time plot, as shown in the next figure.



Plotting and Analyzing Data in the GUI

) New Data - engine_idle_speed/Engine Speed 10| =|
File Edit View Insert Tools Desktop Window Help a
Dode | |RAODBDEL- 2 |0EBE 0l
Data plot for port
engine_idle_speed/Engine Speed
950 -
00 -
850 -
800 -
©
=]
=
= 7501
E
=T,
700
650 -
600 -
550 | 1 1
0 50 100 150
Time

Using the time plot, you can examine the data characteristics such as noise,
outliers and portions of the data to use for estimating parameters. After you
analyze the data, you the preprocess the data as described in “Preprocessing
Data in the GUI” on page 1-14.

1-13
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Preprocessing Data in the GUI

In this section...

“Ways to Preprocess Data Using the Data Preprocessing Tool” on page 1-14
“Opening the Data Preprocessing Tool” on page 1-15

“Handling Missing Data” on page 1-16

“Handling Outliers” on page 1-18

“Detrending Data” on page 1-18

“Filtering Data” on page 1-18

“Selecting Data” on page 1-20

“Adding Preprocessed Data Sets to an Estimation Project” on page 1-28
“Exporting Prepared Data to the MATLAB Workspace” on page 1-31

Ways to Preprocess Data Using the Data
Preprocessing Tool

After you import the estimation data, as described in “Importing Data into
the GUI” on page 1-5, you can perform the following preprocessing operations
using the Data Preprocessing Tool in Simulink Design Optimization software:

Exclusion — Exclude a portion of the data from the estimation process. You
can exclude data by:

= Selecting it with your mouse.
= Graphically by selecting regions on a plot.
= Using rules, such as upper or lower bounds.

Handle missing data — Remove missing data, or compute missing data
using interpolation.

Handle outliers — Remove outliers.
Detrend — Remove mean values or a straight line trend.

Filter — Smooth data using a first-order filter, an arbitrary transfer
function, or an ideal filter.
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Opening the Data Preprocessing Tool
To open the Data Preprocessing Tool:

1 In the Control and Estimation Tools Manager GUI, select the Transient
Data node under the Estimation Task node, and then choose the data you

want to preprocess either in the Input Data, or Output Data tab. This
enables the Pre-process button.

[l control and Estimation Tools Manager

=10l |
File WYiew Help
¢t O | & [[E

< workspace Input Data | Qutput Data | State Data |

=1l Project - enaine_idle_speed
=[] Estimation Task i :

Transient Data I Block Kame I Data I Time | Ts | Wieight I Length

engine_idle_speed BPAY
iodatar:, 1) [ time: [ 1 [ 750147501

~Assign data ko blacks

Yariables
Estimation
E@ Mew Estimation
Ea Wigws

Walidation

Import. ..

Plot Data Clear al |

Show ot hide the output area

s LI

2 Click Pre-process to open the Data Preprocessing Tool.
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«): Data Preprocessing Tool for Dataset: New Data 1'
Modify clata from Iengine_\d\e_spead. . 'I Write resuls to o Mewe Drata 'I % new dstaset  |Datasett
- Data Edting

Renwy data | Madified datal Exclusion Rules | DetrendiFitering |

Titne (secs) iadlatar: 1) |

o ho ﬂ [ Bounds

2.02-2 i fo

4.0e-2 0.0 Exclucie X: I = [ Excludie X I o= [ I

6.0e-2 oo

G.0e-2 oo Exclucle *: I == T I Exclucle *': I B= ¥

0100 oo

0120 oo

0140 0o I Outliers

0160 oo

0180 no Windery lsrth: |1 [

0.200 oo

p.220 oo Confidence limits (% |95

0240 0o onfidence limts (%)

0.260 oo

0280 0o [~ MATLAR EXPrEssion Ins(x)>1

0.500 oo LI

[ Flatines iindow: |5
- Excluded by a rule
Exclude Graphicaly
Red text Manually excluded

rMiz=ing Data Handling

[~ Remove rows where I al = I data iz excluded or missing r Interpolate missing values using interpolation method | ok i

oK | Cloge | Apply | Helgp |

Tip When you have multiple data sets, select the data set that you want
to preprocess from the Modify data from drop-down list in the Data
Preprocessing Tool.

In this section, the sample data set imported for preprocessing is the same as
used in the engine_idle_ speed Simulink model. For an overview of creating
estimation projects and importing data sets, see “Configuring a Model for
Importing Data” on page 1-2, and “Creating an Estimation Project” on page
1-3.

Handling Missing Data

¢ “Removing Missing Data” on page 1-17
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® “Interpolating Missing Data” on page 1-17

Removing Missing Data

Rows of missing or excluded data are represented by NaNs. To remove the rows
containing missing or excluded data, select the Remove rows where check
box in the Missing Data Handling area of the Data Preprocessing Tool GUI.

IMissing Data Handling

al = | datais excluded or missing [~ Interpolate missing values using interpolation method | zob -

When the data set contains multiple columns of data, select all to remove
rows in which all the data is excluded. Select any to remove any excluded cell.
In the case of one-column data, any and all are equivalent.

Tip You can view the modified data in the Modified data tab of the Data
Preprocessing Tool GUI.

Interpolating Missing Data

The interpolation operation computes the missing data values using known
data values. When you select the Interpolate missing values using
interpolation method check box in the Missing Data Handling area of
the Data Preprocessing Tool GUI, the software interpolates the missing
data values.

Missing Diata Handling

[~ Remove rows where | &l = | data is excluded or missing v Interpolate missing values using interpolation method : I zoh - I

You can compute the missing data values using one of the following
interpolation methods:

® Zero-order hold (zoh) — Fills the missing data sample with the data value
immediately preceding it.

® Linear interpolation (Linear) — Fills the missing data sample with the
average of the data values immediately preceding and following it.

1-17
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By default, the interpolation method is set to zoh. You can select the
Linear interpolation method from the Interpolate missing values using
interpolation method drop-down list.

Tip You can view the results of interpolation in the Modified data tab of the
Data Preprocessing Tool GUI.

Handling Outliers

Outliers are data values that deviate from the mean by more than three
standard deviations. When estimating parameters from data containing
outliers, the results may not be accurate.

To remove outliers, select the Outliers check box to activate outlier exclusion.
You can set the Window length to any positive integer, and use confidence
limits from 0 to 100%. The window length specifies the number of data points
used when calculating outliers.

Removing outliers replaces the data samples containing outliers with NaNs,
which you can interpolate in a subsequent operation. To learn more, see
“Interpolating Missing Data” on page 1-17.

Detrending Data

To detrend, select the Detrending check box. You can choose constant or
straight line detrending. Constant detrending removes the mean of the data
to create zero-mean data. Straight line detrending finds linear trends (in the
least-squares sense) and then removes them.

Filtering Data

e “Types of Filters” on page 1-18
e “How to Filter Data” on page 1-19

Types of Filters

You have these choices for filtering your data:
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. 1
® First order — A filter of the type
s+1

where T is the time constant that you specify in the associated field.

e Transfer function — A filter of the type

n n-1
a,s” +a, 1S ~+..+ay
-1

by,s™ by, 18"+ + by

where you specify the coefficients as vectors in the associated A
coefficients and B coefficients fields.

e Ideal — An idealized (noncausal) filter, either stop or pass band. Specify
either filter as a two-element vector in the Range (Hz) field. These filters
are ideal in the sense that there is no finite rolloff or ripple; the ends of the
ranges are perfectly horizontal in the frequency domain.

How to Filter Data

To filter the data to remove noise, select the Detrend/Filtering tab in the
Data Preprocessing Tool GUI. Select the Filtering check box, and choose the
type of filter from the Select filter type drop-down list.

Exclusion Rules  Detrend|Filtering |
[T Detrending {* | Constant

(" Straight Line
¥ Filtering  Seleck filker bype -
First arder filker with time conskankt IlEI

1-19



1 Data Analysis and Processing

1-20

Selecting Data

e “Techniques for Excluding Data in the Data Preprocessing Tool” on page
1-20

® “Graphically Selecting Data” on page 1-20

e “Using Rules to Select Data Samples” on page 1-23

e “Using the Data Table to Select Data Samples” on page 1-25

Techniques for Excluding Data in the Data Preprocessing Tool
You can use the Data Preprocessing Tool to select a portion of the data to be
excluded from the estimation process. You can choose one of the following
techniques:

e Selecting data from the Data Editing Table.

e Selecting data from a plot of the data.

® Specifying a rule.

You accomplish the first two manually, and for the last you specify a rule.
When you exclude data using manual selection, the excluded data is shown
as red. When you exclude data using a rule, the background color of the cell

becomes gray. When a portion of the data is excluded both manually and by a
rule, the data is red, and the background is gray.

Note Changes in data are visible everywhere. When you use the Data
Editing table, you can view the results in the data plot.

Graphically Selecting Data

You can exclude data graphically. Click Exclude Graphically to open the
Select Points for Preprocessing Rule window.
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+) Select Points for Preprocessing Rule

=10l x|

Specify Axes

X Time

'S I indatal: 10 - i

—— Selection

Selecting points:
# Excludes them

€ Inzludes them

Include Al |
Exclude Al |

Close |

Input Data

&0

Manually exeluded

100 150
Time (sec)
O Excluded by rule

Cutput Data

2000

4000 5000 G000 FOOO

Pasition

The way you exclude data is similar to the way you select a region for
zooming: place your cursor in the Input Data plot and drag the mouse to

draw a region of exclusion.

This figure shows an example of resulting data exclusion in the input data.
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+) Select Points for Preprocessing Rule : - | Ellﬂ

Input Data

The excluded area
is red in the Input
Data plot.

_ Specify Axes

X Time

'S I indatal: 10 - i

2 1 !
o] &0 100 150
— Selection Time (sec)
# Manually excluded O Excluded by rule
Selecting points:
% Excludes them Output Data

By default, In the
Output Data plot,
the excluded input

data produces a
blank area.

T T

€ Inzludes them

Include Al |
Exciude Al |

1000 2000 3000 4000  HOO0 G000 FOO00

Clase | Pasition

In the Output Data plot, the excluded input data produces a blank area by
default. This corresponds to the NaNs that now represent excluded data. If
you choose to interpolate or remove the excluded data, the output data shows
the interpolated points.

When you make changes in the Select Points for Preprocessing Rule window,
they immediately appear in the Data Editing pane, and vice versa.

Selection Pane. By default, any box that you draw with your mouse selects
data for exclusion, but you can toggle between exclusion and inclusion using
the Selection pane on the left side of the Select Points for Preprocessing
Rule window.
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— Selection
Selecting points:
Use these radio buttons fo toggle between
inc|ut|'|ng and exduding selected data.

{*' Excludes them_—______

" Includes them

Use these buttons to include or exclude all

Include All | T — Ihe dﬂfﬂ.
Exclude Al |

Using Rules to Select Data Samples

A more precise way to exclude data is to use mathematical rules. The
Exclusion Rules pane in the Data Preprocessing Tool allows you to enter
customized rules for excluding data.

Exclusion Rules | DetrendfFiIteringl

Exclude X: |<= 'I I Exclude X: I:: VI I
Exclude " |<= 'I I Exclude |:== vl I

[~ Gutliers

Windovy length: |2III

Confidence limits (%) |95

[~ maTLAE expression Ias[x)>1
™ Flatines indow: |22

These are the rules you can use to exclude data:

® “Upper and Lower Bounds” on page 1-24
e “MATLAB Expressions” on page 1-24
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¢ “Flatlines” on page 1-24

Upper and Lower Bounds. Select the Bounds check box to activate upper
and lower bound exclusion. Enter numbers in the Exclude X and Exclude
Y fields for upper and lower bound exclusion. By default, the exclusion rule
1s to include the boundary values, but you can use the menu to exclude the
boundaries as well.

MATLAB Expressions. Use the MATLAB expression field to enter any
mathematical expression using MATLAB code. Use x as the variable name in
your expression for the data being tested.

Flatlines. If you have areas of your data set where the data is constant,
providing no new information, then you can choose to exclude those data
points as flatlines. The Window length field sets the minimum number of
constant data points required to define the area as a flatline.
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Example of Rule Exclusion. This figure shows data with a region of the

x-axis excluded.

<) Select Points for Preprocessing Rule

a
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X Time
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— Selection
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Using the Data Table to Select Data Samples
The Data Editing table lists both the raw data set and the modified data

that you create.
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Diata Editing

Raw data | Macified data |

Time [zecs)

ioatat: 1] |

21 680

-0.472

21.700

-0.515

21720

21.740

21 760

21 780

21.500

21820

21.540

21 860

21580

21.800

21 820

21 840

21 860

-0.931

21 8580

|-0.348

- Excluded by a rule
Manually excluded

[~
Exclude Graphically J’

Use your mouse to seledt groups of
cells for exclusion. Selected celks
become blue. Right-click and select
Exclude. The background becomes
white, but the numbers are now red.

Click this button 1o view the data
graphically.

There are two tabs in the Data Editing pane: Raw data and Modified
data. The Raw Data pane shows the working copy of the data. For example,
if you exclude rows of data in the Raw data pane, the corresponding rows
of numbers become red in this table. By default the Modified data pane
represents the rows you removed by inserting NaNs.
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~Data Editing
Raw data  Modified data
Titne (ecs) iodatal: 1)*
&.760 0.8739 N
&.750 0.976
5500 0472 =
5520 0.9639
5540 Mal
& 380 [
330 [
&.a00 [
5320 [y
6.940 Mah
&850 [
GEEN] [
8.0 hihl
8.20 [
.40 [
960 ] ﬂ
- Excluded by arule
M anually excluded

By default, data that you excluded from the
Raw Data table is represented by Nals in
the Modified Data tabk. If you choose to
interpolate or remove missing data, the
results of that action are shown in the
Modified Datu fable.

In the Modified data pane, you can choose to remove the excluded data
completely or interpolate it. See “Handling Missing Data” on page 1-16 for

more information.

After you select data for exclusion, you can view it graphically by clicking
Exclude Graphically.
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As you make changes in the Data Editing pane, they immediately appear in
the Select Points for Preprocessing Rule window, and vice versa.

Adding Preprocessed Data Sets to an Estimation
Project

After you preprocess the data using the techniques described in “Ways to
Preprocess Data Using the Data Preprocessing Tool” on page 1-14, you can
add the data set to an estimation project either by overwriting an existing
data set or creating a new data set.

e “Overwriting an Existing Data Set” on page 1-29

® “Creating a New Data Set” on page 1-30
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Overwriting an Existing Data Set

To overwrite an existing data set with the preprocessed data:

1 In the Write results to area of the Data Preprocessing Tool GUI, select
the existing dataset option.

2 Choose the data set you want to overwrite from the drop-down list.

Madify data fram I ..eedfEngine Speed = l

|—Data Editing

Write results to: €% existing dataset  |...w Data *

3 Click Add.

i~ new dataset IDatasetl

This action overwrites the selected data set with the modified data in the
Control and Estimation Tools Manager GUI.

[l control and Estimation Tools Manager

File WYiew Help

=10l |
o
RN ="
s workspace Input Data OUtPUt Data | Stare Data |
E:‘J Project - engine_idle_speed | “pceion daka ko blacks
- Estimation Task
E Block Mame I Data I Time | Ts | ‘Weight I Length
] ata engine_idle_speed/Engine Speed
Channel - 1 timed:, 1% [ 1 [ 750147501
Estimation
g validation
Impart... Pre-process... Flok Data Clear all |
- New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels to configure the transient data set. v
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Tip You can export the preprocessed data to the MATLAB Workspace, as
described in “Exporting Prepared Data to the MATLAB Workspace” on page
1-31.

Creating a New Data Set

If you do not want to overwrite an existing data set with the preprocessed
data, as described in “Overwriting an Existing Data Set” on page 1-29, you
can create a new data set for the preprocessed data:

1 In the Write results to area of the Data Preprocessing Tool GUI, select
the new dataset option.

2 Specify the name of the data set in the adjacent field.

IModify data from I ..eed/Engine Speed * l ‘Write results ko existing dataset Iw Data VI * new dataset

3 Click Add.

This action adds a new data node in the Control and Estimation Tools
Manager GUI containing the modified data.
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E! Control and Estimation Tools Manager =] 3]
File Wiew Help
= =
&0 g a|E
), viorkspace Input Data Output Data | State Data |
=- gl Project - engine_idle_speed —Assign data ta blacks
=+ E3) Estimation Task.
- Tran Block Mame I Data I Time | Ts | ‘Weight I Length
i T engine_idle_speedEngine Speed
BlFrep_Data Channel - 1 timef:, 17 I 1 [ 7s0yrso
% Estirnation
Ea Walidation
Impott. .. Pre-process... Plot Data Clear all |
— New Data node has been added to Transient Data. ﬂ
[
&

Select the tabbed panels ta configure the transient data set.

Tip You can export the preprocessed data to the MATLAB Workspace, as
described in “Exporting Prepared Data to the MATLAB Workspace” on page
1-31.

Exporting Prepared Data to the MATLAB Workspace

After you add the preprocessed data to an estimation project, as described in
“Adding Preprocessed Data Sets to an Estimation Project” on page 1-28, you
can export the data set to the MATLAB Workspace. You can use the data to
further prepare it or estimate parameters using the data.

1 In the Transient Data node of the Control and Estimation Tools Manager
GUI, select the node containing the prepared data set.
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2 Right-click the table Data cell containing the data that you want to export,
and select Export.

The Export to Workspace dialog box opens.

3 Specify the MATLAB variable names for the prepared data and the
corresponding time vector in the Data and Time fields, respectively.

_Io/x]
[V Data pata
v Time timeﬂll
OK | Cancel
4 Click OK.

The resulting MATLAB variables data and time4 appear in the MATLAB
Workspace browser.
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Parameter Estimation

e “Overview of Parameter Estimation” on page 2-2

¢ “Configuring Parameter Estimation in the GUI” on page 2-3

¢ “Estimating Parameters in the GUI” on page 2-36

e “Validating Parameters in the GUI” on page 2-40

e “Accelerating Model Simulations During Estimation” on page 2-50

® “Speeding Up Parameter Estimation Using Parallel Computing” on page
2-52

¢ “Estimating Initial States” on page 2-65
¢ “Working with Estimation Projects” on page 2-78

¢ “Estimating Parameters at the Command Line” on page 2-83
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Overview of Parameter Estimation

When you estimate model parameters, Simulink Design Optimization
software compares the measured data with data generated by a Simulink
model. Using optimization techniques, the software estimates the parameter
and (optionally) initial conditions of states to minimize a user-selected cost
function. The cost function typically calculates a least-square error between
the empirical and model data signals.

After you import and preprocess the estimation data, as described in
“Importing Data into the GUI” on page 1-5 and “Preprocessing Data in the
GUI” on page 1-14, follow these steps to estimate model parameters:

1 “Creating an Estimation Task” on page 2-3

2 “Specifying Data for Parameter Estimation” on page 2-4
3 “Specifying Parameters to Estimate” on page 2-6

4 “Specifying Initial States” on page 2-17

5 “Selecting Views for Plotting” on page 2-19

6 “Specifying Estimation Options” on page 2-23

7 Estimating Parameter

8 Validating Parameters

Note The Simulink model must remain open to perform parameter
estimation tasks.

To learn how to estimate parameters at the command line, see “Estimating
Parameters at the Command Line” on page 2-83.
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Configuring Parameter Estimation in the GUI

In this section...

“Creating an Estimation Task” on page 2-3

“Specifying Data for Parameter Estimation” on page 2-4
“Specifying Parameters to Estimate” on page 2-6
“Specifying Initial States” on page 2-17

“Selecting Views for Plotting” on page 2-19

“Specifying Estimation Options” on page 2-23
“Specifying Simulation Options” on page 2-29
“Specifying Display Options” on page 2-35

Creating an Estimation Task

This section describes how to use the GUI to estimate parameters. After you
import the transient data, as described in “Importing Data into the GUI” on
page 1-5, you must create an estimation task and configure the estimation
settings. To create a container that stores the estimation settings:

1 In the Control and Estimation Tools Manager, right-click the Estimation
node in the Workspace tree and select New.

2 Select the New Estimation node.

The Control and Estimation Tools Manager now resembles the next figure.
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E! ‘Control and Estimation Tools Manager =lol =]
File View Help
=
=RaN=N=T
Waorkspace Data Sets I Parameters | Statesl Estimation I
=/ Project - engine_idle_speed | pata sets used for estimation ~Output data weights
(=1 Estimation Task - —
E" nsient Daka I Transient estimation ;I Black Name | Length I ‘Weight
L Ri]NewData — _itlle_t ngine Speed
.. Varisbles JEE | EHECE | Chamnel-1 [ 75017501 | 1
= Estimation METEEE | ] ‘;I
Views
Ea Validation
=
Select Al | Clzar all
E
[
Select the tab panels ta configure your estimation, 4

Specifying Data for Parameter Estimation

® “Prerequisite for Specifying Data” on page 2-4

e “How to Specify Data in the GUI” on page 2-5

Prerequisite for Specifying Data
To specify a data set for estimation, you must have already imported the
data in the GUI and created an Estimation Task, as described in “Creating
an Estimation Task” on page 2-3. If your data contains noise or outliers,
you must also preprocess the data, as described in “Preprocessing Data in
the GUI” on page 1-14.
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How to Specify Data in the GUI

After you select the New Estimation node, the Data Sets tab appears. Here
you select the data set that you want to use in the estimation.

Select the Selected check box to the right of the New Data data set.

=) control and Estimation Tools Manager = 3]

File Wiew Help

ct D= 3 [[E

Q Workspace Data Sets I Parameters | States | Estimation |
(= J8H Project - engine_idle_sp2ed | pure sets ysed forestimation - Output deta weight
[=1-F3) Estimation Task
[ Transient Data [ Transient estimtion | BockMame |  Length | weoht
: [4] Mevw Dt ine_idle_speed/Engine Speed
e % Variables Dita Set | Selected | Channel -1 | 75017501 | 1
=8

Estimation hew Data \ 4 [2]

“alidation

[]

Select All Clear Al |

4 [2]

s L L

Select the tab panels to configure your estimstion.

Note If you imported multiple data sets, you can select them for estimation
by selecting the check box to the right of each desired data set. When using
several data sets, you increase the estimation precision. However, you also
increase the number of required simulations: for N parameters and M data
sets, there are M*(2N+1) simulations per iteration.

Then, specify the weight of each output from this model by setting the Weight
column in the Output data weights table.
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The relative weights are used to place more or less emphasis on specific
output variables. The following are a few guidelines for specifying weights:

e Use less weight when an output is noisy.

e Use more weight when an output strongly affects parameters.

e Use more weight when it is more important to accurately match this model
output to the data.

Specifying Parameters to Estimate

¢ “Choosing Which Parameters to Estimate First” on page 2-6

¢ “How to Specify Parameters for Estimation in the GUI” on page 2-6
® “Specifying Initial Guesses and Upper/Lower Bounds” on page 2-11
® “Specifying Parameter Dependency” on page 2-13

e “Example: Specifying Independent Parameters for Estimation” on page
2-14

Choosing Which Parameters to Estimate First

Simulink Design Optimization software lets you estimate scalar, vector and
matrix parameters. Estimating model parameters is an iterative process.
Often, it is more practical to estimate a small group of parameters and use the
final estimated values as a starting point for further estimation of parameters
that are trickier. When you have a large number of parameters to estimate,
select the parameters that influence the output the most to be estimated
first. Making these sorts of choices involves experience, intuition, and a solid
understanding of the strengths and limitations of your Simulink model.

After you estimate a subset of parameters and validate the estimated
parameters, select the remaining parameters for estimation.

How to Specify Parameters for Estimation in the GUI
To select parameters for estimation:

1 In the Control and Estimation Tools Manager, select the Variables node
in the Workspace tree to open the Estimated Parameters pane.
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E! ‘Control and Estimation Tools Manager

=101 =]
File View Help
G0 aa|
41 Workspace Estimated Parameters | Estimated Statesl
=W Project - engine_idle_speed | selacted parameters ~Default settings
E|- Estimation Task Name:
Transient Data ;I ’
L[iii] New Data il
Initial guess: I
[=-{ . Estimation o
E@ New Estimatian nimum: I
Maximum: I
Typical value: I
Referenced by:
=]
=
Add... | Delete | =l
E
[
Select the tab panels ta configure your estimation parameters and states. 4

2 In the Estimated Parameters pane, click Add to open the Select

Parameters dialog box.
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— By default, the Select Parameters dialog box looks ot
- - | all variables in the model workspace and the MATLAB
o— = — 4 workspace that are used by the model.
32:§§ i List of parameters

delay 11

Use your mouse to seked data. To select adjacent
parameters, hold down the Shift key while clicking the
first and last parameter in the selection. To select
nonadjacent parameters, hod down the Ctrl key while
clicking each parameter.

[
SPeelly Sxpression (59, 5%, %3), bED Use the text field o get the parameters contained in
I either a Simulink parameter object, MATLAB array,
ok | cocel | rew | awy | structure, or ell array. Nofe that you cannot use

mathematical expressions such as x + 5.

The dialog box lists all the variables in the model workspace and the
MATLAB workspace that the model uses. You can use the mouse to select
the parameters to estimate.

You can also enter parameters, separated by commas, in the Specify
expression field of the Select Parameters dialog box. The parameters
can be stored in one of the following:

¢ Simulink software parameter object
Example: For a Simulink parameter object k, type k.value.
® Structure

Example: For a structure S, type S.fieldname (where fieldname
represents the name of the field that contains the parameter).

e Cell array
Example: Type C{1} to select the first element of the C cell array.
e MATLAB array

Example: Type a(1:2) to select the first column of a 2-by-2 array called
a.
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Sometimes, models have parameters that are not explicitly defined in
the model itself. For example, a gain k could be defined in the MATLAB
workspace as k=a+b, where a and b are not defined in the model but k
1s used. To add these independent parameters to the Select Parameters
dialog box, see “Specifying Parameter Dependency” on page 2-13.

Select the last seven parameters: freql, freq2, freqd, gaini, gain2,
gain3, and mean_speed, and then click OK.

Note You need not estimate the parameters selected here all at once. You
can first select all the parameters that you are interested in, and then later
select the ones to estimate as described in the next step.

The Control and Estimation Tools Manager now resembles the next figure.

« ) Control and Estimation Tools Manager =10 x|
File WYiew Help

ot D[ W [[E

Wwiorkspace Estimated Parameters | Estimated S{a{eSI
B Project - engine_idle_speed

= ~Selected parameater Defautt setting
=2 Estimation Task . N
573 Transient bata =z =
4] M Dt fren2 Walue: 3
Wariables frecd Initizl guess: Ifrecﬂ
(e Estimation gaint

Valitation ain2 Minimum: —— [-inf
oaing
rnean_speed

Maxitnur:  [+nr

Typical value: Ifrecﬂ

Referenced by:

engine_idle_speed/Transfer Fen ]

1 |

Select the tab panels to configure your estimation parameters and states.

x [ L
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To learn how to specify the settings in the Default settings area of the
pane, see “Specifying Initial Guesses and Upper/Lower Bounds” on page
2-11.

In the New Estimation node of the Control and Estimation Tools
Manager GUI, select the Parameters tab . In this pane, you select which
parameters to estimate and the range of values for the estimation.

a Select the parameters you want to estimate by selecting the check box
in the Estimate column.

b Enter initial values for your parameters in the Initial Guess column.

The default values in the Minimum and Maximum columns are - Inf
and +Inf, respectively, but you can select any range you want. For more
information, see “Specifying Initial Guesses and Upper/Lower Bounds”
on page 2-11.

Note When you specify the Minimum and Maximum values for the
parameters here, it does not affect your settings in the Variables node.
You make these choices on a per estimation basis. You can move data to
and from the Variables node into the Estimation node.

For this example, select gaini1, gain2, gain3 and mean_speed for
estimation and set gaini to 10, gain2 to 100, gain3 to 50, and mean_speed
to 500. Alternatively, use any initial values you like.

If you have good reason to believe a parameter lies within a finite range,
it 1s usually best not to use the default minimum and maximum values.
Often, there are computational advantages in specifying finite bounds if
you can. It can be very important to specify lower and upper bounds. For
example, if a parameter specifies the weight of a part, be sure to specify 0
as the absolute lower bound if better knowledge is unavailable.

The Control and Estimation Tools Manager now resembles the next figure.
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E! ‘Control and Estimation Tools Manager - ol x|

File View Help

&5 08d|E

ﬂ Warkspace Data Sets  Parameters | States | Estimation |
-l Project - engine_idle_speec

r Estimation parameters
E-- Estimation Task - — — - -

5[5 Transient Data MName Value Estimate Initial Guess Minimum Maximum | Typical Value

[+ new Data freql 3 O freql Inf +Inf freql

Variables freq2 3 O freq2 Inf +Inf freq2

: % Estimation freq3 3 freq3 -Inf +Inf freq3

By New Estimation ] gain 1 gainl

Ea Views gain2 0 I gain2 -Inf +nf gain2

validation gain3 0 v gain3 Inf +Inf gain3
mean_speed 600 I mean_speed -Inf +Inf mean_speed

Use Value as Initial Guess Reset to Default Settings Save as Default Settings |
q (2]

-New Data node has been added to Transient Data.
- New Estimation node has been added to Estimation.

s L1

Select the tab panels to configure your estimation.

Specifying Initial Guesses and Upper/Lower Bounds

After you select parameters for estimation in the Variables node of the
Control and Estimation Tools Manager GUI, the Estimated Parameters tab
in the Control and Estimation Tools Manager looks like the following figure.
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Select the tab panels to configure your estimation parameters and states. A

For each parameter, use the Default settings pane to specify the following:

Initial guess — The value the estimation uses to start the process.

Minimum — The smallest allowable parameter value. The default is - Inf.

¢ Maximum — The largest allowable parameter value. The default is +Inf.

Typical value — The average order of magnitude. If you expect your

parameter to vary over several orders of magnitude, enter the number
that specified the average order of magnitude you expect. For example, if
your initial guess is 10, but you expect the parameter to vary between
10 and 1000, enter 100 (the average of the order of magnitudes) for the

typical value.
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You use the typical value in two ways:

® To scale parameters with radically different orders of magnitude for equal
emphasis during the estimation. For example, try to select the typical
values so that

anticipated value

1

n

typical value
or

initial value 1

n

typical value

® To put more of less emphasis on specific parameters. Use a larger typical
value to put more emphasis on a parameter during estimation.

Specifying Parameter Dependency

Sometimes parameters in your model depend on independent parameters
that do not appear in the model. The following steps give an overview of how
to specify independent parameters for estimation:

1 Add the independent parameters to the model workspace (along with
initial values).

2 Define a Simulation Start function that runs before each simulation of the
model. This Simulation Start function defines the relationship between the
dependent parameters in the model and the independent parameters in
the model workspace.

3 The independent parameters now appear in the Select Parameters dialog
box. Add these parameters to the list of parameters to be estimated.

Caution Avoid adding independent parameters together with their
corresponding dependent parameters to the lists of parameters to be
estimated. Otherwise the estimation could give incorrect results. For
example, when a parameter x depends on the parameters a and b, avoid
adding all three parameters to the list.
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For an example of how to specify independent parameters, see “Example:
Specifying Independent Parameters for Estimation” on page 2-14.

Example: Specifying Independent Parameters for Estimation

Assume that the parameter Kint in the model srotut1 is related to the
parameters x and y according to the relationship Kint=x+y. Also assume that
the initial values of x and y are 1 and -0.7 respectively. To estimate x and y
instead of Kint, first define these parameters in the model workspace. To

do this:

1 At the MATLAB prompt, type

srotuti

This opens the srotut1 model window.

2 Select View > Model Explorer from the srotut1 window to open the
Model Explorer window.

3 In the Model Hierarchy tree, select srotutl > Model Workspace.

o
File Edit View Tools Add Help
| zjtm@ex|BHE S iod [ @enzaza
HSEardﬂ Ihy Name ;I Name: I Search
Model Hierarchy | ¥ | e ‘ Column View: |Data Chjects 'I Show Detsils ~ Oobjects  Model Workspace
E"@ Simulink Root INama i IVaIue I DataType |Min I Max |Dimansions Str Workspace data
B ﬁ Base Workspace
Er- ] srotut1 Data source: |MDLF\Ie =l

= Model Workspace
Code for srotutl

Import from MA‘H:lIel Export to MAT-File
Advice for srotut1

Clear Workspace ‘

s% Configuration {Active)

:‘5:] Signal Constraint Model arguments (for referendng this modef):

| |

Contents Search Results |

Revert
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4 Select Add > MATLAB Variable to add a new variable to the model

workspace. A new variable with a default name Var appears in the Name
column.

5 Double-click Var to make it editable and change the variable name to x.
Edit the initial Value to 1.

6 Repeat steps 4 and 5 to add a variable y with an initial value of -0.7.
The Model Explorer window resembles the following figure.

@ Model Explorer

— Ol x|
File Edit View Tools Add Help
| zsmaxHHe N7 ionom4neaza
HSeard'l: |by Name LI Name: | Search
Model Hierarchy |% | % ‘ Column View: |Data Objects vI Show Details 2 objects Data properties: y

= [#4] Simulink Root
=ﬁ Base Workspace
£ ] srotut1= - =
b Model Workspace® = 1
> Code for srotutl
Advice for srotut1
,% Configuration (Active)
B i:-] Signal Constraint

Value: I 0.7

Min | Max | Dimensions | Stc

Data Type: |doub\e {auta)

‘| | ]

Revert Help Apply
Contents Search Results |

7 To add the Simulation Start function that defines the relationship between
Kint and the independent parameters x and vy, select File > Model
Properties in the srotut1 model window.

8 In the Model Properties window, click the Callbacks tab.
9 To enter a Simulation start function, select StartFen*, and type the name

of a new function. For example, srotut1_start in the Simulation start
function panel. Then, click OK.
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10 Create a MATLAB file named srotuti_start. The content of the file
defines the relationship between the parameters in the model and the
parameters in the workspace. For this example, the content resembles
the following:

wks = get_param(gcs, 'ModelWorkspace')
X = wks.evalin('x")

y = wks.evalin('y"')

Kint = x+y;

Note You must first use the get_param function to get the variables x and
y from the model workspace before you can use them to define Kint.

When you select parameters for estimation in the Variables node of Control
and Estimation Tools Manager, x and y appear in the Select Parameters
dialog box.

x

—Select additional parameters to estimate

Tame Size
Kint 1x1 o
] 1x1
% 1x1
Yy 1x1
zeta 1x1

[ |

Specify expression (e.d., 5.3, a(3), b{Z}

QK | _ancel Help | Aol |
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Specifying Initial States

® “When to Specify Initial States Versus Estimate Initial States” on page 2-17
* “How to Specify Initial States in the GUI” on page 2-17

When to Specify Initial States Versus Estimate Initial States

Often, sets of measured data are collected at various times and under
different initial conditions. When you estimate model parameters using one
data set and subsequently run another estimation with a second data set,
your parameter values may not match. Given that the Simulink Design
Optimization software attempts to find constant values for parameters, this
is clearly a problem.

You can estimate the initial conditions using procedures that are similar to
those you use to estimate parameters. You can then use these initial condition
estimates as a basis for estimating parameters for your Simulink model. The
Control and Estimation Tools Manager has an Estimated States pane that
lists the states available for initial condition estimation. To learn how to
estimate initial states, see “Estimating Initial States” on page 2-65.

How to Specify Initial States in the GUI

After you select parameters for estimation, as described in “Specifying
Parameters to Estimate” on page 2-6, you can specify initial conditions of
states in your model. By default, the estimation uses initial conditions
specified in the Simulink model. If you want to specify initial conditions
other than the defaults, use the State Data tab. You can select the State
Data tab in the New Data node under the Transient Data node in the
Workspace tree.
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E! Control and Estimation Tools Manager

File Wiew Help

I [=[ 3]

e 0| 3 ([E

@ Wiorkspace

Estitnation Task
Transient Data
1 i‘:’l] Mewe Data
% “ariahles
Estitnation

g alidation

l

EG Project - engine_idle_speed

I+

Input Data | Output Data State Data |

~&szsigh data to state:

Elock Mame

Data

_idle_speed/Transfer Fcn

State -1

State -2

_jdle_speed/Transfer Fcn1

State -1

State - 2

_jdle_speed/Transfer Fch2

State -1

State - 2

Import... | Clear All |

Select the tabbed panels to configure the transient data set

s L L
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To specify the initial condition of a state for the engine_idle speed model:

1 Select the Data cell associated with the state.

2 Enter the initial conditions. In this example, enter -0.2 for State - 1 of
the engine_idle_speed/Transfer Fen. For State - 2, enter 0.

=) Control and Estimation Tools Manager ;lﬂlll

File Wiew Help

ot 0|2 3 [[E

. viorkepace Input Deta | Output Detes - Stete Data |
EG Project - engine_idle_speed
=-E3) Estimation Task

~&asigh data to stats

=-{[3] Transient Data Elock Mame | Sample Time I Data
[ Mew Data ine_idle_speed/Transfer Fcn
% Variakles State - 1 [ 0 | 02
Estimation State - 2 ‘ il |
=L valiation engine_idle_speed/Transfer Fcnl
State -1 | 0 |
State - 2 | 0 |
ine_idle_speed/Transfer Fcn2
State -1 I 0 |
State - 2 | 0 |

mport... | Clear Al |
Kl I»]

L

Select the tabbed panels to configure the transient data set

Selecting Views for Plotting
e “Types of Plots” on page 2-19

* “Basic Steps for Creating Plots” on page 2-20

Types of Plots

You can choose the plot type from the Plot Type drop-down list. The following
types of plots are available for viewing and evaluating the estimation:
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® Cost function — Plot the cost function values.
® Measured and simulated — Plot empirical data against simulated data.

® Parameter sensitivity — Plot the rate of change of the cost function as a
function of the change in the parameter. That is, plot the derivative of the
cost function with respect to the parameter being varied.

® Parameter trajectory — Plot the parameter values as they change.

® Residuals — Plot the error between the experimental data and the
simulated output.

Basic Steps for Creating Plots

Before you begin estimating the parameters, you must create the plots for
viewing the progress of the estimation.

Note An estimation must be created before creating views. Otherwise, the
Options table will be empty. To learn more, see “Creating an Estimation
Task” on page 2-3.

To create plots for viewing the estimation progress, follow the steps below:

1 Right-click the Views node in the Control and Estimation Tools Manager
and select New.
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2 In the Workspace tree, select New View to open the View Setup pane.

E! Control and Estimation Tools Manager =] 3]

File Wiew Help

e D= 3
*l Wiorkspace Wiew Setup I
=gl Project - engine_idle_speed ~Select plot type
=-E) Estimation Task
Plat Mumber Flot Type Plat Title
3] Mew Daka Flot 1 (none)
Wariables Flat 2 (none)
Estimation Flat 3 (none)
E@ Meww Estimation Plot 4 (none)
=8 Ea Wiews Flat 5 (none)
o i Flot & (none)
~Ciption:

Estimation
Mew Estimation

Shovy Plats |

Iteration 4 complete
Estimation completed.

Configure dynamic views,

IR0
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3 In the Select plot types table, select the Plot Type from the drop-down
list. In this example, select Cost function.

E! Control and Estimation Tools Manager =] 3]

File Wiew Help

ot O | = 3 [[E

ﬂ Workspace View Setup I
=gl Project - engine_idle_speed

~Select plat bype:
=-E) Estimation Task
- [ Transient Data Plat tumber | Plot Type | Flot Title
: [5\:,3] Mew Data Flok 1 {none) =l
Yariables Plot 2
= (i} Estimation Flak 3 Measured and simulated
o R Mew Estimation Plok 4 Parameter sensitivity
=t Ea Wigws Flat 5 Parameter trajectory
Lo e View Plot & Residuals
=-[Ig validation (none)
~Ciption:

Estimation
Mew Estimation

Shovy Plats |

Iteration 4 complete
Estimation completed.

Configure dynamic views,

IR0

4 Select Measured and simulated as the Plot Type for Plot 2. This plot
will be used in validating estimated parameters.

5 In the Options area, select the check-box for both Plot 1 and Plot 2.

6 Click Show Plots. This displays an empty cost function plot and a plot of
the measured data.
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/) New View - Plot 2 (Measured and simulated) = - |EI|5|
a

File Edit View Insert Tools Deskiop Window Help
Dode B |RAONDEL -2 00R| a0

Meazured vs. Simulated Responzes

New Data
950 T T

800

850 -

S00 -

70

Amplitude
Engine Speed

Too

650 -

600 - B

550 L L
o 50 100 150

Time (sec)

When you perform the estimation, the plot updates automatically.

Specifying Estimation Options

® “Accessing Estimation Options” on page 2-24

® “Supported Estimation Methods” on page 2-25

e “Selecting Optimization Termination Options” on page 2-27

® “Selecting Additional Optimization Options” on page 2-27

e “Specifying Goodness of Fit Criteria (Cost Function)” on page 2-28
e “How to Specify Estimation Options in the GUI” on page 2-28
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Accessing Estimation Options
In the New Estimation node in the Workspace tree, click the Estimation

Select the tab panels to configure your estimation.

tab.
E! Control and Estimation Tools Manager =lol =]
File Wiew Help
o D= E
4:\ Workspace Data Setsl Parameters' States  Estimation I
=] EI Project - engine_jdle_speed Estimation progr
=B8] Estimation Task
=R im tteration I Function Cmuml Cost Function I Step Size Procedure I Estitnation Cptions... |
| -
Display Cptions... |
Estirmation
BB hew Estimation
E Views
m “alidation Start
I~ Show Rrogress views
-]
[
[
4 I>]
[
g
&

Click Estimation Options. This action opens the Options- New Estimation
dialog box where you can specify the estimation method, algorithm options
and cost function for the estimation.

2-24



Configuring Parameter Estimation in the GUI

). Options - New Estimation =] |
Simulation Options  @ptimization Options I Parallel Options |
—Optimization method

Method: INonIinear least squares ;I Algorithm: ITrust-Region-ReFIective ;I

rOptimization options

Diff max change: IU.l Maximum fun evals:  [400
Diff min change: Ile-UUB Maximurm iterations: (100
Parameter kolerance: I0.00l Function kolerance: I0.00I

Display level: OFf - Gradient bype: I Basic - I
Cost function: I SSE - l [~ | Use robust cost

Cancel | Help | Apply |

The following sections describe the estimation method settings and cost
function:

® “Supported Estimation Methods” on page 2-25

® “Selecting Optimization Termination Options” on page 2-27

® “Selecting Additional Optimization Options” on page 2-27

e “Specifying Goodness of Fit Criteria (Cost Function)” on page 2-28

Supported Estimation Methods

Both the Method and Algorithm options define the optimization method.
Use the Optimization method area of the Options dialog box to set the
estimation method and its algorithm.

Optimization method
’7Meﬂ10d: I MNonlinear least squares LI Algarithm: I Trust-Region-Reflective LI

For the Method option, the four choices are:

® Nonlinear least squares (default) — Uses the Optimization Toolbox™
nonlinear least squares function 1sqnonlin.

e Gradient descent — Uses the Optimization Toolbox function fmincon.

2-25



2 Parameter Estimation

® Pattern search — Uses the pattern search method patternsearch. This
option requires Global Optimization Toolbox software.

e Simplex search — Uses the Optimization Toolbox function fminsearch,
which is a direct search method. Simplex search is most useful for simple
problems and is sometimes faster than fmincon for models that contain
discontinuities.

The following table summarizes the Algorithm options for the Nonlinear
least squares and Gradient descent estimation methods:

Method Algorithm Option Learn More

Nonlinear ® Trust-Region-Reflective In the Optimization

least squares (default) Toolbox
documentation,

® |evenberg-Marquardt
see:

® “Large Scale
Trust-Region
Reflective Least
Squares”

® “Levenberg-Marquardt

Method”
Gradient ® Active-Set (default) In the Optimization
descent
® Interior-Point Toalsos .
documentation,
® Trust-Region-Reflective see:

e “fmincon Active
Set Algorithm”

e “fmincon Interior
Point Algorithm”

® “fmincon Trust
Region Reflective
Algorithm”
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Selecting Optimization Termination Options
Specify termination options in the Optimization options area.

Optitmization aptions

Diff max change: IU.1 aximum fun ewvals: |4DD
Diff min change: |1 e-008 aximum iterations: |1 oo
Parameter tolerance: |1 e-006 Function talerance: |1 e-006

Several options define when the optimization terminates:

¢ Diff max change — The maximum allowable change in variables
for finite-difference derivatives. See fmincon in the Optimization
Toolboxdocumentation for details.

¢ Diff min change — The minimum allowable change in variables for
finite-difference derivatives. See fmincon in the Optimization Toolbox
documentation for details.

e Parameter tolerance — Optimization terminates when successive
parameter values change by less than this number.

¢ Maximum fun evals — The maximum number of cost function
evaluations allowed. The optimization terminates when the number of
function evaluations exceeds this value.

® Maximum iterations — The maximum number of iterations allowed. The
optimization terminates when the number of iterations exceeds this value.

* Function tolerance — The optimization terminates when successive
function values are less than this value.

By varying these parameters, you can force the optimization to continue

searching for a solution or to continue searching for a more accurate solution.

Selecting Additional Optimization Options

At the bottom of the Optimization options pane is a group of additional

optimization options.

Display level I Mone & I Gradient type: I Basic LI
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Additional options for optimization include:

¢ Display level — Specifies the form of the output that appears in the
MATLAB command window. The options are Iteration, which displays
information after each iteration, None, which turns off all output, Notify,
which displays output only if the function does not converge, and Final,
which only displays the final output. Refer to the Optimization Toolbox
documentation for more information on what type of iterative output each
method displays.

¢ Gradient type — When using Gradient Descent or Nonlinear least
squares as the Method, the gradients are calculated based on finite
difference methods. The Refined method offers a more robust and less
noisy gradient calculation method than Basic, although it does take longer
to run optimizations using the Refined method.

Specifying Goodness of Fit Criteria (Cost Function)

The cost function is a function that estimation methods attempt to minimize.
You can specify the cost function at the bottom of the Optimization options
area.

Cost Function: S5E - [~ Use robust cosk

You have the following options when selecting a cost function:
e Cost function — The default is SSE (sum of squared errors), which uses a
least-squares approach. You can also use SAE, the sum of absolute errors.

e Use robust cost — Makes the optimizer use a robust cost function instead
of the default least-squares cost. This is useful if the experimental data has
many outliers, or if your data is noisy.

How to Specify Estimation Options in the GUI

You can set several options to tune the results of the estimation. These
options include the optimization methods and their tolerances.

To set options for estimation:

1 Select the New Estimation node in the Workspace tree.
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2 Click the Estimation tab.
3 Click Estimation Options to open the Options dialog box.

4 Click the Optimization Options tab and specify the options.

=lolx|

Simulation Options  ©ptimization Options I Parallel Cptions |

~Optimization method
Method: I Monlinear least squares LI Algarithm: I Trust-Region-Reflective LI

~Opkimization options

Diff max change: |0.1 Maximum fun evals:  [400

Diff min change: Ile—UUB Maximurm iterations: (100
Parameter tolerance: IU.UUl Function tolerance: IU.UUI

Display level: OFf - Gradient type: I Basic - I
Cost Funckion: I SSE - l I~ | Use robust cost

Cancel | Help | Apply |

Specifying Simulation Options

® “Accessing Simulation Options” on page 2-29
e “Selecting Simulation Time” on page 2-30

® “Selecting Solvers” on page 2-32

Accessing Simulation Options
To estimate parameters of a model, Simulink Design Optimization software
runs simulations of the model.

To set options for simulation:
1 Select the New Estimation node in the Workspace tree.

2 Click the Estimation tab.

3 Click Estimation Options to open the Options dialog box.
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) Options - New Estimation =10l

I Optimization Opﬁonsl Parallel Opﬁonsl

~Simulation time

Start time: Iaub: Stop time: Iaub:
Solver options
Type: | Auto - Solver: | Use model settings ;I
oK | Cancel | Help | Apply |

4 Click the Simulation Options tab and specify the options, as described in
the following sections:

e “Selecting Simulation Time” on page 2-30

e “Selecting Solvers” on page 2-32

Selecting Simulation Time

You can specify the simulation start and stop times in the Simulation time
area of the Simulation Options tab.

Simulation tirme
lrstart tirne: Iautc- Stop tirme: Iautc-

By default, Start time and Stop time are automatically computed based on
the start and stop times specified in the Simulink model.

To set alternative start and stop times for the optimization, enter the new

times under Simulation time. This action overwrites the simulation start
and stop times specified in the Simulink model.
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Simulation Time for Data Sets with Different Time Lengths. Simulink
Design Optimization software can simulate models containing empirical
data sets of different time lengths. You can use experimental data sets for
estimation that contain I/O samples collected at different time points.

The following example shows a single-input, two-output model for which
you want to estimate the parameters.

y1(?)

u(t)
y2(1)

The model uses two output data sets containing transient data samples for
parameter estimation:
e Qutput yI(t) at time points ¢1 = {tll,t%,....t,ll}.

e Output y2(t) at time points 2 = {t%,t%, ..... t,2n}.

The simulation time £ is computed as:

This new set ranges from tmin to tmax. The values tmin and tmax represent
the minimum and maximum time points in ¢ respectively.

When you run the estimation, the model is simulated over the time range ¢.
Simulink extracts the simulated data for each output based on the following
criteria:

e Start time — Typically, the start time in the Simulink model is set to 0.
For a nonzero start time, the simulated data corresponding to time points

before t11 for y1(t) and t12 for y2(t) are discarded.
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* Stop time — If the stop time Zy,, 2tnay, the simulated data
corresponding to time points in ¢1 are extracted for yI1(z). Similarly, the
simulated data for time points in {2 are extracted for y2(¢).

If the stop time fg,, <?max, the data spanning time points >y, are
discarded for both yI(z) and y2(t).

Selecting Solvers

When running the estimation, the software solves the dynamic system using
one of several Simulink solvers.

Specify the solver type and its options in the Solver options area of the
Simulation Options tab of the Options dialog box.

Solver options

The solver can be one of the following Type:

® Auto (default) — Uses the simulation settings specified in the Simulink
model.

® Variable-step — Variable-step solvers keep the error within specified
tolerances by adjusting the step size the solver uses. For example, if the
states of your model are likely to vary rapidly, you can use a variable-step
solver for faster simulation. For more information on the variable-step
solver options, see “Variable-Step Solver Options” on page 2-33.

® Fixed-step — Fixed-step solvers use a constant step-size. For more
information on the fixed-step solver options, see “Fixed-Step Solver
Options” on page 2-34.

See “Choosing a Solver” in the Simulink documentation for information about
solvers.



Configuring Parameter Estimation in the GUI

Note To obtain faster simulations during estimation, you can change the
solver Type to Variable-step or Fixed-step. However, the estimated
parameter values apply only for the chosen solver type, and may differ from
values you obtain using settings specified in the Simulink model.

Variable-Step Solver Options. When you select Variable-step as the
solver Type, you can choose one of the following as the Solver:

® Discrete (no continuous states)

® ode45 (Dormand-Prince)

® 0de23 (Bogacki-Shampine)

® ode113 (Adams)

® odel15s (stiff/NDF)

® 0de23s (stiff/Mod. Rosenbrock)

® 0de23t (Mod. stiff/Trapezoidal)

® 0de23tb (stiff/TR-BDF2)

~Solver options
Type: I Variable-step LI Solver: I ode45 (Dormand-Prince) ;I
Maximum step size: Iauh:u Relative tolerance: Ile-3
Minimum step size: Iautc- Absolute tolerance: Iautu:||
Initial step size: Iautc- Zero crossing control: I On ;I

You can also specify the following parameters that affect the step-size of the
simulation:

* Maximum step size — The largest step-size the solver can use during a
simulation.

* Minimum step size — The smallest step-size the solver can use during a
simulation.

* Initial step size — The step-size the solver uses to begin the simulation.
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* Relative tolerance — The largest allowable relative error at any step in
the simulation.

® Absolute tolerance — The largest allowable absolute error at any step in
the simulation.

e Zero crossing control — Set to on for the solver to compute exactly where
the signal crosses the x-axis. This option is useful when using functions
that are nonsmooth and the output depends on when a signal crosses the
x-axis, such as absolute values.

By default, the software automatically chooses the values for these options.
To specify your own values, enter them in the appropriate fields. For more
information, see “Solver Pane” in the Simulink documentation.

Fixed-Step Solver Options. When you select Fixed-step as the solver
Type, you can choose one of the following as the Solver:

Discrete (no continuous states)
® ode5 (Dormand-Prince)

® ode4 (Runge-Kutta)

® ode3 (Bogacki-Shanpine)

® ode2 (Heun)

® odel (Euler)

Solver options

Type: (IREGLE] Solver: I Discreke (no conkinuous states) LI

Fixed step size: Iauto

You can also specify the Fixed step size value, which determines the

step size the solver uses during the simulation. By default, the software
automatically chooses a value for this option. For more information, see
“Fixed-step size (fundamental sample time)” in the Simulink documentation.
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Specifying Display Options

You can specify the display options by clicking Display Options in the
Estimation tab in the Control and Estimation tools Manager. This opens the

following dialog box.

[¥ Function count
V¥ Cost function v Step size

¥ Procedure

Ok | Cancel | Help |

Apply |

By default, all boxes are checked. Uncheck any
feature that you don't want to view during the
esfimation process.

Clearing a check box implies that feature will not appear in the display table
as the estimation progresses. To learn more about the display table, see
“Displaying Iterative Output” in the Optimization Toolbox documentation.
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Estimating Parameters in the GUI

Before you begin estimating the parameters, you must have configured the
estimation data and parameters, and specified estimation and simulation
options, as described in “Configuring Parameter Estimation in the GUI” on
page 2-3.

To start the estimation, select the New Estimation node in the Control and
Estimation Tools Manager and select the Estimation tab.

Click Start to begin the estimation process. At the end of the iterations, the
window should resemble the following:

=) Control and Estimation Tools Manager = 3]

File view Help

i il Y = = N )

4:\ Workspace Data Seisl Parameters | States Estimation I
=¥l Project - engine_idle_speed

[ Estimation progress

[=-51] Estimation Task
=17 Transient Data Iteration Function Count | Cest Function Step Size Procedure Estimation Options... |
: ] New 0 1 1.5981e+008 |1 =]
i 1 2 1.3725=+008 |10 Display Options...
1 Estimation 2 3 9.7536e+007 |20
. New Estimation 3 4 3.9731e+007 |40
é..fa Views 4 5 5.6148e+006 |71.238
0 New View
Ea Validation
I~ show progress views
=
Performing transient estimation... ]

Active experiments: New Data
Estimated parameters: gainl. gain?, gain3, mean_speed

Local minimum found.

Optimization completed because the size of the gradient is less than the
selected value of the function tolerance.

(=
Tteration 4 complete ;I
Estimation completed.
=
Select the tab panels to configure your estimation. &

Usually, a lower cost function value indicates a successful estimation,
meaning that the experimental data matches the model simulation with the
estimated parameters.
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Note For information on types of problems you may encounter using
optimization solvers, see “Steps to Take After Running a Solver” in the
Optimization Toolbox documentation.

The Estimation pane displays each iteration of the optimization methods. To
see the final values for the parameters, click the Parameters tab.

E! ‘Control and Estimation Tools Manager =] 3]

File View Help

i il == W e

. Workspace Data Sets Parameters | States | Estmation |
EG Project - engine_idle_speed | | _Eetimation parameters
(=B Estimation Task

&) Transient Data MName Value Estimate Initial Guess Minimum Maximum | Typical Value

i N freql 3 ] freql -Inf +Inf freql

: freqz 3 ] freqz -Inf +Inf freqz

1[5 Estimation freq3 3 ] freg3 -Inf +Inf freq3

E@ === gain 1 124,58 I~ gaini -Inf +Inf gaini

é--@ Views lgainz 23.89 v gainZ Inf +Inf gain2

el New View gain3 20,312 v gain3 -Inf +Inf gain3

Ea validation mean_speed 730.84 v mean_speed -Inf +Inf mean_speed

Use Value &z Initisl Guess Reset to Default Settings Save as Default Settings |
Iteration 4 complete ;I
Estimation completed.
-

Select the tab panels to configure your estimation. 4

The values of these parameters are also updated in the MATLAB workspace.
If you specify the variable name in the Initial Guess column, you can restart
the estimation from where you left off at the end of a previous estimation.

After the estimation process completes, the cost function minimization plot
appears as shown in the following figure.
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) New View - Plot 1 (Cost function) : =]

File Edit Wiew Insert Tools Desktop Window Help "

NEES b RAMDRL- 2|08 a O

Cost Function

10f ' ' ' ' , ' ' ' '

Cost

107 | | | | | |

Iterations

If the optimization went well, you should see your cost function converge on a
minimum value. The lower the cost, the more successful is the estimation.

You can also examine the measured versus simulated data plot to see how
closely the simulated data matches the measured estimation data. The next
figure shows the measured versus simulated data plot generated by running
the estimation of the engine_idle_ speed model.
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In this section...

“Basic Steps for Model Validation” on page 2-40
“Loading and Importing the Validation Data” on page 2-41
“Performing Validation” on page 2-43

“Comparing Residuals” on page 2-47

Basic Steps for Model Validation

After you complete estimating the parameters, as described in “Estimating
Parameters in the GUI” on page 2-36, you must validate the results against
another set of data.

The steps to validate a model using the Control and Estimation Tools
Manager are:

1 Import the validation data set to the Transient Data node.
2 Add a new validation task in the Validation node in the Workspace tree.

3 Configure the validation settings by selecting the plot types and the
validation data set from the Validation Setup pane.

4 Click Show Plots in the Validation Setup pane and view the results
in the plot window.

5 Compare the validation plots to the corresponding view plots to see if they
match.

The basic difference between the validation and views features is that you
can run validation after the estimation is complete. All views should be set
up before an estimation, and you can watch the views update in real time.
Validations can use other validation data sets for comparison with the model
response. Also, validations appear after you have completed an estimation
and do not update.
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You can validate your data by comparing measured vs. simulated data for
your estimation data and validation data sets. Also, it is often useful to
compare residuals in the same way.

Loading and Importing the Validation Data

To validate the estimated parameters computed in “Estimating Parameters
in the GUI” on page 2-36, you must first import the data into the Control
and Estimation Tools Manager GUI.

To load the validation data, type

load iodataval

at the MATLAB prompt. This loads the data into the MATLAB workspace.
The next step is to import this data into the Control and Estimation Tools
Manager. See “Importing Data into the GUI” on page 1-5 for information on
importing data, but the quickest way is to follow these steps:

1 Right-click the Transient Data node in the Workspace tree in the
Control and Estimation Tools Manager and select New.

2 Select New Data (2) from the Transient Data pane.

3 Right-click the New Data (2) node in the Workspace tree and select
Rename. Change the name of the data to Validation Data.

4 In the Input Data pane, select the Data cell associated with Channel
- 1 and click Import. In the Data Import dialog box, select iodataval
and assign column 1 to the selected channel by entering 1 in the Assign
columns field. Click Import to import the input data.
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X
Import from: IWorkspace vI
“ariahle Mame | Size | Biytes I Class I
@iudataval 7a01x2 120016 double 2
@mean_speed 11 8 double
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H tespz BT 528 double |

% Assign the Following columns to selected channel(s): |1

™ Assign the Fallowing rows to selected channel(s): I[l:?SDl:

Close I Help |

5 Select the Time/Ts cell and import time using the Data Import dialog box.
6 Similarly, in the Output Data pane, select Time/T's and import time.

7 In the Output Data pane, select the Data cell associated with Channel
- 1 and click Import. Import the second column of data in iodataval by

2-42



Validating Parameters in the GUI

selecting it from the list in the Import Data dialog box and entering 2 in the
Assign columns field. Click Import to import the output data.

The Control and Estimation Tools Manager should resemble the next

figure.
« ) Control and Estimation Tools Manager =] 3]
File Wiew Help
===
‘Workspace Input Data Qutput Data | State Data
Project - engine_idle_speed ~Azsion datato block
Expetimertsl Data
Block Narme
Data [ tmerts | Wilght | Length
engine_idle_speed/Engine Speed
Chanmel - 1 [ odstavaic ] titmed: 1] I 1 [ TE01/7501
Impott. .. Pre-process... Plot Data Clear &1l |
| | 2]
]
-
Select the tabbed panels to configure the transient data set v

Performing Validation

After you import the validation data, as described in “Loading and Importing
the Validation Data” on page 2-41, right-click the Validation node and select
New. This creates a New Validation node in the Control and Estimation

Tools Manager.
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To perform the validation:

1 Select the New Validation node in the Workspace tree to open the
Validation Setup pane.
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2 Click the Plot Type cell for Plot 1 and select Measured and simulated
from the drop-down menu.

3 In the Options area, select Validation Data in the Validation data set
drop-down list.

4 Click Show Plots to open a plot figure window as shown next.
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Measured Versus Simulated Data Plot for Validation Data

5 Compare this plot with the plot of Measured and simulated data for
the validation data. For more information on how to create this plot, see
“Selecting Views for Plotting” on page 2-19.
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Comparing Residuals

To look at the residuals, select Residuals as the Plot Type for Plot 2 in the
New Validation pane. In the Options area, select the Plot 2 check box and
click Show Plots. The following figure shows the resulting residuals plot.
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Plot of Residuals Using the Validation Data

Compare the validation data residuals with the original data set residuals
from the Views node in the Workspace tree. To create the plot of residuals
for the original data set, select the New View node and choose Residuals as
the Plot Type.
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Plot of Residuals Using the Test Data

The plot on the left agrees with the plot of the residuals for the validation
data. The right side has no plot because residuals were not calculated for the
validation data during the original estimation process.
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In this section...

“About Accelerating Model Simulations During Estimation” on page 2-50

“Limitations” on page 2-50

“Setting the Accelerator Mode for Parameter Estimation” on page 2-50

About Accelerating Model Simulations During
Estimation

You can accelerate the parameter estimation computations by changing the
simulation mode of your Simulink model. Simulink Design Optimization
software supports Normal and Accelerator simulation modes. For more
information about these modes, see “Accelerating Models” in the Simulink
documentation.

The default simulation mode is Normal. In this mode, Simulink software uses
interpreted code, rather than compiled C code during simulations.

In the Accelerator mode, Simulink Design Optimization software runs
simulations during estimation with compiled C code. Using compiled C code
speeds up the simulations and reduces the time to estimate parameters.

Limitations

You cannot use the Accelerator mode if your model contains algebraic loops.
If the model contains MATLAB function blocks, you must either remove them
or replace them with Fen blocks.

Setting the Accelerator Mode for Parameter
Estimation

To set the simulation mode to Accelerator, open the Simulink model window
and perform one of the following actions:

e Select Simulation > Accelerator.

® Choose Accelerator from the drop-down list as shown in the next figure.




Accelerating Model Simulations During Estimation

idle_speed

File Edit Wiew Simulation Format Tools Help

O =EH&| &R <=4 =2y mji5

Ready

Idle Speed Engine
Copyright (o) 2002-2004 The

I Mormal

Idle
Speead

alve ﬂ

Woltage deniE)
Transfer Fen

gainz

deniz)

o S

Engine Speed

Transport Transfer Fen
Delay
gain3
deniz)
w3 Transfer Fen2
Click on the Start button in the GUIl to
run an estimation.
[1o0%

|ode4s

S |

Tip To obtain the maximum performance from the Accelerator mode, close

all Scope blocks in your model.
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Speeding Up Parameter Estimation Using Parallel

Computing

In this section...

“When to Use Parallel Computing for Estimating Model Parameters” on
page 2-52

“How Parallel Computing Speeds Up Parameter Estimation” on page 2-53
“Specifying Model Dependencies” on page 2-56

“Configuring Your System for Parallel Computing” on page 2-56

“How to Use Parallel Computing in the GUI” on page 2-58

“Troubleshooting” on page 2-62

When to Use Parallel Computing for Estimating
Model Parameters

You can use Simulink Design Optimization software with Parallel Computing
Toolbox™ software to speed up parameter estimation of Simulink models.
Using parallel computing may reduce the estimation time in the following
cases:

® The model contains a large number parameters to estimate, and the
Nonlinear least squares or Gradient descent is selected as the
estimation method.

e The Pattern search method is selected as the estimation method.

¢ The model is complex and takes a long time to simulate.

When you use parallel computing, Simulink Design Optimization software
distributes independent simulations to run them in parallel on multiple
MATLAB sessions, also known as workers. The time required to simulate
the model dominates the total estimation time. Therefore, distributing the
simulations significantly reduces the estimation time. For more information
on the expected speedup, see “How Parallel Computing Speeds Up Parameter
Estimation” on page 2-53.
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The following sections describe how to configure your system, and use parallel
computing:

® “Configuring Your System for Parallel Computing” on page 2-56

e “How to Use Parallel Computing in the GUI” on page 2-58

¢ “How to Use Parallel Computing at the Command Line” on page 2-116

How Parallel Computing Speeds Up Parameter
Estimation

You can enable parallel computing with the Nonlinear least squares,
Gradient descent and Pattern search estimation methods in the Simulink
Design Optimization software. The following sections describe how parallel
computing speeds up the estimation:

¢ “Parallel Computing with Nonlinear least squares and Gradient descent
Methods” on page 2-53
¢ “Parallel Computing with the Pattern search Method” on page 2-54

Parallel Computing with Nonlinear least squares and Gradient
descent Methods

When you select Gradient descent as the estimation method, the model is
simulated during the following computations:
® (Objective value computation — One simulation per iteration

® (Objective gradient computations — Two simulations for every tuned
parameter per iteration

® Line search computations — Multiple simulations per iteration

The total time, Ttotal , taken per iteration to perform these simulations is
given by the following equation:

Ttotal = T+(Np><(2XT))+(leXT) = TX(1+(2XNp)+le)
where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of parameters to estimate, and Nis is
the number of line searches.
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When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for objective gradient computations.
The simulation time taken per iteration when the gradient computations

are performed in parallel, TtotalP, 1s approximately given by the following
equation:

TtotalP = T + (ceil & X 2XT)+ (NisxT)=Tx(1+2xceil &
Nw N

w

)+ Nis)

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected reduction of the total estimation time is given by the following
equation:

1+2x ceil(Np)-F Nis
TtotalP _ Nuw
Ttotal 1+ (2% Np) + Nis

For example, for a model with N,=3, N,=4, and N, =3, the expected reduction of

1+2xceil(i)+ 3
the total estimation time equals =0.6.
1+(2x3)+3

Parallel Computing with the Pattern search Method

The Pattern search method uses search and poll sets to create and compute
a set of candidate solutions at each estimation iteration.
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The total time, Ttotal , taken per iteration to perform these simulations, is
given by the following equation:

Ttotal = (T'x Npx Nss) + (T x Npx Nps) = T'x Np X (Nss + Nps)
where T is the time taken to simulate the model and is assumed to be equal
for all simulations, Np is the number of parameters to estimate, Nss 1s a

factor for the search set size, and Nps is a factor for the poll set size.

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for the search and poll set computations,
which are evaluated in separate parfor loops. The simulation time taken per

iteration when the search and poll sets are computed in parallel, TtotalP
is given by the following equation:

TiotalP = (T x ceil(Npx N %)) + (T x ceil (Np x Nps))
Nw Nw

= T x (ceil(Np x %) + ceil(Np x %ps))

w

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with

configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speed up for the total estimation time is given by the following
equation:

ceil(Np x %) + ceil(Np x ]st)

TtotalP _ w

Ttotal Npx(Nss+ Nps)

For example, for a model with N,=3, N,=4, N, =15, and Nos=2, the expected

cetl(3 x %) + ceil(3x g)

4
d 1 =0.27.
speedup equals 3x(1572)
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Using the Pattern search method with parallel computing may not speed
up the estimation time. When you do not use parallel computing, the method
stops searching for a candidate solution at each iteration as soon as it finds a
solution better than the current solution. When you use parallel computing,
the candidate solution search is more comprehensive. Although the number
of iterations may be larger, the estimation without using parallel computing
may be faster.

Specifying Model Dependencies

Model dependencies are files, such as referenced models, data files and
S-functions, without which a model cannot run. When you use parallel
computing, Simulink Design Optimization software helps you identify model
path dependencies. To do so, the software uses the Simulink Manifest Tools.
The dependency analysis may not find all the files required by your model.
For example, folder paths that contain code for your model or block callback.
To learn more, see the “Scope of Dependency Analysis” in the Simulink
documentation.

If your model has dependencies that the software cannot detect automatically,
you must add the dependencies before you start the estimation using parallel
computing:

1 Add the path dependencies, as described “How to Use Parallel Computing
in the GUI” on page 2-58 and “How to Use Parallel Computing at the
Command Line” on page 2-116.

2 Add the file dependencies, as described in “Configuring Parallel Computing
on Multiprocessor Networks” on page 2-57.

Note When you use parallel computing, verify that the remote MATLAB
workers can access all the model dependencies. The optimization errors out if
all the remote workers cannot access all the model dependencies.

Configuring Your System for Parallel Computing

You can use parallel computing on multi-core processors or multi-processor
networks. To configure your system for parallel computing, see the following
sections:
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¢ “Configuring Parallel Computing on Multicore Processors” on page 2-57

® “Configuring Parallel Computing on Multiprocessor Networks” on page 2-57

After you configure your system for parallel computing, you can use the GUI
or the command-line functions to estimate the model parameters.

Configuring Parallel Computing on Multicore Processors

With a basic Parallel Computing Toolbox license, you can establish a pool of
up to four parallel MATLAB sessions in addition to the MATLAB client.

To start a pool of four MATLAB sessions in local configuration, type the
following at the MATLAB prompt:

matlabpool open local

To learn more, see the matlabpool reference page in the Parallel Computing
Toolbox documentation.

Configuring Parallel Computing on Multiprocessor Networks

To use parallel computing on a multiprocessor network, you must have
the Parallel Computing Toolbox software and the MATLAB® Distributed
Computing Server™ software. To learn more, see the Parallel Computing
Toolbox and MATLAB Distributed Computing Server documentation.

To configure a multiprocessor network for parallel computing:

1 Create a user configuration file to include any model file dependencies, as
described in “Defining Configurations” and FileDependencies reference
page in the Parallel Computing Toolbox documentation.

2 Open the pool of MATLAB workers using the user configuration file,
as described in “Applying Configurations in Client Code” in the Parallel
Computing Toolbox documentation.

Opening the pool allows the remote workers to access the file dependencies
included in the user configuration file.
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How to Use Parallel Computing in the GUI

After you configure your system for parallel computing, as described in
“Configuring Your System for Parallel Computing” on page 2-56, you can use
the GUI to estimate the model parameters.

Tip If you want to use functions to estimate parameters using parallel
computing, see “How to Use Parallel Computing at the Command Line” on
page 2-116.

1 Open the Simulink model by typing the model name at the MATLAB
prompt.

2 Configure the model for parameter estimation, as described in “Configuring
Parameter Estimation in the GUI” on page 2-3.

3 In the Estimation tab of the New Estimation node, click Estimation
Options.
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4 In the Parallel Options tab, select the Use the matlabpool during
optimization option.

This action checks for model path dependencies in your Simulink model and
displays the path dependencies in the Model path dependencies list box.

Note As described in “Specifying Model Dependencies” on page 2-56,
the automatic path dependencies check may not detect all the path
dependencies in your model.

). Options - New Estimation =07 =]

Simulation Options | Optimization Options  Parallel Options |

[¥ Use the matlabpoal during optimizatioré

~Madel path dependencies

Ma madel path dependencies.

Add path dependency. .. | Sync path dependencies From madel

QK Cancel | Help | Apply

5 (Optional) Add the path dependencies that the automatic check does not
detect.

a Specify the paths in the Model path dependencies list box.

You can specify the paths separated with a semicolon, or on a new line.
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b Click Apply to include the new paths.
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4

6 (Optional) If you modify the Simulink model such that it introduces a new
path dependency, then you must resync the path dependencies. Click Synec

2-61



2 Parameter Estimation

2-62

path dependencies from model in the Parallel Options tab to rerun
the automatic dependency check for your model.

This action updates the Model path dependencies list box with any new
path dependency found in the model.

7 Click OK.

8 In the Estimation tab, click Start to estimate the model parameters using
parallel computing.

9 Examine the values of the estimated parameters in the Value column of
the Parameters tab.

For more information on how to troubleshoot estimation results you
obtained using parallel computing, see “T'roubleshooting” on page 2-62.

Troubleshooting

* “Why are the estimation results with and without using parallel computing
different?” on page 2-62

® “Why do I not see the estimation speedup I expected using parallel
computing?”’ on page 2-63

* “Why does the estimation using parallel computing not make any
progress?” on page 2-64

® “Why do I receive an error "Cannot save model
tpe5468c55_910c_4275_94ef 305e2eeeeef4"?” on page 2-64

® “Why does the estimation using parallel computing not stop when I click
Stop?” on page 2-64

Why are the estimation results with and without using parallel
computing different?

The values of the estimated parameters obtained using parallel computing
may differ from the values obtained without using parallel computing. The
results can be different under the following conditions:

¢ Different numerical precision on the client and worker machines can
produce marginally different simulation results. Thus, the estimation
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method may take a completely different solution path and produce a
different result.

Note Numerical precision can differ because of different operating systems
or hardware on the client and worker machines.

e The state of the model on the client and the worker machines can differ,
and thus lead to a different result. For example, the state can become
different if you change a parameter value initialized by a callback function
on the client machine after the workers have loaded the model. The model
parameter values on the workers and the client are now out of sync, which
can lead to a different result.

After you change the model parameter values initialized by a callback
function, verify that the parameters exist in the model workspace or
update the callback function so that the remote workers have access to the
changed parameter values.

® When you use parallel computing with the Pattern search method, the
method searches for a candidate solution more comprehensively than when
you do not use parallel computing. This more comprehensive search can
result in a different solution. To learn more, see “Parallel Computing with
the Pattern search Method” on page 2-54.

Why do | not see the estimation speedup | expected using
parallel computing?

¢ The resulting estimation time may not be faster when you estimate a
small number of model parameters or when the model does not take
long to simulate. In such cases, the overheads associated with creating
and distributing the parallel tasks outweighs the benefits of running the
simulations during estimation in parallel.

e Using Pattern search method with parallel computing may not speed up
the estimation time. When you do not use parallel computing, the method
stops searching for a candidate solution at each iteration as soon as it finds
a solution better than the current solution. The candidate solution search
1s more comprehensive when you use parallel computing. Although the
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number of iterations may be larger, the optimization without using parallel
computing is faster.

To learn more about the expected speedup, see “Parallel Computing with
the Pattern search Method” on page 2-54.

Why does the estimation using parallel computing not make
any progress?

In some cases, the gradient computations on the remote worker machines
may silently error out when you use parallel computing. In such cases, the
Estimation progress table shows that the f(x) values do not change, and
the optimization terminates after two iterations.

To troubleshoot the problem:

1 Run the optimization for a few iterations without parallel computing to
see if the optimization progresses.

2 Check if the remote workers have access to all model dependencies. To
learn more, see “Specifying Model Dependencies” on page 2-56.

Why do | receive an error "Cannot save model
tpe5468c55 910c_4275 94ef 305e2eeeeefd"?

When you select Refined as the Gradient type, the software may error out
when it saves a temporary model to a nonwriteable folder, and then displays
this error message. Change the Gradient type to Basic to clear this error.

To learn more, see “Selecting Additional Optimization Options” on page 2-27.

Why does the estimation using parallel computing not stop
when | click Stop?

When you use parallel computing, the software has to wait till the current
iteration completes before it notifies the workers to stop the estimation. The
estimation does not terminate immediately when you click Stop, and appears
to continue to run.
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Estimating Initial States

In this section...
“How to Estimate Initial States in the GUI” on page 2-65

“Estimating Initial Conditions for Blocks with External Initial Conditions”
on page 2-66

“Example — Estimating Initial States of a Mass-Spring-Damper System”
on page 2-67

How to Estimate Initial States in the GUI

In general, you choose to estimate only those states that are not already in
the model. Before you estimate initial conditions, you must have already
imported the estimation data and specified the parameters to estimate, as
described in “Specifying Data for Parameter Estimation” on page 2-4 and
“Specifying Parameters to Estimate” on page 2-6, respectively.

To estimate initial conditions (or initial states) if they are not known:

1 In the Control and Estimation Tools Manager, select the Variables node
in the Workspace tree.

2 Click the Estimated States tab.

3 Click Add to open the Select States dialog box.

2-65



2 Parameter Estimation

x| By default, the Select States dialog box looks at all
Select additional states to estimate states of all blocks in the model.
Elock Marme Length |
engine_idle_speediTra... 2 :I
engine_idle_speediTra... 2 — .
engine_idle_speediTra... 2 T LISt Of states

Use your mouse fo select data. To select adjocent states,
hold down the Shift key while clicking the first and last
state in the selection. To select nonadjacent states, hold
down the Cirl key while clicking each state.

=

fall |§<:ance|§ Help | Al |

4 Select the states to estimate and click OK.

The states selected for estimation are added to the Estimated States tab.
For an example of estimating initial states, see “Example — Estimating
Initial States of a Mass-Spring-Damper System” on page 2-67.

Estimating Initial Conditions for Blocks with External
Initial Conditions

When an integrator block uses an initial-condition port, which you specify
by an IC block feeding into the integrator block, you cannot estimate the
initial conditions (ICs) of the integrator using Simulink Design Optimization
software. This is because external ICs have priority over the ICs of a specific
block to maintain the integrity of the model.

To tune the ICs of an integrator block with external ICs, you must modify the
model to make the external signal into a tunable parameter. For example,
you can set the IC block that feeds into the integrator to be a tunable variable
and estimate it.
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Example — Estimating Initial States of a
Mass-Spring-Damper System

“Loading the Example” on page 2-67
“Model Parameters” on page 2-68
“Setting Up the Estimation Project” on page 2-69

“Importing Transient Data and Selecting Parameters for Estimation” on
page 2-70

“Selecting Parameters and Initial Conditions for Estimation” on page 2-72
“Creating the Estimation Task” on page 2-73

“Running the Estimation and Viewing Results” on page 2-75

Loading the Example
To open the Simulink model of a mass-spring-damper system, type:

msd_system

at the MATLAB prompt.

This action also loads the two sets of measured data with differing initial
conditions.
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E!msd_system
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You can also run the Initial State Estimation demo that shows how to
estimate parameters and initial states. This example goes beyond the demo
by providing in-depth discussion of each task.

Model Parameters

The output of the Simulink model, msd_system, is the position of the mass in

a mass-spring-damper system. The model is subject to a constant force F, and
an initial condition, x0, for the mass displacement. x0 is the initial condition

of the integrator block, Position.

The model parameters of interest are the mass, m, the viscous damping, b,
and the spring constant, k. For more information about physical modeling of
mass-spring-damper systems, see any book on mathematical modeling or on
automatic control systems.

For estimating the model parameters m, b, and k, this model uses two
experimental data sets. The data sets contain output data measured using
two different initial positions, x0=0.1 and x0=0.3, and additive noise.
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Click * to run a simulation. The simulation generates the following plots,
as shown in the next figure:

¢ Simulated response of the model for x0=-0.1 and parameter values, m=8,
k=500, and b=100

e Experimental data sets

i
EEIEEERN IR

Magenta and cyan lines are
experimental data sets with
different initial conditions.

Yellow line is the response
of the model to a constant force.

Setting Up the Estimation Project

To set up the estimation of initial conditions and then transient state space
data, select Tools > Parameter Estimation in the msd_system model
window.
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=] Control and Estimation Tools Manager i ] ]

File View Help
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i,\ Workspace ~Task settings
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[/ Transient Data | ||| Subject: I
Variables Author: I
Estimation
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Description: :I
||
Maodel: msd_system Cpen Model Update Task |
-
-
Select the nodes below to configure and run estimations. A

Importing Transient Data and Selecting Parameters for
Estimation

To import data for initial state estimation:

1 In the Control and Estimation Tools Manager, select Transient Data
under the Estimation Task node.

2 Right-click Transient Data, and select New to create a New Data node.

3 Select New Data under the Transient Data node.

4 In the Output Data pane of the New Data node, select the Data column
of the msd_system/Position state, and click Import. The Data Import

dialog box opens.

Select yexp1, and click Import to assign the data yexp1 to the model.

2-70



Estimating Initial States

5 In the Output Data pane, select the Time/Ts column of the
msd_system/Position state. In the Data Import dialog box, select texp1,
and click Import to assign the time vector texp1 to the model.

6 Right-click New Data in the Workspace tree, and rename it to Data
set #1.

7 Repeat steps 2-5 to add a second data set, yexp2 and texp2. Rename the
data set to Data set #2.

The Control and Estimation Tools Manager GUI now resembles the next
figure.

«): Control and Estimation Tools Manager 0] x|
File  wiew Help

s =2 = W)

Workspace Input Data Cuthut Data | State Data |
G Project - msd_system
) Estimation Task

~&zsign Data to Block:

Experimertal Data

Elock Matne
Data [ rmeits | isight | Length

msd_system/Position
Charnel - 1 [ yewton [ temicn [ 1 [ 7676
msd_system/Velocity
Chaninel - 1 | - ‘ - | 1 |

Wariables
LB Estimation
“alidation

Irport.... Pre-process... Cleat Al |
~ New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels to configure the transient data set. A

For more information on importing data, see “Importing Data into the GUI”
on page 1-5.
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Selecting Parameters and Initial Conditions for Estimation

To select the parameters and initial states you want to estimate for the
Simulink model msd_system:

1 Select the Variables node in the Workspace tree of the Control and
Estimation Tools Manager GUI.

2 In the Estimated Parameters pane, click Add to open the Select
Parameters dialog box.

3 Select the parameters b, k, and m, and then click OK. The selected
parameters now appear in the Selected parameters area of the
Estimated Parameters pane.

4 In the Estimated States pane, click Add.

The Select States dialog box opens, which displays all the available states
of the msd_system model. Select msd_system/Position, and click OK.

x

—Select additional states to estimate

Blodk Mame Length
. _ Select states with initial
d svetem Velod 1 conditions that you want
msd_system/Velodity to estimate.

Hold down Shift, and use
your mouse to select
groups of adjacent states.
Hold down Ctrl, and use
your mouse to select
non-adjacent states.

QK Ca... Help | Apply |
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Note For states that you do not estimate, the software uses the initial
condition value specified in the Simulink model. In this example, the value
of initial velocity, as specified in the model is 0.

The selected state appears in the Selected states area of the Estimated
States pane, as shown in the next figure.

«J: Control and Estimation Tools Manager =101 x|

File  wiew Help

ok 0| ||

Workspace Estitnated Parameters Estitnated States
Project - mzd_system —Selected state

) Estimation Task

= lﬁ Transient Data
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Elock name:  Posttion

Ve J-0
Imitial guess: I-D.1
Minitrim: I-Inf
aximurm: |+In1

Typical walue; I—El.1

Satnple tirme: IEI

Full narme:

msd_system/Position =

Addd... Delete | ;I

L L

Configure here your parameters and states to estimate.

For more information on selecting parameters to estimate, see “Specifying
Parameters to Estimate” on page 2-6.

Creating the Estimation Task

To create an estimation task in the Control and Estimation Tools Manager
GUI, select the Estimation node in the Workspace tree, and click New.
This action creates a New Estimation node.
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In the New Estimation node, select the following check boxes:

1 Data Set #1 and Data Set #2 in the Data Sets pane.

2 Estimate for b, k, and m in the Parameters pane.

3 Estimate for Position in the States pane. Make sure to select this check
box for both Data Set #1 and Data Set #2 to estimate the initial position

for the spring.

Data Setsl Parameters States I Esh’mah’onl

Estimation states

States for data set: | Data Set #1 |
Data Set #1 |
Mame {1 m Maximum | Typical Value
Position : W : n +Inf -0.1

Although the initial positions for the two data sets differ, specify the initial
state guesses for both data sets as -0.1. The Control and Estimation Tools
Manager GUI now resembles the following figure.
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=] Control and Estimation Tools Manager 10l =|
File View Help
=
sl =
., Warkspace Data Sets | Parameters States | Estimation
=gl Project - msd_system o=
E}-- Estimation Task
Transient Data States for data set: I Data Set #1 LI
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A Position [ 01 ] 2 | anf [ #nf [ 01
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E@ MNew Estimation
Ea Views
Ea Validation
4 | o
Use Value as Initial Guess Reset to Default Settings Save gz Default Settings |
4 |
- New Estimation node has been added to Estimation. ;I
[
Select the tab panels to configure your estimation. 4

Running the Estimation and Viewing Results
Click Start in the Estimation pane to run the estimation.

As the estimation proceeds, the most current estimation of the position
response (yellow curve) updates in the Scope. The curve toggles between
the two experimental data sets because the software uses the two data sets
successively to update the estimates of the parameter values. The software
converges to the correct parameter values, within the scope of experimental
noise and optimization options settings. The closeness of the estimated

response (yellow) to the experimental data (magenta) indicates that simulated

data is a good match to the measured data. .
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View the initial position estimates for Data Set #1 and Data Set #2 in the
Value column of the States tab. The estimated values match closely with
the known values, 0.1 and 0.3 of initial position.

~Estimation states
States for dataset: | Data Set £1 ]

Mame Value Estimate Initial Guess Minimurm Maximum | Typical Value

Position

View the estimated parameter values in the Value column of the Parameters
tab.
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Data Sets Parameters | states | Estimation |
Estimation parameters

Mame Value Estimate Initial Guess Minimum Maximum | Typical Value
b 57.957 [ b -Inf +Inf b
ke 400,27 I k -Inf +Inf k
m 9.7862 I m -Inf +Inf m

The estimation of initial states is important for obtaining the correct
estimates of the model parameters. You do not set the initial states (x0 in this
case) as parameters because the initial states do not represent fixed physical
properties of the system. For different experimental data or operating
conditions, these states need not be unique.

In this example, you use two data sets with distinct initial positions together
for a single estimation of model parameters. While the estimates of the

model parameters are unique, the initial state (position) is different, and you
estimate them individually for each data set.
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Working with Estimation Projects

In this section...

“Structure of an Estimation Project” on page 2-78
“Managing Multiple Projects and Tasks” on page 2-79
“Adding, Deleting and Renaming an Estimation Project” on page 2-80

“Saving Control and Estimation Tools Manager Projects” on page 2-81

“Loading Control and Estimation Tools Manager Projects” on page 2-82

Structure of an Estimation Project

The Control and Estimation Tools Manager, which i1s a graphical user
interface (GUI) for performing parameter estimation, stores and organizes all
data from a given Simulink model inside a project. To open the Control and
Estimation Tools Manager GUI, select Tools > Parameter Estimation in
the Simulink model window.

When using the Control and Estimation Tools Manager for parameter
estimation, you can

e Manage estimation projects.

® Select parameters and initial conditions to configure the estimation.
® Specify cost functions.

® Import experimental data (to be matched by the output of your Simulink
model).

® Specify the initial conditions of your model.
Each estimation task can include

® One or more data sets
¢ Parameter information

® One or more sets of estimation settings, or configurations
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The default project name is the same as the Simulink model name. The
project name is shown in the Workspace tree of the Control and Estimation
Tools Manager.

You can also add tasks from Simulink® Control Design™ and Model Predictive
Control Toolbox™ software to the current project, if these products are
installed on your system.

Managing Multiple Projects and Tasks

The Control and Estimation Tools Manager works seamlessly with products
in the Controls and Estimation family. In particular, if you have licenses for
Simulink Control Design or Model Predictive Control Toolbox software, you

can use these products to perform tasks on projects that you have created in
Simulink Design Optimization software, and vice versa.

This figure shows a tools manager with multiple projects and multiple tasks.
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You can save projects individually, or group multiple projects together in
one saved file, as described in:

® “Saving Control and Estimation Tools Manager Projects” on page 2-81

® “Loading Control and Estimation Tools Manager Projects” on page 2-82

Adding, Deleting and Renaming an Estimation Project
To add, delete, or rename the project or task:

1 Right-click the project or task node in the Workspace tree.

2 Select the appropriate command from the shortcut menu.
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Saving Control and Estimation Tools Manager
Projects

A Control and Estimation Tools Manager project can consist of tasks from
products such as Simulink Control Design, Simulink Design Optimization,
and Model Predictive Control Toolbox software. Each task contains data,
objects, and results for the analysis of a particular model.

To save your project as a MAT-file, select File > Save in the Control and
Estimation Tools Manager window.

«} Save Projects =] |

Projects:

Project t14 ||

=

034 | Cann::ell Helg |

To save multiple projects within one file:

1 In the Save Projects dialog box, select the projects that you want to save.
2 Click OK.

3 Choose a folder and name for your project file by either browsing for a file
or typing the full path and filename in the Save as field. Click Save.
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Loading Control and Estimation Tools Manager
Projects

To open previously saved projects, select File > Load in the Control and
Estimation Tools Manager window.

+} Load Projects =] |

Projects:

Project t14 ||

[

Load from: I’E|"DESH:Dp".F'rDjEC‘t -f1dmat .. |

034 | Cann::ell Helg |

In the Load Projects dialog box, choose a project file by either browsing for
the folder and file, or by typing the full path and filename in the Load from
field. Project files are always MAT-files. The projects within this file appear
in the Projects list.

Select the projects that you want to load, then click OK. When a file contains
multiple projects, you can choose to load them all or just a few.
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Estimating Parameters at the Command Line

In this section...

“Workflow for Estimating Parameters at the Command Line” on page 2-83

“Example — Estimating Parameters and Initial States at the Command
Line” on page 2-84

“Objects for Parameter Estimation” on page 2-95

“How to Use Parallel Computing at the Command Line” on page 2-116

Workflow for Estimating Parameters at the
Command Line

In addition to the Control and Estimation Tools Manager GUI, you can also
use Simulink Design Optimization functions to perform parameter and state
estimation. These functions perform the same tasks as the tools manager,
but have the advantages of command-line execution. When you perform a
state or parameter estimation using the GUI, you create MATLAB objects for
all the states and parameters of your model. If you have a large number of
states or parameters, this can use up large amounts of memory and cause
computational delays. With the command-line approach, only those states
and parameters that you select are assigned MATLAB objects, which is more
efficient.

In addition, the command-line approach is useful for batch jobs where you can
estimate parameters for a large numbers of models.

Simulink Design Optimization software uses MATLAB objects to perform
estimation tasks. To learn more about object-oriented programming, see
the Object-Oriented Programming documentation for a description of
object-oriented programming in MATLAB.

Simulink Design Optimization command-line interface requires a Simulink
model as a starting point for analysis and estimation.
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Note The Simulink model must contain an Inport or Outport block or logged
signals to enable assigning data to the signals. For more information on how
to configure a Simulink model for parameter estimation, see “Configuring a
Model for Importing Data” on page 1-2.

After you configure your model for parameter estimation, as described in
“Configuring a Model for Importing Data” on page 1-2, the estimation process
at the command line consists of the following steps:

1 Defining experiments consisting of empirical data sets, and the operating
conditions and/or initial conditions of your model.

2 Selecting the variables and states to be estimated.
3 Performing the estimation.

4 Reviewing the results and iterating as necessary.
5 Validating estimation results.

See “Objects for Parameter Estimation” on page 2-95

for more information on how to use methods and properties to perform
parameter estimation.

Note The Simulink model must remain open to perform parameter
estimation tasks.

For an example of estimating parameters using command-line functions,
see “Example — Estimating Parameters and Initial States at the Command
Line” on page 2-84.

Example — Estimating Parameters and Initial States
at the Command Line

® “Loading the F14 Jet Model” on page 2-85
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e “Baseline Simulation” on page 2-86
e “Creating a Transient Experiment Object” on page 2-88

® “Assigning Experimental Data to Inputs and Outputs of the Model” on
page 2-89

® “Creating Parameter Objects for Estimation” on page 2-90

® “Creating an Estimation Object and Running the Estimation” on page 2-92

Loading the F14 Jet Model

To define an experiment, you must start with a Simulink model. For this
example, type

f14

to load the F14 fighter jet model into the MATLAB workspace. The following
figure shows the f14 model.
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F14 Fighter Jet Model

This example outlines the basics of constructing an estimation project using
object-oriented code. Only what you need to run the example is presented in
this section. See “Objects for Parameter Estimation” on page 2-95 for details
on all the properties and methods associated with parameter estimation.

Baseline Simulation

Before running an estimation, you need a baseline for data comparison. First,
you must choose parameters and states’ initial conditions for estimation. This
example uses Ta, the actuator time constant, and Zd and Md, the vertical
velocity and pitch rate gains, respectively. Then use the following code to run
the Simulink f14 model. Note that this is standard Simulink code and does
not involve Simulink Design Optimization command-line interface in any
way. See sim in the Simulink Reference documentation for information about
running Simulink models from the MATLAB command line.
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%% Open the model and load experimental data.
open_system('f14"')
load f14_estim % Load empirical I/0 data.

%% Set initialize unknown parameters
% Actuator time constant (ideal: Ta = 0.05)
Ta = 0.5;

% Aircraft dynamic model parameters (ideal: Md = -6.8847,
Zd = -63.998)
-1; Zd = -80;

o°

=

d

%% Plot measured data and simulation results

[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);

plot(time, iodata(:,2:3), T, Y, '-');

legend( 'Measured angle of attack', 'Measured pilot g force',
‘Simulated angle of attack', 'Simulated pilot g force');

The following figure appears.
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As you can see, the measured and simulated data are a poor match. The
rest of this section describes how to estimate values for Ta, Zd, and Md that
result in a better match of data sets.

Creating a Transient Experiment Object

After you have a model and identify the parameters you want to

estimate, the next step is to create the objects required for an estimation.
ParameterEstimator is both the name of the class and the object instantiated
by that class. Classes are created by a constructor; objects are created by
invoking the class name with parameters.

First, create an estimation project object. This is the constructor syntax:

hExp = ParameterEstimator.TransientExperiment('f14")

For more information, see “Transient Experiment Objects” on page 2-103.
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This command returns the following information about the f14 model.

Experimental transient data set for the model 'f14':

Output Data

(1)
(2)

f14/alpha (rad)
f14/Nz Pilot (9)

Input Data

(1)

f14/u

Initial States

(1)

f14/Actuator Model

f14/Aircraft Dynamics Model/Transfer Fcn.1
f14/Aircraft Dynamics Model/Transfer Fcn.2
f14/Controller/Alpha-sensor Low-pass Filter
f14/Controller/Pitch Rate Lead Filter
f14/Controller/Proportional plus integral compensator
f14/Controller/Stick Prefilter

f14/Dryden Wind Gust Models/Q-gust model

f14/Dryden Wind Gust Models/W-gust model

Assigning Experimental Data to Inputs and Outputs of the

Model

After you create a ParameterEstimator object, assign input and output

experimental (i.e., empirical) data.

%% Create objects to represent the experimental data sets.

set(hExp.InputData(1),

set(hExp.OutputData(1),

time, 'Weight', 5);

set (hExp.OutputData(2),

‘Data’,
‘Data’,

‘Data’,

iodata(:,1), 'Time', time);

iodata(:,2), 'Time',

iodata(:,3), 'Time', time);
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Note In general, for models with multiple inputs and outputs, you must
independently assign one data object to each input and output port. The
data object you assign to a specific port can be a vector or a matrix that
corresponds to that channel. You cannot use a single I/O port to represent
multiple channels.

Creating Parameter Objects for Estimation

To activate parameters for estimation, you must create parameter objects for
the parameters you want to estimate. For this example, use Ta, the actuator
time constant, and Zd and Md, the vertical velocity and pitch rate gains,
respectively. The Zd and Md gains are located in the F14 aircraft dynamics
subsystem.
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First, create ParameterEstimator objects for the parameters you want to
estimate.
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%% Create objects to represent parameters.
hPar (1) = ParameterEstimator.Parameter('Ta');
set(hPar(1), 'Minimum', 0.01, 'Maximum', 1, 'Estimated', true)

hPar(2) = ParameterEstimator.Parameter('Md');
set(hPar(2), 'Minimum', -10, 'Maximum', O, 'Estimated', true)

hPar(3) = ParameterEstimator.Parameter('zd');
set(hPar(3), 'Minimum', -100, 'Maximum', O, 'Estimated', true)

%% Create objects to represent initial states.
hIc(1) = ParameterEstimator.State('f14/Actuator Model');
set(hIc(1), 'Minimum', O, 'Estimated', false);
For more information, see “Parameter Objects” on page 2-106.
You can also use dot notation here. For example, instead of
set(hPar(2), 'Minimum', -10, 'Maximum', O, 'Estimated', true)
you can write
hPar(2).Estimated=true;

hPar(2) .Minimum=-10;
hPar(2) .Maximum=0;
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Creating an Estimation Object and Running the Estimation

Finally, create an estimation object and run the estimation, using gcs to get
the full pathname to the Simulink model.

hEst = ParameterEstimator.Estimation(gcs, hPar, hExp);
hEst.States = hlc;

%% Setup estimation options

hEst.OptimOptions.Method = 'lsgnonlin’;
hEst.OptimOptions.GradientType = 'refined’';
hEst.OptimOptions.Display = 'iter';

%% Run the estimation
estimate(hEst);

The estimation runs for a few iterations. After the estimation completes, plot
the measured data and the simulated response.

%% Plot measured data and final simulation results
[T,X,Y] = sim('f14', time, [], [time iodata(:,1)]);

figure
plot(time, iodata(:,2:3), T, Y, '-');
legend( 'Measured angle of attack', 'Measured pilot g force',

‘Simulated angle of attack', 'Simulated pilot g force');

For more information, see “Estimation Objects” on page 2-113.
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This figure shows the results of the estimation.
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The measured and simulated outputs now appear to be a close match. Next,
look at the estimated values to see how they compare with the default values
of the f14 model.

%% Look at the estimated values
find(hEst.Parameters, 'Estimated', true)
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This command returns the following result:

(1) Parameter data for 'Ta':

Parameter value

05
Initial guess 5

0.

;0.
Estimated : true

Referenced by:

(2) Parameter data for 'Md':

Parameter value : -6.884
Initial guess : -1

Estimated : true
Referenced by:
(3) Parameter data for 'zZd':

Parameter value : -63.99
Initial guess : -80

Estimated : true

Referenced by:
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Note You can use the find command to identify scalar, vector, or matrix
parameters. The dimensions of the Estimated value you specify as the find
argument must match the dimensions of the parameters you are trying to
find. For example,

find(hEst.Parameters, 'Estimated', true)

finds only scalar estimated parameters. However,

find(hEst.Parameters, 'Estimated', [true;true])

finds only vector estimated parameters with dimensions 1-by-2 and excludes
all scalar parameters.

You can verify that these values match the default values of the f14 model by
clearing your workspace, loading the model, and checking the values.

clear all
f14
whos

Objects for Parameter Estimation

The following sections describe in more detail how to create and modify
transient data and estimation objects:

* “Transient Data Objects” on page 2-96

® “State Data Objects” on page 2-100

* “Transient Experiment Objects” on page 2-103

* “Parameter Objects” on page 2-106

* “State Objects” on page 2-109

* “Estimation Objects” on page 2-113
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First, a quick look at terminology:

e (Objects are instantiations of classes.
® (Classes contain, or rather, define, properties and methods.

® You use a constructor to create an instance of an object, and use the set
method or dot notation to modify the properties of your objects.

Transient Data Obijects

¢ “What is a Transient Data Object” on page 2-96

e “Constructor” on page 2-96

e “Properties of Transient Data Objects” on page 2-97

* “Modifying Properties of Transient Data Objects” on page 2-99
e “Using Class Methods” on page 2-100

What is a Transient Data Object. The @TransientData object encapsulates
the data measured at a single input or output of a physical system during

an experiment. Transient data objects are associated with three types of
Simulink blocks:

® Inport blocks
® Qutport blocks

¢ Internal blocks used in conjunction with signal logging.

Each @TransientData object describes the time history of a signal at a
Simulink port. A data set is identified by the Block property of this object
corresponding to a block name in the Simulink model. A PortNumber value
is also necessary for internal blocks to uniquely identify signals within the
block diagram.

Constructor. Estimating parameters requires a transient data object, which
you create using a constructor. The syntax to create a transient data object is

% I/0 port block
h = ParameterEstimator.TransientData('block');
I

nternal block

[
“©



Estimating Parameters at the Command Line

h = ParameterEstimator.TransientData('block',portnumber);

= ParameterEstimator.TransientData('block',data,time);

= ParameterEstimator.TransientData('block',data,Ts);

= ParameterEstimator.TransientData('block',portnumber,data,time);
= ParameterEstimator.TransientData('block',portnumber,data,Ts);

> 5 5 S
|

Properties of Transient Data Objects. Descriptions of properties of the
transient data object and the associated input parameters are as follows.

Transient Data Object Properties

Property Description

Block Name of the Simulink block with which the data is
associated. Must be a string.

PortType The type of signal that this object represents is determined
in the constructor from the Block property, which may be
Inport, Outport, or Signal.

PortNumber For data associated with the outputs of regular blocks
or subsystems, this property specifies the output port
number of interest. The default value is 1.

Dimensions Dimensions of the data required for this data set. It is
computed from the CompiledPortDimensions property of
the appropriate port of the block, and it defines the size
of other properties. Currently, Simulink supports scalar,
vector, or matrix signals, so Dimensions is either a scalar
or a 1-by-2 array.
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Transient Data Object Properties (Continued)

Property Description

Data Actual experimental data. Its size must be consistent
with the Dimensions property. To conform with Simulink
conventions, the data is stored in the following formats:

¢ Scalar or vector-valued data. The data is of the form Ns
m, where Ns is the number of data samples, and m is
the number of channels in the signal.

e Multidimensional data (matrix and higher dimensions).
The data is of the form m1. .. mn Ns, where Ns is
the number of data samples, and mi is the number of
channels in the ith dimension of the signal.

¢ For missing or unspecified data, NaNs are used.

Ts, For uniformly sampled data, Ts is the sample time and
Tstart, Tstart is the start time of the signal. The stop time Tstop
Tstop and the time vector Time are given by

Tstop = Tstart + Ts * (Ns -1)
Time = Tstart : Ts : Tstop

For nonuniform time data, Ts is set to NaN, and the start
and stop times are calculated from the time vector.

Time The time data in column vector format. The length of Time
must be consistent with the number of samples in Data.

For a nonuniformly spaced Time vector, its length should
match the length of Data.

Otherwise, Time is automatically adjusted based on the
length of Data.

Modifying Ts resets Time internally. In this case, Time is
a virtual property whose value is computed from Ts and
Tstart when you request it. The rules for setting time
related properties are

® Modifying Time sets
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Transient Data Object Properties (Continued)

Property Description

Ts = NaN
Tstart = Time(1)

e If the time vector is uniformly spaced, a sample time
Ts is calculated.
¢ Modifying Tstart translates time forward or backward.

¢ Modifying Ts sets Time = [] internally and generates
it when required by the simulation.

Weight The weight associated with each channel of this data set.
It is used to specify the relative importance of signals.
The default value is 1.

InterSample Interpolation method between samples can be zero-order
hold (zoh) or first-order hold (foh). This property is used
for data preprocessing.

Modifying Properties of Transient Data Objects. After a transient data
object 1s created, you can modify its properties using this syntax:

ini.Data = rand(2,1,10); % 10 data values each of size [2 1]
in1.Time 1:10; % Automatically converted to column vector

Some properties (e.g., Weight) support scalar expansion with respect to the
value of the Dimensions property.
Example: Assigning Input Port Data

To assign data to an input port with 2-by-3 port dimensions, use

in1 = ParameterEstimator.TransientData(gcb, rand(2,3,100), 0.05)

This command returns the following result:
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(1) Transient data for Inport block 'portdata_test noSim/By//Pass
Air Valve Voltage':

Sampling interval: 0.05 sec.

Data set has 100 samples and 6 channels.

Using Class Methods. Descriptions of two important methods are given
next:

® select — Extracts a portion of data. The result is returned in a new
transient data object.

in2 = select(in1, 'Sample', 10:100); % 91 samples

in3 select(in1, 'Range', [1 4]); % Samples for 1<t<4

% ... or an alternative

in3 select(in1, 'Sample', find(ini1.Time > 1 & in1.Time < 4));

To extract data from a subset of available channels, use

in4 = select(in1, 'Channel', [1 3 2]);

)

% channels 1,3,and 2 in this order
e hiliteBlock — Highlights the block associated with this object in the
Simulink diagram.

¢ update — Updates the transient data object from the corresponding
Simulink model block.

State Data Objects

* “What is a State Data Object” on page 2-101

® “Constructor” on page 2-101

® “Properties of the State Data Object” on page 2-101
¢ “Example: Initial Condition Data” on page 2-103

e “Modifying Properties” on page 2-103

e “Using Class Methods” on page 2-103
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What is a State Data Object. The ParameterEstimator.StateData
object defines the known states of a dynamic Simulink block. It is used in a
transient estimation context to define known initial conditions of a block
diagram model, and in a steady-state estimation context to define the known
states of the model.

For example, the Simulink model of a simple mass-spring-damper system
has two integrator blocks to generate velocity and position signals from
acceleration and velocity values, respectively, during simulation. If the
corresponding physical system is known to be at rest at the beginning of an
experiment, the initial states (velocity and position) of these integrators are
zero. So, two @StateData objects can be created to describe these known
initial conditions.

Constructor. The syntax for creating this object is

h
h

ParameterEstimator.StateData('block');
ParameterEstimator.StateData('block', data);

In the first constructor, the state vector is initialized from the model
containing the block.

Properties of the State Data Object. Descriptions of some important
properties are given in the following table .

State Data Object Properties

Property Description

Block Name of the Simulink block whose states are defined
by this object.

Dimensions Scalar value to store the number of states of the relevant
block.
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State Data Object Properties (Continued)

Property Description

Data Column vector to store the initial value of the state

for the block specified by this object. The length of

this vector should be consistent with the Dimensions
property. Since the underlying Simulink model also
stores an initial state vector for all dynamic blocks, the
following conventions are used to resolve the initial state
values during estimations:

¢ [f Data is not empty, use it when forming the state
vector.

¢ [f Data is empty, get the state vector for this block
from the model. This behavior is useful when using
helper methods to create an experiment object that
instantiates empty state data objects for all dynamic
blocks in the Simulink model.

e [f there is no state data object for a dynamic block in
the model, get the state vector of that block from the
model. This behavior is useful for command-line users,
when there are too many states in the model and only
a few of them have to be set to different initial values.

Ts Sampling time of discrete blocks. Set to 0 for continuous
blocks. This property is read only and is currently used
for information only.

Domain String to hold the physical domain of the block. Used for
SimMechanics or SimPowerSystems blocks with states.
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Example: Initial Condition Data. To create an empty initial condition
object for the engine_idle speed/ TransferFcn2, use

st1 = ParameterEstimator.StateData ...
('engine_idle_speed/Transfer Fcn2', [1 2])

(1) State data for 'f14/Dryden Wind Gust Models/W-gust model’
block:

The block has 2 continuous state(s).

State value : [1;2]

Modifying Properties. After a state data object is created, you can modify
its properties using this syntax:

st1.Data = [2 3]; % State vector of size 2

Some properties (e.g., Data) support scalar expansion with respect to the
value of the Dimensions property.

Using Class Methods. Description of two important methods are given next:

hiliteBlock — Highlights the block associated with this object in the
Simulink diagram.

update — Updates the object after the Simulink model has been modified.
If the Dimensions property value changes, the other properties are reset to
their default values.

Transient Experiment Objects

“What is a Transient Experiment Object” on page 2-104
“Constructor” on page 2-104

“Properties of Transient Experiment Objects” on page 2-104
“Example: Creating an F14 Experiment” on page 2-105

“Example: Creating a Van der Pol Experiment from User Objects” on
page 2-105

“Modifying Properties” on page 2-105
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e “Using Class Methods” on page 2-106
What is a Transient Experiment Object. The @TransientExperiment
object encapsulates the data measured at the input and output ports of a
system during a single experiment, as well as the system’s known initial
states.
Constructor. The syntax to create a transient experiment object is

h = ParameterEstimator.TransientExperiment('model’);

where model specifies the name of the Simulink model.

Properties of Transient Experiment Objects. Descriptions of some
important properties are given in the following table.

Transient Experiment Object Properties

Property Description

Model Simulink model with which this experiment is
associated.

InputData, Transient data objects associated with appropriate I/0

OutputData blocks in the model. Blocks with unassigned objects
or objects with no data are not used in estimations,
meaning:

® For input ports, assign zeros to these ports/channels
during simulation.

¢ For output ports, don’t use these ports/channels in
the cost function.

InitialStates State data objects associated with appropriate dynamic
blocks in the model.

InitFcn Function to be executed to configure the model for this
particular experiment.
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Example: Creating an F14 Experiment. To create an empty transient
experiment for the f14 model, use

expl = ParameterEstimator.TransientExperiment('f14"')
Experimental (Transient) data set for the model 'f14':
Outputs

(1) f14/alpha (rad)

(2) f14/Nz Pilot (9)

Inputs

(1) f14/u

Initial States

(1) f14/Actuator Model

2) f14/Aircraft Dynamics Model/Transfer Fcn.1
f14/Aircraft Dynamics Model/Transfer Fcn.2
f14/Controller/Alpha-sensor Low-pass Filter
f14/Controller/Pitch Rate Lead Filter
f14/Controller/Proportional plus integral compensator
f14/Controller/Stick Prefilter

f14/Dryden Wind Gust Models/Q-gust model
f14/Dryden Wind Gust Models/W-gust model

Py
~— = = — — ~— ~— ~—

3
4
5
6
7
8
9

Example: Creating a Van der Pol Experiment from User Objects. To
create a transient experiment from user objects for I/Os and states, use

out1 = ParameterEstimator.TransientData('vdp/Outi');
ic1 = ParameterEstimator.StateData('vdp/x1');

exp1 = ParameterEstimator.TransientExperiment...
(ges, [1, outl, icl);

Experimental (Transient) data set for the model 'vdp':
Outputs

(1) vdp/Outi

Inputs

(none)

Initial States

(1) vdp/x1

Modifying Properties. The objects referred in InputData, OutputData, and
InitialStates properties can be modified or removed as necessary.

2-105



2 Parameter Estimation

2-106

Using Class Methods. The description of one important method is given
next:

update — Updates the object after the Simulink model has been modified.
The object listed in the InputData, OutputData, and InitialStates
properties are updated in turn.

Parameter Obijects

* “What is a Parameter Object” on page 2-106

e “Constructor” on page 2-106

® “Properties of Parameter Objects” on page 2-107
e “Example: F14 Model” on page 2-108

¢ “Example: Gain Matrix” on page 2-108

¢ “Modifying Properties” on page 2-109

e “Using Class Methods” on page 2-109

What is a Parameter Object. The @Parameter object refers to the
parameters of the Simulink model marked for estimation. Some of the
Simulink model parameters are to be estimated and storage is required for the
initial values, current values, ranges, etc. One @Parameter object corresponds
to each parameter in the Simulink model to be potentially estimated. These
objects represent estimation parameters of any type such as scalars, vectors,
and multidimensional arrays.

Constructor. The syntax to create a parameter object is

h = ParameterEstimator.Parameter('Name');

h ParameterEstimator.Parameter('Name', Value);

h ParameterEstimator.Parameter('Name', Value, Minimum,
Maximum) ;

In the first case, Name is a workspace variable. In the other cases, Name does
not need to exist in the workspace at the time of object creation. However, it
is required at estimation time.
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Properties of Parameter Objects. Descriptions of some important
properties are given in the following table.

Parameter Object Properties

Property Description

Name Parameter name. The parameter can be a
multidimensional array of any size.

Dimensions Dimensions of the value of the parameter. This is the
defining property for the size of other properties.

Value The current or estimated value of the parameter. This
is the defining property for size checking and scalar
expansions.

Estimated A Boolean array of the same size as that of Value.

Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
Value is as follows:

¢ The elements of Value is estimated if the corresponding
elements in Estimate are set to true. The result is
stored in the Value property.

® The elements of Value are not estimated if the
corresponding elements in Estimated are set to
false. However, these elements are used to reset
the corresponding workspace parameter during
estimations.

This property is set to false by default, meaning that
the parameter value is not estimated.
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Parameter Object Properties (Continued)

Property

Description

InitialGuess

Separate properties are required to hold the initial

and current values of the parameters. So, when the
InitialGuess property is initialized with a value, both it
and the Value property are assigned the same value.
Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
InitialGuess is as follows:

¢ [f any element in Estimated is set to true, then the
corresponding element of InitialGuess is used to
initialize the workspace parameter during estimations.

e [f any element in Estimated is set to false, then the
corresponding element of InitialGuess is not used
In any way.

Minimum,
Maximum

Parameter range.

TypicalValue

The typical values of the parameters. This property is
used in estimations for scaling purposes. The default
value is 1.

Example: F14 Model. To create a parameter object for the parameter Ta
in the f14 model, use

pari = ParameterEstimator.Parameter('Ta')
(1) Parameter data for 'Ta':
Parameter value : 0.05

Initial value
. false

Estimated

: 0.05

Referenced by the blocks:
f14/Actuator Model

Example: Gain Matrix. To create a parameter object for a matrix
parameter K of size 4-by-1, use
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par1 = ParameterEstimator.Parameter('K', [1 2 3 4]"')
(1) Parameter data for 'K':

Parameter value : [1;2;3;4]

Initial value : [1;2;3;4]

Estimated elements : [false;false;false;false]
Referenced by the blocks:

Modifying Properties. After a parameter object is created, you can modify
its properties using this syntax:

pari.Estimated = true; % Estimate this parameter

Most of the properties, for example, Estimated and TypicalValue support
scalar expansion with respect to the size of Value.

Using Class Methods. Descriptions of two important methods are given
next:

e hiliteBlock — Highlights the referenced blocks associated with
parameter objects in the Simulink diagram.

® update — Updates the parameter object after the Simulink model has
been modified. If the size of the Value property changes, then the other
properties are reset to their default values.

State Objects

e “What is a State Object” on page 2-110

e “Constructor” on page 2-110

* “Properties of State Objects” on page 2-110
e “Example: F14 Model” on page 2-112

e “Modifying Properties” on page 2-112

e “Using Class Methods” on page 2-113
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What is a State Object. The @State object is similar to the @Parameter
object, and refers to the states of the Simulink model marked for estimation.
One @State object corresponds to each Simulink block with states in the
model.

Constructor. The syntax to create a state object is

h = ParameterEstimator.State('block');
h = ParameterEstimator.State('block', Value);
h = ParameterEstimator.State('block', Value, Minimum,

Maximum) ;
In the first case, the state vector is initialized from the model containing the
block. In the other cases, block does not need to exist in the workspace at

the time of object creation. However, it is required at estimation time.

Properties of State Objects. Descriptions of some important properties of
state objects are given in the following table.

State Object Properties

Property Description

Block Name of the Simulink block whose states are defined
by this object.

Dimensions Scalar value to store the number of states of the relevant
block.

Value Column vector to store the value of the state for the

block specified by this object. The length of this vector
should be consistent with the Dimensions property.
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State Object Properties (Continued)

Property

Description

Estimated

A Boolean array of the same size as that of Value.
Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
Value is as follows:

¢ The elements of Value are estimated if the
corresponding elements in Estimate are set to true.
The result is stored in the Value property.

¢ The elements of Value are not estimated if the
corresponding elements in Estimated are set to
false. However, these elements are used to reset the
corresponding states during estimations.

This property is set to false by default, meaning that
the state value is not estimated.

InitialGuess

Separate properties are required to hold the initial and
current values of the states. So, when the InitialGuess
property is initialized with a value, both it and the
Value property are assigned the same value.
Depending on the value of the elements of the Estimated
property, the behavior of the corresponding elements of
InitialGuess is as follows:

e [f any element in Estimated is set to true, then the
corresponding element of InitialGuess is used to
initialize the state during estimations.

e [f any element in Estimated is set to false, then the
corresponding element of InitialGuess is not used
in any way.

Minimum,
Maximum

State vector range.

TypicalValue

The typical values of the states. This property is used in
estimations for scaling purposes. The default value is 1.
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State Object Properties (Continued)

Property Description

Ts Sampling time of discrete blocks. Set to zero for
continuous blocks. This property is read-only and is
currently used for information only.

Domain String to hold the physical domain of the block. Used for
SimMechanics™ or SimPowerSystems™ blocks with
states.

Example: F14 Model. To create a state object for the f14/Actuator Model
block in the f14 model, use

st1 = ParameterEstimator.State(gchb)

This command returns the following result:

(1) State data for fi14/Actuator Model block:
The block has 1 continuous state(s).

State value : 0
Initial guess : O
Estimated : false

Modifying Properties. After a state object is created, you can modify its
properties using this syntax:

ic1.Estimated = true; % Estimate this state

Most of the properties, for example, Estimated and TypicalValue, support
scalar expansion with respect to the size of Value.
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Using Class Methods. Description of two important methods are given next:

hiliteBlock — Highlights the referenced blocks associated with state
objects in the Simulink diagram.

update — Updates the state object after the Simulink model has been
modified. If the size of Value property changes, then the other properties
are reset to their default values.

Estimation Obijects

“What is an Estimation Object” on page 2-113
“Constructor” on page 2-113

“Properties of Estimation Objects” on page 2-113
“Example: F14 Model” on page 2-115
“Modifying Properties” on page 2-115

“Using Class Methods” on page 2-115

What is an Estimation Object. The @Estimation object defines the
estimation problem, and is the coordinator between the model, experiments,
parameter objects, and state objects.

Constructor. The @Estimation object is the coordinator of the model,
experiment, and parameter objects. The syntax to create an estimation object

1S

h = ParameterEstimator.Estimation('model');
h = ParameterEstimator.Estimation('model', hParam);
h = ParameterEstimator.Estimation('model', hParam, hExps);

Properties of Estimation Objects. Descriptions of some important
properties of estimation objects are given in the following table.
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Estimation Object Properties

Property

Description

Model

Name of the Simulink model with which this estimation
1s associated.

Experiments

Experiments to be used in estimations. For multiple
experiments, the cost function uses a concatenation of the
output error vectors obtained using each experimental
data set.

Parameters

Parameter objects to be used in estimations.

States

State objects to be used in estimations. This is a handle
matrix with as many columns as there are experiments,
and as many rows as there are states in Model.

The handle matrix is created automatically in the
constructor. You can reorganize its rows to specify shared
states between experiments, and set the Estimated flag
of desired states.

If state data is provided in an experiment, the state
objects stored in the columns of this matrix are initialized
from the experiments.

SimOptions

Same as simset structure. This property is initialized to
simget(this.Model).

OptimOptions

Same as optimset structure.

EstimInfo

This property is used to store estimation-related
information at each iteration of the optimizer, and is
initialized as
this.EstimInfo = struct( 'Cost', [],...
‘Covariance', [1,...
‘FCount', [],...
‘FirstOrd', [],...
‘Gradient', [],...
‘Iteration', [],...
‘Procedure', []1,...
‘StepSize', [],...
‘Values', [] );
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Example: F14 Model. To create an estimation object for the f14 model to
estimate the parameters Ta and Kf and two states, use

expl = ParameterEstimator.TransientExperiment(gcs);
pari = ParameterEstimator.Parameter('Ta', 'Estimated', true);
par2 = ParameterEstimator.Parameter('Kf', 'Estimated', true);

est1 = ParameterEstimator.Estimation(gcs, [pari, par2], expl);
est1.States(1,1).Estimated = true;

est1.States(6,1).Estimated = true;

est1

This command returns the following result:

Estimated variables for the model 'f14':
Estimated Parameters

Using Experiments
(1) f14 experiment

Estimated States for Experiment 'f14 experiment'
(1) f14/Actuator Model
(6) f14/Controller/Proportional plus integral compensator

Modifying Properties. After an estimation object is created, you can modify
its properties using this syntax:

est.OptimOptions.Method = 'fmincon'; % Estimation method
est.OptimOptions.Display = 'iter'; % Show estimation information
...1n workspace

est.Parameters(1).Estimated = false; % Do not estimate first
...parameter

est.States(2,3).Estimated = false; % Do not estimate second state
...0f third expression

Using Class Methods. Descriptions of some of the important methods are
given next:
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e compare — Compares an experiment and a simulation.
® simulate — Simulates the model with current parameters and states.
® estimate — Runs an estimation.

® update — Updates the estimation object after the Simulink model has
been modified.

How to Use Parallel Computing at the Command Line

After you configure your system for parallel computing, as described in
“Configuring Your System for Parallel Computing” on page 2-56, you can
estimate the model parameters using the command-line functions. To learn
more about parameter estimation using parallel computing, see “When to Use
Parallel Computing for Estimating Model Parameters” on page 2-52, and
“How Parallel Computing Speeds Up Parameter Estimation” on page 2-53.

To use parallel computing for parameter estimation at the command line:

1 Open the Simulink model by typing the model name at the MATLAB
prompt.

2 Configure an estimation project, as described in “Workflow for Estimating
Parameters at the Command Line” on page 2-83.

3 Enable the parallel computing option in the estimation project by typing
the following command.:

hEst.OptimOptions.UseParallel="'always';

To view that the UseParallel property has been set, type the following
command:

hEst.OptimOptions
4 Find the model path dependencies by typing the following command:
dirs=hEst.finddepend;

This command returns the model path dependencies in your Simulink
model in the dirs cell array.
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Note As described in “Specifying Model Dependencies” on page 2-56,
the finddepend command may not detect all the path dependencies in
your model.

5 (Optional) Modify dirs to include the model path dependencies that
finddepend does not detect by typing the following command.

dirs=vertcat(dirs;'\\hostname\C$\matlab\work")

6 Assign the path dependencies to the estimation project by typing the
following command:

hEst.OptimOptions.ParallelPathDependencies=dirs;

7 Run the estimation by typing the following command:

estimate(hEst);

For more information on how to troubleshoot estimation results you
obtained using parallel computing, see “Troubleshooting” on page 2-62.
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Parameter Optimization

® “Overview of Optimizing Model Parameters” on page 3-2

® “Optimizing Parameters Using the GUI” on page 3-3

® “Optimizing Parameters for Model Robustness” on page 3-42

o “Accelerating Model Simulations During Optimization” on page 3-58

¢ “Speeding Up Response Optimization Using Parallel Computing” on page
3-60

¢ “Refining and Troubleshooting Optimization Results” on page 3-72
¢ “Saving and Loading Response Optimization Projects” on page 3-82

® “Optimizing Parameters at the Command Line” on page 3-87
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Overview of Optimizing Model Parameters

When you optimize parameters of a Simulink model to meet time-domain
design requirements, Simulink Design Optimization software automatically
converts time-domain requirements into a constrained optimization problem,
and then solves the problem using optimization techniques. The constrained
optimization problem iteratively simulates the Simulink model, compares the
results of the simulations with the constraint objectives, and uses gradient
methods to adjust tuned parameters to better meet the objectives.

The process for optimizing model parameters to meet time-domain design
requirements consists of the following task:

1 “Constraining Model Signals” on page 3-3

2 “Specifying Design Requirements” on page 3-5

3 “Specifying Parameters to Optimize” on page 3-19
4 “Specifying Optimization Options” on page 3-27

5 “Running the Optimization” on page 3-39

To learn how to optimize parameters at the command line, see “Optimizing
Parameters at the Command Line” on page 3-87.
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Optimizing Parameters Using the GUI

In this section...

“Constraining Model Signals” on page 3-3

“Specifying Design Requirements” on page 3-5

“Specifying Parameters to Optimize” on page 3-19

“Specifying Optimization Options” on page 3-27

“Specifying the Simulation Options” on page 3-32

“Plotting Responses in the Signal Constraint Window” on page 3-36
“Running the Optimization” on page 3-39

Constraining Model Signals

Simulink Design Optimization software works by adjusting parameters in a
Simulink model so that chosen response signals within the system behave in
a specified way. You choose the signals that you want to shape or constrain by
attaching Signal Constraint blocks to them. The constraints on the behavior
of the response signals and the tuned parameters are set within the Signal
Constraint blocks.

The first step in the response optimization process is to choose which signals
in your Simulink model you would like to constrain and to attach Signal
Constraint blocks to these signals.

Once you have selected signals to constrain, you need to attach a Signal
Constraint block to each of these signals. You can find the Signal Constraint
block in the Simulink Design Optimization library in the Simulink Library
Browser. Alternatively, you can open Simulink Design Optimization library
by typing sdolib at the MATLAB prompt.

To attach a Signal Constraint block to a signal in your model, drag the block
from the block library into the model and join the signal line to the inport of
the Signal Constraint block. A model can include multiple Signal Constraint
blocks, and you can attach the Signal Constraint block to any signal, including
signals within subsystems of your model.
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Note The Signal Constraint block is not an outport block of the system and
does not interfere with a linearization of your model (as opposed to blocks in
the Nonlinear Control Design Blockset, the previous name for this product,
which were outport blocks).

Double-click a Signal Constraint block to open the Signal Constraint window
associated with it. Within this window you can specify the constraints
imposed on the signal. For more information, see “Specifying Design
Requirements” on page 3-5. You can also specify parameters to optimize and
optimization settings in this block.

Although you must specify the constraints for each signal individually within
each Signal Constraint block, you only need to set the remaining settings such
as tuned parameters and optimization settings within one Signal Constraint
window as they apply to the whole project.

Opening a Signal Constraint window, automatically creates a response
optimization project. The project consists of the following information:

Constraints on all signals that have Signal Constraint blocks attached

® Tuned parameters in the system and specifications for these parameters
such as initial guesses and maximum and minimum values

e Uncertain parameters in the system and specifications for these parameters
¢ Optimization and simulation setup options

A response optimization project exists within a single model; there are no
cross-model projects. Additionally, although you can create different sets

of constraints and tuned parameters and save these as different response

optimization projects, you can only associate one project with the model at
any time.

The remaining steps involved in specifying the settings of a response
optimization project are discussed in the following sections:

® “Specifying Design Requirements” on page 3-5

® “Specifying Parameters to Optimize” on page 3-19
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To save the project for use in a later session, see “Saving and Loading
Response Optimization Projects” on page 3-82.

Specifying Design Requirements

¢ “What Are Design requirements” on page 3-5

¢ “Enforcing Signal Bounds” on page 3-5

* “Moving Constraints” on page 3-6

¢ “Including Gridlines on the Axes” on page 3-8

® “Positioning Constraints Exactly” on page 3-8

¢ “Adjusting Constraint Weightings” on page 3-9

e “Edit Design Requirement Dialog Box” on page 3-10
® “Scaling Constraints” on page 3-14

e “Splitting and Joining Constraints” on page 3-14

® “Choosing Step Response Specifications” on page 3-15

e “Tracking Reference Signals” on page 3-18

What Are Design requirements

Design requirements include the positions of the constraint bound segments
and reference signals specified in the Signal Constraint block. The constraints
are used in a response optimization project to define the region in which the
response signal must lie.

Enforcing Signal Bounds

You can specify the desired response of a signal by enforcing signal bounds
or by tracking a reference signal. To enforce signal bounds, select this
option at the bottom of the Signal Constraint window, and then position
time-domain-based constraint bound segments in the Signal Constraint
window. To track a reference signal, select this option at the bottom of the
Signal Constraint window, and then plot the signal in the Signal Constraint
window. This section provides further details on both methods as well as
instructions for editing the figure axes and plotting additional responses.
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To specify the desired response signal using time-domain-based constraints,
first select the Enforce signal bounds option at the bottom of the Signal
Constraint window. Then, constrain the response signal by positioning

the constraint bound segments within the figure axes using the following
techniques.

When using a Signal Constraint block to directly optimize a Simulink
model, by default, the start and stop time are inherited from the Simulink
model. However, you can change them with the Simulation Options dialog
box. Choose a stop time that captures enough of the desired response’s
characteristics. When you want the response to settle to a final value, use
at least 10 to 20% of the simulation time for constraining the steady-state
response. This ensures the proper weighting of requirements on the final
value and overall stability.

Moving Constraints

Constraint-bound segments define the time-domain constraints you would
like to place on a particular signal in your model. To position these segments,
which appear as a yellow shaded region bordered by a black line, use the
mouse to click and drag segments within the Signal Constraint window as
shown in the following figure.
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Move o constroint edge
boundory or chonge the
slope of o constraint edge.

Move on enfire constraint edge up, down, left, or right.

<) Block Parameters: Signal Constraint 10| =l

File Edit Plots Goals Optimization Help
FEHS REAE » o [E

Input to srotut1 Signal Constrant

15

Amplitude

-05
o =] 10 13 20 25 30 33 40 43 a0

Time (sec)
[+ Enforce signal bounds [ Track reference signal

Select check box to use constraints for
optimizing signol responses.

¢ To move a constraint segment boundary or to change the slope of a

constraint segment, position the pointer over a constraint segment
endpoint, and press and hold down the left mouse button. The pointer
should change to a hand symbol. While still holding the button down,
drag the pointer to the target location, and release the mouse button.
Note that the segments on either side of the boundary might not maintain

their slopes.

To move an entire constraint segment up, down, left, or right, position the
mouse pointer over the segment and press and hold down the left mouse
button. The pointer should change to a four-way arrow. While still holding
the button down, drag the pointer to the target location, and release the
mouse button. Note that the segments on either side of the boundary might

not maintain their slopes.
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Tip To move a constraint segment to a perfectly horizontal or vertical position,
hold down the Shift key while clicking and dragging the constraint segment.
This causes the constraint segment to snap to a horizontal or vertical position.

To use these constraints to optimize signal responses, make sure that the
Enforce signal bounds check box is selected at the bottom of the window.

Note It is possible to move a lower bound constraint segment above an upper
bound constraint segment, or vice versa, but this produces an error when
you attempt to run the optimization.

Including Gridlines on the Axes

When moving constraint bound segments in the Signal Constraint window,
it is sometimes helpful to display gridlines on the axes for careful alignment
of the constraint bound segments. To turn the gridlines on or off, right-click
within the axes of the Signal Constraint window and select Grid.

Positioning Constraints Exactly

To position a constraint segment exactly, position the pointer over the
segment you want to move and press the right mouse button. Select Edit
from the menu to open the Edit Design Requirement dialog box, shown next.
For information on using the Edit Design Requirement dialog box, see “Edit
Design Requirement Dialog Box” on page 3-10.
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Adjusting Constraint Weightings

To change the weight of a constraint segment, position the pointer over the
segment you want to weight and click the right mouse button. Select Edit
from the menu to open the Edit Design Requirement dialog box, shown next.
For information on using the Edit Design Requirement dialog box, see “Edit
Design Requirement Dialog Box” on page 3-10.
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Edit Design Requirement Dialog Box
The Edit Design Requirement dialog box allows you to exactly position

constraint segments and to edit other properties of these constraints. The
dialog box has two main components:

® An upper panel to specify the constraint you are editing

® A lower panel to edit the constraint parameters

The upper panel of the Edit Design Requirement dialog box resembles the
image in the following figure.

Desigh reguirement; |Upper time responzse bound from 0to 10 sec :I

In the context of the SISO Tool in Control System Toolbox™ software,
Design requirement refers to both the particular editor within the SISO
Tool that contains the requirement and the particular requirement within
that editor. To edit other constraints within the SISO Tool, select another
design requirement from the drop-down menu. In the context of the Signal
Constraint block, the constraints are always time-bound constraints.
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Edit Design Requirement Dialog Box Parameters

Edit Design Requirement Dialog Box Parameters. The particular
parameters shown within the lower panel of the Edit Design Requirement
dialog box depend on the type of constraint/requirement. In some cases, the
lower panel contains a grid with one row for each segment and one column
for each constraint parameter. The following table summarizes the various
constraint parameters.

Parameter Found in Description

Time Upper and lower time Defines the time range of a segment
response bounds on step within a constraint/requirement.
and impulse response plots

Amplitude Upper and lower time Defines the beginning and ending
response bounds on step amplitude of a constraint segment.
and impulse response plots

Magnitude SISO Tool Open-Loop Defines the beginning and ending
Bode Editor, Prefilter Bode | amplitude of a constraint segment.
Editor

Weight Upper and lower time Defines the weight of a segment

response bounds on step
and impulse response plots,
SISO Tool Open-Loop
Bode Editor, Prefilter Bode
Editor, Root Locus Editor,
Open-Loop Nichols Editor

within a constraint/requirement. The
weight is a measure of the relative
importance of this constraint segment
when used in a response optimization
project. Weights can vary between

0 and 1, where 0 implies that the
constraint segment is disabled and
does not have to be satisfied, and 1
implies that the constraint segment
must be satisfied. The weight of a
constraint segment is graphically
represented by the thickness of the
black constraint line. An invisible
constraint segment represents a
weight of 0, and a thick constraint
segment represents a weight of 1.
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Edit Design Requirement Dialog Box Parameters (Continued)

Parameter

Found in

Description

Frequency

SISO Tool Open-Loop

Bode Editor, Prefilter Bode

Editor

Defines the frequency range of an
edge within a constraint.

Slope (dB/decade)

SISO Tool Open-Loop

Bode Editor, Prefilter Bode

Editor

Defines the slope, in dB/decade,

of a constraint segment. It is an
alternative method of specifying the
magnitude values. Entering a new
Slope value changes any previously
defined magnitude values.

Final value

Step response bounds

Defines the input level after the step
occurs.

Rise time Step response bounds Defines a constraint segment for a
particular rise time.
% Rise Step response bounds The percentage of the step’s range

used to describe the rise time.

Settling time <

SISO Tool Root Locus
Editor

Settling time

Step response bounds

Defines a constraint segment for a
particular settling time.

% Settling

Step response bounds

The percentage of the final value that
defines the settling region used to
describe the settling time.

Percent overshoot <

SISO Tool Root Locus
Editor

% Overshoot

Step response bounds

Defines the constraint segments for a
particular percent overshoot.

% Undershoot

Step response bounds

Defines the constraint segments for a
particular percent undershoot.

Damping ratio >

SISO Tool Root Locus
Editor

Defines the constraint segments for a
particular damping ratio.
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Edit Design Requirement Dialog Box Parameters (Continued)

Parameter

Found in

Description

Natural frequency

SISO Tool Root Locus
Editor

Defines a constraint segment for a
particular natural frequency. To
specify the constraint, choose at
least or at most from the menu, and
then specify the natural frequency of
interest.

Real

SISO Tool Root Locus
Editor

Defines the beginning and end of the
real component of a pole-zero region
constraint.

Imaginary

SISO Tool Root Locus
Editor

Defines the beginning and end of the
imaginary component of a pole-zero
region constraint.

Phase margin >

SISO Tool Open-Loop
Nichols Editor

Defines a constraint segment for a
minimum phase margin. The phase
margin specified should be a number
greater than 0.

Located at

SISO Tool Open-Loop
Nichols Editor

Defines the center, in degrees, of
the constraint segment defining
the phase margin, gain margin, or
closed-loop peak gain. The location
must be -180 plus a multiple of 360
degrees. If you enter an invalid
location point, the closest valid
location is selected.

Gain margin >

SISO Tool Open-Loop
Nichols Editor

Defines a constraint segment for a
particular gain margin.

Closed-Loop peak gain <

SISO Tool Open-Loop
Nichols Editor

Defines a constraint segment for a
particular closed-loop peak gain. The
specified value can be positive or
negative in dB. The constraint follows
the curves of the Nichols plot grid, so
we recommend that you have the grid
on when using this feature.
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Edit Design Requirement Dialog Box Parameters (Continued)

Parameter Found in Description
Open loop phase SISO Tool Open-Loop Defines the beginning and end of
Nichols Editor the open loop phase component of a
gain-phase constraint segment.
Open loop gain SISO Tool Open-Loop Defines the beginning and end of
Nichols Editor the open loop gain component of a

gain-phase constraint segment.

Scaling Constraints

Instead of clicking and dragging the constraints to their new positions, you
can scale the constraints. To scale the constraints, select Edit > Scale
Constraint in the Signal Constraint window. This displays the Scale
Constraint dialog box.

). Scale Constraint o ] [

Scale constraint

Scale ¥ range by factar I'-I about v = E

Ok I Cancell Help I

Enter the amount by which you want the constraints to scale and the point
about which you want to scale them, and then click OK.

Splitting and Joining Constraints

To split a constraint segment, position the pointer over the segment to be split,
and press the right mouse button. Select Split from the context menu. The
segment splits in half. You can now manipulate each segment individually.
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To join two neighboring constraint segments, position the pointer over one
constraint segment, and press the right mouse button. Select Join left or
Join right from the menu to join the segment to the left or right respectively.

Choosing Step Response Specifications

When you are optimizing the step response of your system, an alternative
method of positioning the constraint bound segments is to specify the desired
step response characteristics such as rise time, settling time, and overshoot.

To specify step response characteristics, select Goals > Desired Response
in the Signal Constraint window or right-click in the white space of the
figure window and select Desired Response from the context menu. This
displays the Desired Response dialog box. Select Specify step response
characteristics to display the step response specifications as shown in the
following figure.
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The top three options specify the details of the step input:

e Initial value: Input level before the step occurs
* Step time: Time at which the step takes place

¢ Final value: Input level after the step occurs

The remaining options specify the characteristics of the response signal. Each
of the step response characteristics is illustrated in the following figure.
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% Overshoot
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Rise Time Settling Time Time

* Rise time: The time taken for the response signal to reach a specified
percentage of the step’s range. The step’s range is the difference between
the final and initial values.

* % Rise: The percentage used in the rise time.

¢ Settling time: The time taken until the response signal settles within a
specified region around the final value. This settling region is defined as the
final step value plus or minus the specified percentage of the final value.

® % Settling: The percentage used in the settling time.

* % Overshoot: The amount by which the response signal can exceed the
final value. This amount is specified as a percentage of the step’s range.
The step’s range is the difference between the final and initial values.

¢ % Undershoot: The amount by which the response signal can undershoot
the initial value. This amount is specified as a percentage of the step’s
range. The step’s range is the difference between the final and initial
values.
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Enter values for the response specifications in the Response Specifications
dialog box, based on the requirements of your model, and then click OK. The
constraint segments now reflect the constraints specified.

Tracking Reference Signals

You can specify the desired response as an ideal or reference trajectory. You
can use this reference signal in addition to, or instead of, enforcing signal
bounds.

To specify a reference signal:

1 Select the Track reference signal check box at the bottom of the Signal
Constraint window.

[¥ Enforce signal bounds W Track reference sional

2 Specify a reference signal using one of the following techniques:
¢ Selecting Goals > Desired Response in the Signal Constraint window.

¢ Right-clicking in the white space of the figure window and selecting
Desired Response from the context menu.

This action displays the Desired Response dialog box. Select the radio
button labeled Specify reference signal to display the reference signal
setup as shown in the following figure.
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3 Define the reference signal by entering vectors, or variables from the
workspace, for the time and amplitude of the signal, and then clicking OK.

This action plots the reference signal within the figure axes of the Signal
Constraint block window.

To turn the reference signal plot on or off, right-click in the white space of
the figure window, and select Show > Reference Signal.

Use the Track reference signal check box in the Signal Constraint window
to enable or disable tracking the reference signal.

Note When tracking a reference signal, the software ignores the maximally
feasible solution option. For more information on this option, see “Selecting
Optimization Termination Options” on page 3-29.

Specifying Parameters to Optimize

¢ “Defining Tunable Parameters” on page 3-20
¢ “Adding Tuned Parameters” on page 3-21

¢ “Changing Tuned Parameter Specifications” on page 3-22
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® “Specifying Independent Parameters” on page 3-23

¢ “Example — Specifying Independent Parameters for Optimization” on page
3-24

Defining Tunable Parameters

Before running the optimization, you must define which system parameters
are tunable. By tuning these parameters, Simulink Design Optimization
software makes the response signal meet the imposed constraints. In addition,
you can define uncertain parameters to account for plant uncertainty in your
response optimization project. The tunable and uncertain parameters can

be scalar, vector, or matrix.

Simulink Design Optimization software optimizes the response signals of
the model by varying the model’s tuned parameters so that the response
signals lie within the constraint bound segments or closely match a specified
reference signal. You can specify these tuned parameters by selecting
Optimization > Tuned Parameters in a Signal Constraint window.

Note When you have more than one Signal Constraint block in your model,
you need to specify the tuned parameters in only one window as these settings
apply to all constrained signals within the model.
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Adding Tuned Parameters

Within the Tuned Parameters dialog box, the tuned parameters are shown
in a list on the left. To add a tuned parameter to your response optimization
project, click the Add button. This action opens the Add Parameters dialog
box which lists all model parameters currently available in the MATLAB
workspace.
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Note If a parameter is already listed in the Tuned parameters list of the
Tuned Parameters window, it does not appear in the Add Parameters dialog

box.

Select the parameters that you want to tune, then click OK to add them to the
Tuned parameters list. To delete a parameter from the Tuned parameters
list, select the parameter you want to delete and click Delete.

Changing Tuned Parameter Specifications

To display the settings for a particular tuned parameter, select it within
the Tuned Parameters list. Its settings appear on the right under
Optimization Settings, as listed in the following table.

Setting Description Default
Name The name of the parameter. Not an editable field
Value

The current value of the parameter.

Not an editable field
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Setting

Description

Default

Initial
guess

The initial value used by the optimization
method. A well-chosen initial guess can speed up
the optimization and help keep the solution away
from undesirable local minima. You can edit this
field with numbers, variables, or expressions to
provide an alternate initial guess.

The current value of the
parameter

Minimum

The minimum value, or lower bound, that you
would like the parameter to take. You can edit
this field to provide an alternate minimum value.

-Inf

Maximum

The maximum value, or upper bound, that you
would like the parameter to take. You can edit
this field to provide an alternate maximum
value.

Inf

Typical
value

The tuned parameters are scaled, or normalized,
by dividing their current value by a typical value.
You can edit this field to provide an alternate
scaling factor.

The initial value of the
parameter

Tuned

This check box indicates whether this parameter
is tunable. Select it if you want this parameter
to be tuned during the optimization. Unselect

if you do not want this parameter to be tuned
during the optimization but you would like to
keep it on the list of tuned parameters (for a
subsequent optimization).

Selected

Referenced
by

A list of all blocks this parameter appears in.

Not an editable field

After selecting the tuned parameters for the project and editing their

optimization settings, click OK to save your changes and exit the Tuned

Parameters dialog box.

Specifying Independent Parameters

Sometimes parameters in your model depend on independent parameters
that do not appear in the model. The following steps give an overview of how
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to tune and include uncertainty in these independent parameters. example
follows in the next section:

1 Add the independent parameters to the model workspace (along with
initial values).

2 Define a Simulation Start function that runs before each simulation of the
model. This Simulation Start function defines the relationship between the
dependent parameters in the model and the independent parameters in
the model workspace.

3 The independent parameters now appear in the Add Parameters dialog box
when you select Tuned parameters or Uncertain parameters. Add
these parameters to the list of tuned parameters to tune them during the
response optimization.

Caution Avoid adding independent parameters together with their
corresponding dependent parameters to the lists of tuned and uncertain
parameters. Otherwise, the optimization could give incorrect results. For
example, when a parameter x depends on the parameters a and b, avoid
adding all three parameters to the lists of tuned and uncertain parameters.

Example — Specifying Independent Parameters for
Optimization

Assume that the parameter Kint in the model srotut1 is related to the
parameters x and y according to the relationship Kint=x+y. Also assume
that the initial values of x and y are 1 and -0.7, respectively. To tune x and

y instead of Kint, first define these parameters in the model workspace. To
do this,

1 Select View > Model Explorer from the srotut1 window to open the
Model Explorer window.

2 In the Model Hierarchy tree, select srotutl > Model Workspace.
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3 Select Add > MATLAB Variable to add a new variable to the model

workspace. A new variable with a default name Var appears in the Name
column.

4 Double-click Var to make it editable and change the variable name to x.
Edit the initial Value to 1.

5 Repeat step 3 and 4 to add a variable y with an initial value of -0.7.

The Model Explorer window resembles the following figure.
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6 To add the Simulation Start function that defines the relationship between
Kint and the independent parameters x and y, select File > Model
Properties in the srotut1 model window.

7 In the Model Properties window, click the Callbacks tab.

8 To enter a Simulation start function, select StartFen*, and type the name
of a new function. For example, srotut1_start in the Simulation start
function panel. Then, click OK.

9 Create a MATLAB file named srotuti1_start.

The content of the file defines the relationship between the parameters in

the model and the parameters in the workspace. For this example, the
content resembles the following:

wks = get_param(gcs, 'ModelWorkspace')
x = wks.evalin('x")

y = wks.evalin('y')

Kint = x+y;
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Note You must first use the get_param function to get the variables x and
y from the model workspace before you can use them to define Kint.

When you add a new tuned or uncertain parameter, x and y appear in the
Add Parameters dialog box.

) Add Parameters =] |
Select workspace variahles:
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|
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Specifying Optimization Options

® “Accessing Optimization Options” on page 3-27
e “Selecting Optimization Methods” on page 3-28
e “Selecting Optimization Termination Options” on page 3-29

® “Selecting Additional Optimization Options” on page 3-30

Accessing Optimization Options
Several options can be set to tune the results of optimization. These options
include the optimization methods and the tolerances the methods use.

To set options for optimization, select Optimization > Optimization
Options in the Signal Constraint window. This opens the Options dialog box.
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) Options ] |
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—Optimization method

Method: I Gradient descent ;I Algorithm: I Active-Set ;I
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Note If the optimization fails, a good first work-around is to change the
Gradient-type to Refined. For more information on this option, refer to
“Selecting Additional Optimization Options” on page 3-30.

Selecting Optimization Methods

Both the Method and Algorithm options define the optimization method.
Use the Optimization method area of the Options dialog box to set the
optimization method and its algorithm.

Optimization method
’7Method: I Gradient descent LI Algorithm: | Active-Set LI

For the Method option, the three choices are:
® Gradient descent (default) — Uses the Optimization Toolbox function
fmincon to optimize the response signal subject to the constraints.

® Pattern search — Uses the Global Optimization Toolbox function
patternsearch, an advanced direct search method, to optimize the
response. This option requires the Global Optimization Toolbox.
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e Simplex search — Uses the Optimization Toolbox function fminsearch,
a direct search method, to optimize the response. Simplex search is
most useful for simple problems and is sometimes faster than Gradient
descent for models that contain discontinuities.

The following table summarizes the Algorithm options for Gradient
descent:

Algorithm Option Learn More

Active-Set (default) “fmincon Active Set Algorithm”
in the Optimization Toolbox
documentation.

Interior-Point “fmincon Interior Point Algorithm”
in the Optimization Toolbox
documentation.

Trust-Region-Reflective “fmincon Trust Region Reflective
Algorithm” in the Optimization
Toolbox documentation.

Selecting Optimization Termination Options

Use the Optimization options panel to specify when you want the
optimization to terminate.

Optirnization options

Parameter tolerance: ID.DD‘I Function tolerance: ID.DD‘I
Constraint tolerance: ID.DD‘I Mazimum iterations: |1 oo

¥ Look for maximally feasible olution

® Parameter tolerance: The optimization terminates when successive
parameter values change by less than this number. For more details,
refer to the discussion of the parameter TolX in the reference page for the
Optimization Toolbox function fmincon.
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¢ Constraint tolerance: This number represents the maximum relative
amount by which the constraints can be violated and still allow a successful
convergence.

* Function tolerance: The optimization terminates when successive
function values are less than this value. Changing the default Function
tolerance value is only useful when you are tracking a reference signal or
using the Simplex search method. For more details, refer to the discussion
of the parameter TolFun in the reference page for the Optimization Toolbox
function fmincon.

¢ Maximum iterations: The maximum number of iterations allowed.
The optimization terminates when the number of iterations exceeds this
number.

¢ Look for maximally feasible solution: When selected, the optimization
continues after it has found an initial, feasible solution, until it finds a
maximally feasible, optimal solution. When this option is unselected, the
optimization terminates as soon as it finds a solution that satisfies the
constraints and the resulting response signal sometimes lies very close
to the constraint segment. In contrast, a maximally feasible solution is
typically located further inside the constraint region.

Note If selected, the software ignores this option when tracking a
reference signal.

By varying these parameters you can force the optimization to continue
searching for a solution or to continue searching for a more accurate solution.

Selecting Additional Optimization Options

At the bottom of the Optimization Options panel is a group of additional
optimization options.

Display level: I tter ations hd I Gradient type: I Biasic LI
Restarts: ID

¢ “Display Level” on page 3-31
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e “Restarts” on page 3-31
® “Gradient Type” on page 3-31

Display Level. The Display level option specifies the form of the output that
appears in the Optimization Progress window. The options are Iterations,
which displays information after each iteration, None, which turns off all
output, Notify, which displays output only if the function does not converge,
and Termination, which only displays the final output.

For more information on the type of iterative output that appears for the
method you selected using the Method option, see the discussion of output for
the corresponding function.

Method Function Output Information

Gradient fmincon fmincon section of “Function-Specific

descent Output Headings” in the Optimization
Toolbox documentation

Simplex fminsearch fminsearch section of

search “Function-Specific Output Headings”
in the Optimization Toolbox
documentation

Pattern patternsearch | “Display to Command Window

search Options” in the Global Optimization

Toolbox documentation

Restarts. In some optimizations the Hessian may become ill conditioned and
the optimization does not converge. In these cases it is sometimes useful to
restart the optimization after it stops, using the endpoint of the previous
optimization as the starting point for the next one. To automatically restart
the optimization, indicate the number of times you want to restart in this field.

Gradient Type. When using Gradient descent as the optimization method,
Simulink Design Optimization software calculates gradients based on finite
difference methods. The default method for computing the gradients is Basic.
The Refined method offers a more robust and less noisy gradient calculation
method than Basic, although it is sometimes more expensive and does not
work with certain models such as SimPowerSystems models.
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Tip If the optimization fails, a good first work-around, before changing
solvers or adding parameter bounds, is to change Gradient type to Refined.

Specifying the Simulation Options

® “Accessing Simulation Options” on page 3-32
® “Selecting Simulation Time” on page 3-33

® “Selecting Solvers” on page 3-33

Accessing Simulation Options
To optimize the parameters of a model, Simulink Design Optimization
software runs simulations of the model.

To set the simulation options, select Optimization > Simulation Options
in the Signal Constraint window. This action opens the Options dialog box.
L Oy Mew Estimation

=101 ]

;| Optimization Dpﬁonsl Parallel O|:|tior|5|

Start time: Iauh:u Stop time: Iauto
~Solver options
Type: I Auto LI Solvers | Use model settings ;I
oK | Cancel | Help | Apply |

Specify the simulation options, as described in the following sections:

e “Selecting Simulation Time” on page 3-33
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e “Selecting Solvers” on page 3-33

Selecting Simulation Time

By default, the Start time and Stop time are auto, which automatically
uses the start and stop times specified in the model.

Situlstion titre:

Start tirne: Iau‘fo Stop tirme: Iauto

Note If the Stop time in the Simulink model is inf, the software
automatically uses the largest time value in the constraints as the stop time
value.

To specify alternative start and stop times for the response optimization
project, enter the new times in the Simulation time area of the dialog box.

Selecting Solvers

When running the optimization, the software solves the dynamic system
using one of the Simulink solvers. You can specify the solver type and its
options in the Solver options area of the Simulation Options tab.

Solver options

Type: - Solver: I_s& model settings j

The solver can be one of the following Type:

® Auto (default) — Uses the simulation settings specified in the Simulink
model.

® Variable-step — Variable-step solvers keep the error within specified
tolerances by adjusting the step size the solver uses. For example, if the
states of your model are likely to vary rapidly, you can use a variable-step
solver for faster simulation. For more information on the variable-step
solver options, see “Variable-Step Solver Options” on page 3-34.
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® Fixed-step — Fixed-step solvers use a constant step size. For more
information on the fixed-step solver options, see “Fixed-Step Solver
Options” on page 3-35.

See “Choosing a Solver” in the Simulink documentation for information about
solvers.

Note To obtain faster simulations during optimization, you can change
the solver Type to Variable-step or Fixed-step. However, the optimized
parameter values apply only for the chosen solver type, and may differ from
values you obtain using settings specified in the Simulink model.

Variable-Step Solver Options. When you select Variable-step as the
solver Type, you can choose one of the following as the Solver:

Discrete (no continuous states)
® ode45 (Dormand-Prince)

® 0de23 (Bogacki-Shampine)

® ode113 (Adams)

® odel15s (stiff/NDF)

® 0de23s (stiff/Mod. Rosenbrock)
® 0de23t (Mod. stiff/Trapezoidal)
e ode23tb (stiff/TR-BDF2)

~Solver options
Type: I Variable-step LI Solver: I ode45 (Dormand-Prince) ;I
Maximum step size: Iauh:u Relative tolerance: Ile-3
Minimum step size: Iautc- Absolute tolerance: Iautu:||
Initial step size: Iautc- Zero crossing control: I On ;I

You can also specify the following parameters that affect the step-size of the
simulation:

3-34



Optimizing Parameters Using the GUI

* Maximum step size — The largest step-size the solver can use during a

simulation.

* Minimum step size — The smallest step-size the solver can use during a

simulation.

¢ Initial step size — The step-size the solver uses to begin the simulation.

* Relative tolerance — The largest allowable relative error at any step in

the simulation.

® Absolute tolerance — The largest allowable absolute error at any step in

the simulation.

e Zero crossing control — Set to on for the solver to compute exactly where

the signal crosses the x-axis. This option is useful when using functions

that are nonsmooth and the output depends on when a signal crosses the

x-axis, such as absolute values.

By default, the software automatically chooses the values for these options.

To specify your own values, enter them in the appropriate fields. For more

information, see “Solver Pane” in the Simulink documentation.

Fixed-Step Solver Options. When you select Fixed-step as the solver
Type, you can choose one of the following as the Solver:

® Discrete (no continuous states)

® ode5 (Dormand-Prince)

® ode4 (Runge-Kutta)

® ode3 (Bogacki-Shanpine)
® ode2 (Heun)

® odel (Euler)

Solver options

Type: (IREGLE]

Salver: I Discrete (no conkinuous states)

Fixed step size:  |auto
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3-36

You can also specify the Fixed step size value, which determines the

step size the solver uses during the simulation. By default, the software
automatically chooses a value for this option. For more information, see
“Fixed-step size (fundamental sample time)” in the Simulink documentation.

Plotting Responses in the Signal Constraint Window

e “Types of Response Plots” on page 3-36

e “Reference Signals” on page 3-36

¢ “Current Response” on page 3-36

e “Initial Response” on page 3-36

¢ “Intermediate Steps” on page 3-37

® “Response Plots Property Editor” on page 3-37

Types of Response Plots

You can choose to plot several different signals in the Signal Constraint
window, including reference signals, initial response signals, and response
signals generated during the optimization.

Reference Signals

To plot a reference signal, use the methods in “Tracking Reference Signals”
on page 3-18.

Current Response

To display the current response signal, based on the current parameter values,
right-click within the white space of the Signal Constraint window and select
Plot Current Response. The current response appears as a thick white line.

Initial Response

To turn the display of the initial response signal on or off, right-click within
the white space of the Signal Constraint window and select Show > Initial
Response. The initial response is the response of the signal based on
parameter values in place before the optimization is run. The initial response
appears as a blue line.
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Intermediate Steps

To turn on, or off, the display of the response signal at intermediate

steps during the optimization, right-click within the white space of the
Signal Constraint window and select Show > Intermediate Steps. The
response signal at an intermediate step is based on parameter values at an
intermediate point in the optimization.

Response Plots Property Editor

¢ “Modifying Properties of Response Plots” on page 3-37

e “Labels Pane” on page 3-38

¢ “Limits Pane” on page 3-38

Modifying Properties of Response Plots. This section discusses how you
can change the properties of response plots. Select Edit > Axes Properties

in the Block Parameters: Signal Constraint window and select Labels to
open the Property Editor dialog box.

Note Click the tabs to get help on panes in the Property Editor.

This figure shows the Property Editor dialog box for a step response.

) Property Editor: Step Response IH[=] E3

Labels | Limits |

~Text

Title: IStep Response

H-Label  [Time (zec)

-Label  amplituce

Close | Help |

In general, you can change the following properties of response plots.
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3-38

e Labels -- Titles and X- and Y-labels

¢ Limits -- Numerical ranges of the x- and y- axes
As you make changes in the Property Editor, they display immediately in the
response plot. Conversely, if you make changes in a plot using right-click

menus, the Property Editor for that plot automatically updates. The Property
Editor and its associated plot are dynamically linked.

Labels Pane.

Note Click the tabs below to get help on the Property Editor.

) Property Editor: Step Response IH[=] E3

Labels | Limits |

~Text

Title: IStep Response

H-Label  [Time (zec)

-Label  amplituce

Close | Help |

To specify new text for plot titles and axis labels, type the new string in the
field next to the label you want to change. The label changes immediately as
you type, so you can see how the new text looks as you are typing.

Limits Pane.

Note Click the tabs to get help on the Property Editor.
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<} Property Editor: Step Response =] 3

Lakels  Limits |

—X-Limits
Auto-Scale: v
Limit=: ID— to |1D—
~¥-Limits
Auto-Scale: [V
Limit=: l? to IT

Close | Help |

Default values for the axes limits make sure that the maximum and minimum
x and y values are displayed. If you want to override the default settings,
change the values in the Limits pane fields. The Auto-Scale check box
automatically clears if you click a different field. The new limits appear
immediately in the response plot.

To reestablish the default values, select the Auto-Scale check box again.

Running the Optimization

After you have specified constraints and the parameters to optimize, as
described in “Specifying Design Requirements” on page 3-5 and “Specifying
Parameters to Optimize” on page 3-19 respectively, you can run the
optimization.

Run the optimization by selecting Optimization > Start in the Signal
Constraint window, or click the Start button, which is the small triangle
located on the control panel below the menus.

Simulink Design Optimization software uses optimization methods to find
parameter values that allow a feasible solution, or best fit in the case of
reference tracking, to the given constraints. Once the appropriate signals
have been constrained with signal bounds or by tracking a reference signal,
the tuned parameters set, and (optionally) any uncertain parameters and
optimization settings specified, you are ready to run the optimization.
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3-40

Simulink Design Optimization software begins by plotting the initial
response in blue in the Signal Constraint window. During the optimization,
intermediate responses are also plotted in various colors. The final response is
plotted in black. If uncertainty is included in the optimization, the uncertain
response signals are plotted as dashed lines, along with the nominal response
as a solid line.

<} Block Parameters: Signal Constraint ] =]

File Edit Plots Goals  Optimization  Help o
SHE RQUE|» = [IE

. _
Input to sratutl Signal Constraint

Amplitude

-0.5
0 =) 10 15 20 23 30 33 40 43 a0

Time (sec)
[ Enforce signal bounds [ Track reference signal

Simulink Design Optimization software changes the values of the tuned
parameters within the MATLAB workspace and displays the final value in
the Optimization Progress window. Alternatively, you can enter a parameter
name at the MATLAB prompt to see its final value.

Note After the optimization, the values of the tuned parameters are changed
to the new optimized values. This means that if you want to run another
optimization, it uses these tuned values of the parameters as initial values,
unless you specify alternative initial values in the Tuned Parameters dialog
box. To revert to the unoptimized parameter values, select Edit > Undo
Optimize Parameters from the Signal Constraint window.
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The Optimization Progress window displays numerical output. The form of
this output depends on the optimization method being used. To learn more,
see “Selecting Optimization Methods” on page 3-28 and the discussion of

Display level in “Selecting Additional Optimization Options” on page 3-30.
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The Gradient descent optimization method may violate the bounds on
parameter values when it cannot satisfy the signal constraints specified in the
Signal Constraint block and the bounds on parameter values simultaneously.
To learn how to troubleshoot this problem, see “Troubleshooting Optimization
Results” on page 3-72

Note For more information on types of problems you may encounter using
optimization solvers, see “Steps to Take After Running a Solver” in the
Optimization Toolbox documentation.

If the optimization does not converge the first time, it often converges after
adjusting the constraints or tuned parameter characteristics, or choosing
different options. For more information, see “Troubleshooting Optimization
Results” on page 3-72.
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Optimizing Parameters for Model Robustness

In this section...

“What Is Model Robustness?” on page 3-42

“Sampling Methods for Computing Uncertain Parameter Values” on page
3-43

“How to Optimize Parameters for Model Robustness Using the GUI” on
page 3-46

“Commands for Optimizing Parameters for Model Robustness” on page 3-49

“Example — Optimizing Parameters for Model Robustness Using the GUI”
on page 3-49

What Is Model Robustness?

A model is robust when it’s response does not violate design requirements
under parameter variations. When you optimize model parameters, your
model may contain additional parameters whose values are not precisely
known. Such parameters vary over a given range of values and are defined
as uncertain parameters. You may know the nominal value and the range of
values in which these uncertain parameters vary.

You can then use the Simulink Design Optimization software to incorporate
the parameter uncertainty to test the robustness of your design. You can test
and optimize parameters for model robustness in the following ways:

¢ Before Optimization. Specify the parameter uncertainty before you
optimize the parameters to meet the design requirements. In this case,
the optimization method optimizes the signals based on both nominal
parameter values as well as the uncertain values. This mode requires
more time.

¢ After Optimization. Specify the parameter uncertainty after you have
optimized the model parameters to meet design requirements. You can
then test the effect of the uncertain parameters by plotting the model’s
response. If the response violates the design requirements, you can
optimize the parameters again by including the parameter uncertainty
during the optimization.
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To learn more, see “Example — Optimizing Parameters for Model Robustness
Using the GUI” on page 3-49.

Note You cannot add uncertainty to controller or plant parameters when
designing controllers using optimization-based methods in the SISO Design
Tool.

Sampling Methods for Computing Uncertain
Parameter Values

There are two sampling methods for computing uncertain parameter values.
Both methods create several sample parameter values within the range of
uncertainty, as described in the following sections:

¢ “Random (Monte Carlo) Method” on page 3-43
¢ “Grid Method” on page 3-45

To learn how to specify the sampling method, see the following sections:
¢ “How to Optimize Parameters for Model Robustness Using the GUI” on
page 3-46

® gridunc and randunc function reference pages

Random (Monte Carlo) Method

The Random (Monte Carlo) sampling method computes random values of
uncertain parameters within a specified range. When you select the Random
(Monte Carlo) method, you must also specify the following settings:

® Number of sample values

®* Nominal parameter value

e Range of parameter values

When you specify more than one uncertain parameter, the sampling method

creates random parameter values within a hypercube. This hypercube is
defined by the minimum and maximum values of all uncertain parameters.
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For example, the following figure shows two uncertain parameters, a and b,
which range in value from 0 to 3 and 1 to 2.5 respectively. In the figure,
the sample values appear as black dots and are scattered randomly within
the rectangle.

{1
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»
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Grid Method

The Grid sampling method computes specified values of uncertain parameters
within the range of uncertainty. When you select the Grid method, you must
specify the following settings:

¢ Nominal parameter value
e Vector of sample parameter values
The sampling method uses the sample parameter values to compute the

number of samples for the uncertain parameter.

When you specify more than one uncertain parameter, the sample values form
a grid of combinations. For example, the following figure shows two uncertain
parameters, a and b, with sample values [0 1 2 3] and [1 1.5 2 2.5]. In
the figure, the sample values appear as black dots to form the grid.

a
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How to Optimize Parameters for Model Robustness
Using the GUI

To optimize parameters for model robustness using the GUI:

1 In the Block Parameters: Signal Constraint window, select
Optimization > Uncertain Parameters.

This action opens the Uncertain Parameters dialog box.

) Uncertain Parameters 10| =]

¥ account for parameter uncertainty

— Uncettain pararmeters
Sarmpling methoc: IRandnm (Morte Carlo) j

Mumber of samples: '3

Parameter Tominal Min Max

A Delete |

— Optimized responses
[¥ Momingl response
[ Responzes for

(Al sample parameter values

% Min and mas values only

Ok I Cancell Help I Applyl

By default, the Account for parameter uncertainty check box is
selected. This implies that the optimization method takes into account
the parameter uncertainty during optimization. You can exclude the
parameter uncertainty during optimization by clearing this option.
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Note When you have more than one Signal Constraint block in your
model, you only need to specify the uncertain parameters in one window.
These settings apply to all constrained signals within the model.

2 Select the sampling method from the Sampling method drop-down list.

To learn more about the sampling methods, see “Sampling Methods for
Computing Uncertain Parameter Values” on page 3-43.

3 To add an uncertain parameter:

a Click Add to open the Add Parameters dialog box.

The dialog box lists all model parameters currently available in the
MATLAB workspace.

=) Add Parameters Xl
Select workspace vatiables:
el Fs
zeta _I
[ |
Ok I Cancel I Help I

Note Parameters that are already specified for optimization or as
uncertain parameters do not appear in the Add Parameters dialog box.
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3-48

b Select the parameters in the Add Parameters dialog box, and then click
OK.

This action adds the parameters to the Uncertain Parameters dialog box.

) Uncertain Parameters oy ] 54

|7 Account far parameter uncertainty

— Uncertsin parameter

Sampling methoc: IRandom (Monte Carlo) d

Mumber of samples: IJ

Parameter| Marminal | Min Max |

wi 0.5 045 055 i’

Delste |

— Optimized responses
¥ Mominal response

[¥ Responses for
= All sample parameter valuss

1+ Min and max values only

ok | cancel | Hep | appy |

For each parameter in the Uncertain Parameters dialog box, you can
change the nominal, minimum and maximum values.

4 In the Optimized responses area of the GUI, configure the sample
parameter values to use during optimization by selecting:

* Nominal response check box to include the nominal values of the
uncertain parameters

e All sample parameter values check box to include all sample values of
the uncertain parameters

¢ Min and max values only check box to include only the minimum and
maximum values of the uncertain parameters
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Tip Using only the minimum and maximum values during optimization
increases the computation speed.

5 Click OK to add the uncertain parameters to the response optimization
project.

When you optimize the parameters for robustness, the optimization method
uses the responses computed using all the uncertain parameter values to
adjust the model parameters. For an example of testing and optimizing
parameters for model robustness using the GUI, see “Example — Optimizing
Parameters for Model Robustness Using the GUI” on page 3-49.

Commands for Optimizing Parameters for Model
Robustness

You can also optimize parameters for model robustness by including
parameter uncertainty at the command line. The following table summarizes
the commands for model robustness. For detailed information about using
each command, see the corresponding reference page.

Command Purpose

setunc Specify parameter uncertainty in response optimization
project

gridunc Sampling method for computing a grid of uncertain

parameter values

randunc Sampling method for computing random samples of
uncertain parameter values

Example — Optimizing Parameters for Model
Robustness Using the GUI

The following example shows how to optimize parameters for model
robustness.
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1 Open the Simulink model by typing the model name at the MATLAB
prompt:

sldo_model1_desreq_optim

The following Simulink model opens.

JR[-TE
File Edit View Simulation Format Tools Help
DEE&| &BR |4 |2y mpo | [Noma A REDE i e

FID ] ini Outt

Unit Step

¥

Controller Flant

Signal Constraint

Ready [100% [ [ |ode45 .

The command also opens the Block Parameters: Signal Constraint window.
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) Block Parameters: Signal Constraint i ] 5]

File Edit Plots Goals Optimization Help
e AR r = |LE

Impact to slcdo_model! _unciSignal Constraint

Amplitude

1) AR e :

D2 feeereid

-0z
1] ] 10 15 20 23 30 33 40 45 a0

Time (sec)
[+ Enforce signal bounds [ Track reference signal

The Simulink model parameters have already been optimized to meet the
following step response requirements:

¢ Maximum overshoot of 10%
e Maximum rise time of 10 seconds

¢ Maximum settling time of 30 seconds

To learn how to optimize model parameters to meet design requirements,
see “Tutorial — Optimizing Parameters to Meet Time-Domain
Requirements Using the GUI” in the Simulink Design Optimization
Getting Started Guide.

Tip To view the current response of the model, select Plots > Plot
Current Response in the Block Parameters window.
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2 To specify parameter uncertainty:

a In the Block Parameters window, select Optimization > Uncertain
Parameters.

) Block Parameters: Signal Constraint _ 0] x|
File Edit Plots Goals | Optimization Help
LY ( =
= =Y | £ 5, stat
Stop
Tuned Parameters. .. _unciSignal Constraint

b

Uncertain Param

2

Simulation Options...

1
: Optimization Options. ..
03 _ ....... Parallel Options. ..
= : :
=3 : 3
£ D4fo IR— 3

-02
1} 5 10 15 20 25 30 35 40 45 a0

Time (sec)
¥ Enforce signal kounds [ Track reference signal
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This action opens the Uncertain Parameters dialog box.

) Uncertain Parameters ] 4

|7 Account far paratmeter uncertainty

— Uncertain parameters

Sampling methock IRandom (Morte Carlo) |

Mutrber of samples: |3

Pararmeter Marminal Ilin &

Al Delete |

— Optimized responses

[¥ Mominal response
[V Responses for
™ Al sample parameter valugs

{+ Min and max valuss only

ok | cancel | Help | appy |

To learn more about the options in this dialog box, see “How to Optimize
Parameters for Model Robustness Using the GUI” on page 3-46.

b Click Add to open the Add Parameters dialog box.

Add Parameters x|
Select workspace variables:
el -
zeta J
|
O | Cancel | Help |
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¢ Select wO and zeta, and click OK.

This action adds the parameters to the Uncertain Parameters dialog box.

-} Uncertain Parameters oy ] 54

|7 Account far parameter uncertainty

— Uncertsin parameter

Sampling methoc: IRandom (Monte Carlo) d

Mumber of samples: IJ

Parameter| Maminal | Min Max |

wi 0.5 0.45 055 i’
zeta 0.5 0.45 055

Delete |

— Optimized responses
¥ Mominal response

[¥ Responses for

= All sample parameter valuss

1+ Min and max values only

ok | cancel | Hep | appy |

The Nominal column displays the nominal value of the parameters as
specified in the Simulink model. The Min and Max columns specify
the range in which the parameter can vary with respect to its nominal
value. By default, the minimum and maximum parameter values vary
by 10% of the nominal value.

d Click OK to close the Uncertain Parameters dialog box.
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3 To test the model robustness to the uncertain parameters, select
Plots > Plot Current Response in the Signal Constraint block window.

The Block Parameters window updates, as shown in the following figure.

) Block Parameters: Signal Constraint _ 0] x|

File Edit Plots Goals Optimization Help

_F.:IH;?|+\_\\'E‘|_|’.|§

Input to sldo_model! _desres_optim/Signal Constraint

1] 5 10 15 20 25 30 35 40 45 20
Time (sec)
¥ Enforce signal kounds [ Track reference signal

The window shows the following plot lines:

¢ The plot line shown as the solid black curve corresponds to the model’s
response computed using the optimized parameters and the nominal
values of the uncertain parameter.

¢ The four plot lines shown as the dashed black curves correspond to
the model’s response with the minimum and maximum values of the
uncertain parameters.

The dashed plot lines show that the model’s response during the period
of 10 to 15 seconds violates the design requirements.

3-55



3 Parameter Optimization

4 To optimize the parameters for model robustness, select
Optimization > Start.

This action opens the Optimization Progress window, which displays the
optimization iterations.

_inix

max Directional First-order

Iter S-count £ix) constraint SEEpoSize derivacive optimality
u} 1 a 0.03441

1 70 a 0.0032&64 0.0483 a 0.0805

2 105 a 9.467e-005 0.0498 a 0.0589

Successful termination.

Found a feasible or optimal solution within the specified tolsrances.
Kd =

0.1214

LAl

0.1560

Ep

0.1692

4 | i

After the optimization completes, the message Successful termination
indicates that the model’s response meets all the specified design
requirements. The Optimization Progress window also displays the
optimized parameter values.

5 Examine the final response in the updated Block Parameters window.
The final response of the model appears as the solid black curve. The

model’s response with the uncertain parameter values now meets the
design requirements.

3-56



Optimizing Parameters for Model Robustness

) Block Parameters: Signal Constraint =10l x|

File Edit Ploks Goals Optimization Help

jlﬂﬁs‘i|+\_\l@h|>.|§

Input to sldo_model _desred_optimiSignal Constraint
12

Amplitude

-0.2
o 5 10 15 20 25 30 35 40 45 50
Time (sec)

|+ Enforce signal bounds [ Track reference signal

Tip To view only the final response of the model, select Plots > Clear

Plots. Then, select Plots > Plot Current Response.
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Accelerating Model Simulations During Optimization

About Accelerating Optimization

You can accelerate the response optimization computations by changing the
simulation mode of your Simulink model. Simulink Design Optimization
software supports Normal and Accelerator simulation modes. For more
information about these modes, see “Accelerating Models” in the Simulink
documentation.

The default simulation mode is Normal. In this mode, Simulink uses
interpreted code, rather than compiled C code during simulations.

In the Accelerator mode, Simulink Design Optimization software runs
simulations during optimization with compiled C code. Using compiled C
code speeds up the simulations and reduces the time to optimize the model
response signals.

Limitations

You cannot use the Accelerator mode if your model contains algebraic loops.
If the model contains MATLAB function blocks, you must either remove them
or replace them with Fen blocks.

If the model structure changes during optimization, the model is compiled
to regenerate the C code for each iteration. Using the Accelerator mode
increases the computation time. To learn more about code regeneration, see
“Code Regeneration in Accelerated Models” in the Simulink documentation.

Setting Accelerator Mode for Response Optimization

To set the simulation mode to Accelerator, open the Simulink model window
and perform one of the following actions:

e Select Simulation > Accelerator.

® Choose Accelerator from the drop-down list as shown in the next figure.
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Tip To obtain the maximum performance from the Accelerator mode,
close all Scope blocks in your model.
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Speeding Up Response Optimization Using Parallel
Computing

In this section...

“When to Use Parallel Computing for Response Optimization” on page 3-60
“How Parallel Computing Speeds Up Optimization” on page 3-61
“Configuring Your System for Parallel Computing” on page 3-64
“Specifying Model Dependencies” on page 3-65

“How to Use Parallel Computing in the GUI” on page 3-66

“How to Use Parallel Computing at the Command Line” on page 3-70

When to Use Parallel Computing for Response
Optimization

You can use Simulink Design Optimization software with Parallel Computing
Toolbox software to speed up the time-domain response optimization of

a Simulink model. Using parallel computing may reduce your model’s
optimization time in the following cases:

¢ The model contains a large number of tuned parameters, and the Gradient
descent method is selected for optimization.

e The Pattern search method is selected for optimization.

¢ The model contains a large number of uncertain parameters and uncertain
parameter values.

® The model is complex and takes a long time to simulate.

When you use parallel computing, Simulink Design Optimization software
distributes independent simulations to run them in parallel on multiple
MATLAB sessions, also known as workers. Distributing the simulations
significantly reduces the optimization time because the time required

to simulate the model dominates the total optimization time. For more
information on how the software distributes the simulations and the expected
speedup, see “How Parallel Computing Speeds Up Optimization” on page 3-61.
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The following sections describe how to configure your system, and use parallel
computing:

® “Configuring Your System for Parallel Computing” on page 3-64

e “How to Use Parallel Computing in the GUI” on page 3-66

e “How to Use Parallel Computing at the Command Line” on page 3-70

How Parallel Computing Speeds Up Optimization

You can enable parallel computing with the Gradient descent and Pattern
search optimization methods in the Simulink Design Optimization software.
When you enable parallel computing, Simulink Design Optimization software
distributes independent simulations during optimization on multiple
MATLAB sessions. The following sections describe which simulations are
distributed and the expected speedup using parallel computing:

e “Parallel Computing with the Gradient descent Method” on page 3-61
e “Parallel Computing with the Pattern search Method” on page 3-62

Parallel Computing with the Gradient descent Method
When you select Gradient descent as the optimization method, the model

is simulated during the following computations:
¢ Constraint and objective value computation — One simulation per iteration

¢ Constraint and objective gradient computations — Two simulations for
every tuned parameter per iteration

¢ Line search computations — Multiple simulations per iteration

The total time, Ttotal , taken per iteration to perform these simulations is
given by the following equation:

Ttotal =T + (Npx2XxT))+ (NisxT) =T x(A + (2% Np) + Nis)
where T is the time taken to simulate the model and is assumed to be equal

for all simulations, Np is the number of tuned parameters, and Nis is the
number of line searches.
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3-62

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for constraint and objective gradient
computations. The simulation time taken per iteration when the gradient

computations are performed in parallel, TtotalP, is approximately given by
the following equation:

TtotalP = T + (ceil & X 2XT)+ (NisxT)=Tx(1+2xceil &
Nw N

w

)+ Nis)

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with
configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speedup for the total optimization time is given by the following
equation:

1+2x ceil(Np)-F Nis
TtotalP _ Nuw
Ttotal 1+ (2% Np) + Nis

For example, for a model with N,=3, N,=4, and N, =3, the expected speedup

1+2xceil(3)+3
equals 4 =0.6.

1+(2x3)+3
For a demo on the performance improvement achieved with the Gradient
descent method, see the Improving Optimization Performance Using Parallel
Computing demo.

Parallel Computing with the Pattern search Method

The Pattern search optimization method uses search and poll sets to create
and compute a set of candidate solutions at each optimization iteration.
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The total time, Ttotal , taken per iteration to perform these simulations, is
given by the following equation:

Ttotal = (T'x Npx Nss) + (T x Npx Nps) = T'x Np X (Nss + Nps)
where T is the time taken to simulate the model and is assumed to be equal
for all simulations, Np is the number of tuned parameters, Nss is a factor for

the search set size, and Nps is a factor for the poll set size.

When you use parallel computing, Simulink Design Optimization software
distributes the simulations required for the search and poll set computations,
which are evaluated in separate parfor loops. The simulation time taken per

iteration when the search and poll sets are computed in parallel, TtotalP
is given by the following equation:

TiotalP = (T x ceil(Npx N %)) + (T x ceil (Np x Nps))
Nw Nw

= T x (ceil(Np x %) + ceil(Np x %ps))

w

where Nw is the number of MATLAB workers.

Note The equation does not include the time overheads associated with

configuring the system for parallel computing and loading Simulink software
on the remote MATLAB workers.

The expected speed up for the total optimization time is given by the following
equation:

ceil(Np x %) + ceil(Np x ]st)

TtotalP _ w

Ttotal Npx(Nss+ Nps)

For example, for a model with N,=3, N,=4, N, =15, and Nos=2, the expected

cetl(3 x %) + ceil(3x g)

4
d 1 =0.27.
speedup equals 3x(1572)
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Note Using the Pattern search method with parallel computing may not
speed up the optimization time. To learn more, see “Why do I not see the
optimization speedup I expected using parallel computing?” on page 3-78 in
the “Troubleshooting Optimization Results” on page 3-72 section.

For a demo on the performance improvement achieved with the Pattern
search method, see the Improving Optimization Performance Using Parallel
Computing demo.

Configuring Your System for Parallel Computing

To use parallel computing, you must first configure your system as described
in the following sections:

¢ “Configuring Parallel Computing on Multicore Processors” on page 3-64
¢ “Configuring Parallel Computing on Multiprocessor Networks” on page 3-64
After you configure your system for parallel computing, you can use the

GUI or the command-line functions to optimize the model’s response using
parallel computing.

Configuring Parallel Computing on Multicore Processors

With a basic Parallel Computing Toolbox license, you can establish a pool of
up to four parallel MATLAB sessions in addition to the MATLAB client.

To start a pool of four MATLAB sessions in local configuration, type the
following at the MATLAB prompt:

matlabpool open local

To learn more, see the matlabpool reference page in the Parallel Computing
Toolbox documentation.

Configuring Parallel Computing on Multiprocessor Networks

To use parallel computing on a multiprocessor network, you must have
the Parallel Computing Toolbox software and the MATLAB Distributed
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Computing Server software. To learn more, see the Parallel Computing
Toolbox and MATLAB Distributed Computing Server documentation.

To configure a multiprocessor network for parallel computing:

1 Create a user configuration file to include any model file dependencies, as
described in “Defining Configurations” and FileDependencies reference
page in the Parallel Computing Toolbox documentation.

2 Open the pool of MATLAB workers using the user configuration file,
as described in “Applying Configurations in Client Code” in the Parallel
Computing Toolbox documentation.

Opening the pool allows the remote workers to access the file dependencies
included in the user configuration file.

Specifying Model Dependencies

Model dependencies are files, such as referenced models, data files and
S-functions, without which a model cannot run. When you use parallel
computing, Simulink Design Optimization software helps you identify model
path dependencies. To do so, the software uses the Simulink Manifest Tools.
The dependency analysis may not find all the files required by your model.
For example, folder paths that contain code for your model or block callback.
To learn more, see the “Scope of Dependency Analysis” in the Simulink
documentation.

Before you start the optimization using parallel computing, verify that the
response optimization project includes all model dependencies and the remote
workers can access them.

Note The optimization errors out if the response optimization project does
not contain all the model dependencies or the remote workers cannot access
the dependencies.

You can add additional dependencies and make the dependencies accessible
to remote workers, as described in the following sections:

® “Specifying Additional Path and File Dependencies” on page 3-66
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¢ “Making Model Dependencies Accessible to Remote Workers” on page 3-66

Specifying Additional Path and File Dependencies

If your model has path and file dependencies that the software cannot find
automatically, add the dependencies before you start the optimization using
parallel computing:

1 Add the path dependencies using the GUI or at the command line, as
described “How to Use Parallel Computing in the GUI” on page 3-66, and
“How to Use Parallel Computing at the Command Line” on page 3-70.

2 Add the file dependencies, as described in “Configuring Parallel Computing
on Multiprocessor Networks” on page 3-64.

Making Model Dependencies Accessible to Remote Workers
If your model has dependencies that the remote MATLAB workers cannot
access directly, modify the list of dependencies to make them accessible.
For example, remote workers cannot access model dependencies on your
local drive. Update the list of paths so that the workers can access them, as
described in “How to Use Parallel Computing in the GUI” on page 3-66, and
“How to Use Parallel Computing at the Command Line” on page 3-70.

How to Use Parallel Computing in the GUI

After you configure your system for parallel computing, as described in
“Configuring Your System for Parallel Computing” on page 3-64, you can use
the GUTI to optimize your model’s response:

1 Open the model that you want to optimize.

2 Configure the response optimization project for your model.
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3 In the Signal Constraint block, select Optimization > Parallel Options
to open the Parallel Options tab.

T — -0 ]

Simulation Qptions | Optimization Options |

[~ Use the matlabpoal during optimization

~Madel path dependencies

Mo model path dependencies.

Add path dependency... | Sync path dependencies from mode!

oK Cancel Help | Apply
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4 Select the Use the matlabpool during optimization option.

This action checks for model path dependencies in your Simulink model and
displays the path dependencies in the Model path dependencies list box.

Note As described in “Specifying Model Dependencies” on page 3-65,
the automatic path dependencies check may not detect all the path
dependencies in your model.

Jopuons i

Simulation Options | Optimization Options Parallel Options |

¥ Use the matiabpool during optimizatiori

~Model path dependencies

Ci/matlab testtoalbox sloptim|sloptparalleljparalleiModelDepends

Add path dependency... | Sync path dependencies from model

oK Cancel Help | Apply
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5 (Optional) Add the path dependencies that the automatic check does not

detect to the response optimization project.

a Specify the paths in the Model path dependencies list box.

You can specify the paths separated with a semicolon, or on a new line.

e — =lox

Simulation Optionsl Optimization Options  Parallel Options |

[ Use the matlabpaool during optimization

~Madel path dependencies

C:J'matlabJ'requirementsj'prc-ject|

C:/matlab test toolbox sloptim|sloptparallel |paralleiModelbepends; C: fmatlabfwork/project

Add path dependency... |

Sync path dependencies from model

oK I Cancel |

| Apply |

b Click Apply to include the new paths in the response optimization

project.

Alternatively, you can click Add path dependency to open a Browse For
Folder dialog box where you can select the folder to add.

Select the directary to add ko the model path dependencies.

=] :J My Computer ﬂ
—

_ﬁ 314 Floppy (A
=] = Syskem (C:)
) _rpcs
=l [C5) matlab
=

70 rksnit j

Folder: I wark

oK I Cancel

Make Mew Folder I
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6 (Optional) In the Model path dependencies list box, update the paths
on local drives to make them accessible to remote workers. For example,
change C:\ to \\\\hostname\\C$\\.

7 (Optional) If you modify the Simulink model such that it introduces a new
path dependency, then you must resync the path dependencies. Click Sync
path dependencies from model in the Parallel Options tab to rerun
the automatic dependency check for your model.

This action updates the Model path dependencies list box with any new
path dependency found in the model.

8 Click OK.

9 In the Signal Constraint block window, select Optimization > Start to
optimize the model response using parallel computing.

For more information on how to troubleshoot problems that occur during
optimization using parallel computing, see “Optimization Speed and Parallel
Computing” on page 3-76.

How to Use Parallel Computing at the Command Line

After you configure your system for parallel computing, as described in
“Configuring Your System for Parallel Computing” on page 3-64, you can
optimize your model’s response using the command-line functions:

1 Open the model that you want to optimize.
2 Configure a response optimization project, proj.

3 Enable the parallel computing option in the response optimization project
by typing the following command:

optimset(proj, 'UseParallel’', 'always');
4 Find the model path dependencies by typing the finddepend command.
dirs=finddepend(proj)

This command returns the model path dependencies in your Simulink
model.
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Note As described in “Specifying Model Dependencies” on page 3-65,
the finddepend command may not detect all the path dependencies in
your model.

5 (Optional) Modify dirs to include the model path dependencies that
finddepend does not detect.

dirs=vertcat(dirs, '\\hostname\C$\matlab\work")

6 (Optional) Modify dirs to make paths on local drives accessible to remote
workers.

dirs = regexprep(dirs,'C:/"','"\\\\hostname\\C$\\")

7 Add the updated path dependencies to the response optimization project,
proj by typing the following command:

optimset(proj, 'ParallelPathDependencies’',dirs)
8 Run the optimization by typing the following command:

optimize(proj)
For more information on how to troubleshoot problems that occur during
optimization using parallel computing, see “Optimization Speed and Parallel

Computing” on page 3-76 in “Troubleshooting Optimization Results” on page
3-72.
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Troubleshooting Optimization Results

When optimizing the model parameters, the optimization method may run
into issues. Simulink Design Optimization software provides visual cues to
inform you about issues during the progress of an optimization. The following
list represents the commonly encountered problems, and recommends
solutions, advice, and tips to help you troubleshoot the issue.

e “Optimization Does Not Make Progress” on page 3-72

e “Optimization Convergence” on page 3-73

® “Optimization Speed and Parallel Computing” on page 3-76

e “Undesirable Parameter Values” on page 3-79

e “Reverting to Initial Parameter Values” on page 3-80

Optimization Does Not Make Progress

e “Should I worry about the scale of my responses and how constraints and
design requirements are discretized?” on page 3-72

* “Why don’t the responses and parameter values change at all?” on page 3-72

* “Why does the optimization stall?” on page 3-73

Should | worry about the scale of my responses and how constraints
and design requirements are discretized?. No. Simulink Design
Optimization software automatically normalizes constraints, design
requirement and response data. Unlike its predecessor, the Nonlinear Control
Design Blockset software, it does not discretize the constraints or design
requirements.

Why don’t the responses and parameter values change at all?.
¢ The optimization problem you formulated might be nonsmooth. This means
that small parameter changes have no effect on the amount by which

response signals satisfy or violate the constraints and only large changes
will make a difference. Try switching to a search-based method such as
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simplex search or pattern search. Alternatively, look for initial guesses
outside of the dead zone where parameter changes have no effect. If you
are directly optimizing the response of a Simulink model using a Signal
Constraint block, you could also try removing nonlinear blocks such as
the Quantizer or Dead Zone block.

e If you are using the Refined option for Gradient type with the gradient
descent method, try the Basic option for Gradient type instead. The
gradient model that the Refined option uses might be invalid for your
problem.

Why does the optimization stall?. When using a Signal Constraint block
to directly optimize a Simulink model, certain parameter combinations can
make the simulation stall for models with strong nonlinearities or frequent
mode switching. In these cases, the ODE solvers take smaller and smaller step
sizes. Stalling can also occur when the model’s ODEs become too stiff for some
parameter combinations. A symptom of this behavior is when the Simulink
model status is Running and clicking the Stop button fails to interrupt the
optimization. When this happens, you can try one of the following solutions:

® Switch to a different ODE solver, especially one of the stiff solvers.
® Specify a minimum step size.
® Disable zero crossing detection if chattering is occurring.

® Tighten the lower and upper bounds on parameters that cause simulation
difficulties. In particular, eliminate regions of the parameter space where
some model assumptions are invalid and the model behavior can become
erratic.

Optimization Convergence
* “What to do if the optimization does not get close to an acceptable solution?”
on page 3-74

¢ “Why does the optimization terminate before exceeding the maximum
number of iterations, with a solution that does not satisfy all the constraints
or design requirements?” on page 3-74

* “What to do if the optimization takes a long time to converge even though it
is close to a solution?” on page 3-75
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e “What to do if the response becomes unstable and does not recover?” on
page 3-75

What to do if the optimization does not get close to an acceptable
solution?.

¢ [fyou’re using gradient descent, the default method, try the Refined option
for Gradient type. This option yields more accurate gradient estimates
when using variable-step solvers and can facilitate convergence.

¢ [f you are using pattern search, check that you have specified appropriate
maximum and minimum values for all your tuned parameters or
compensator elements. The pattern search method looks inside these
bounds for a solution. When they are set to their default values of Inf
and -Inf, the method searches within £100% of the initial values of the
parameters. In some cases this region is not large enough and changing the
maximum and minimum values can expand the search region.

® Your optimization problem might have local minima. Consider running one
of the search-based methods first to get closer to an acceptable solution.

e Reduce the number of tuned parameters and compensator elements
by removing from the Tuned parameters list (when using a Signal
Constraint block) or from the Compensators pane (when using a SISO
Design Task) those parameters that you know only mildly influence the
optimized responses. After you identify reasonable values for the key
parameters, add the fixed parameters back to the tunable list and restart
the optimization using these reasonable values as initial guesses.

Why does the optimization terminate before exceeding the
maximum number of iterations, with a solution that does not satisfy
all the constraints or design requirements?.

¢ [t might not be possible to achieve your specifications. Try relaxing the
constraints or design requirements that the response signals violate the
most. After you find an acceptable solution to the relaxed problem, tighten
some constraints again and restart the optimization.

¢ The optimization might have converged to a local minimum that is not a
feasible solution. Restart the optimization from a different initial guess
and/or use one of the search-based methods to identify another local
minimum that satisfies the constraints.
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What to do if the optimization takes a long time to converge even
though it is close to a solution?.

¢ In a Signal Constraint window, use the Stop button, or select
Optimization > Stop, to interrupt the optimization when you think the
current optimized response signals are acceptable.

When you use a SISO Design Task, click Stop Optimization in the
Optimization panel of the Response Optimization node in the Control
and Estimation Tools Manager, when you think the current optimized
response signals are acceptable.

¢ If you use the gradient descent method, try restarting the optimization.
Restarting resets the Hessian estimate and might speed up convergence.

¢ Increase the convergence tolerances in the Optimization Options dialog
to force earlier termination.

¢ Relax some of the constraints or design requirements to increase the size of
the feasibility region.

What to do if the response becomes unstable and does not recover?.
While the optimization formulation has explicit safeguards against unstable
or divergent response signals, the optimization can sometimes venture into
an unstable region where simulation results become erratic and gradient
methods fail to find a way back to the stable region. In these cases, you can
try one of the following solutions:

¢ Add or tighten the lower and upper bounds on compensator element and
parameter values. Instability often occurs when you allow some parameter
values to become too large.

® Use a search-based method to find parameter values that stabilize the
response signals and then start the gradient-based method using these
initial values.

® When optimizing responses in a SISO Design Task, you can try adding
additional design requirements that achieve the same or similar goal.
For example, in addition to a settling time design requirement on a step
response plot, you could add a settling time design requirement on a
root-locus plot that restricts the location of the real parts of the poles. By
adding overlapping design requirements in this way, you can force the
optimization to meet the requirements.

3-75



3 Parameter Optimization

3-76

Optimization Speed and Parallel Computing

e “How can I speed up the optimization?” on page 3-76

® “Why are the optimization results with and without using parallel
computing different?” on page 3-77

* “Why do I not see the optimization speedup I expected using parallel
computing?”’ on page 3-78

* “Why does the optimization using parallel computing not make any
progress?” on page 3-78

® “Why do I receive an error “Cannot save model
tpeb468c55_910c_4275_94ef 305e2eeeeef4”?” on page 3-78

e “Why does the optimization using parallel computing not stop when I click
the Stop optimization button?” on page 3-79

How can | speed up the optimization?.

¢ The optimization time is dominated by the time it takes to simulate
the model. When using a Signal Constraint block to directly optimize
a Simulink model, you can enable the Accelerator mode using
Simulation > Accelerator in the Simulink model window, to dramatically
reduce the optimization time.

Note The Rapid Accelerator mode in Simulink software is not supported
for speeding up the optimization. For more information, see “Accelerating
Model Simulations During Optimization” on page 3-58.

¢ The choice of ODE solver can also significantly affect the overall
optimization time. Use a stiff solver when the simulation takes many small
steps, and use a fixed-step solver when such solvers yield accurate enough
simulations for your model. (These solvers must be accurate in the entire
parameter search space.)

® Reduce the number of tuned compensator elements or parameters and
constrain their range to narrow the search space.
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® When specifying parameter uncertainty (not available when optimizing
responses in a SISO Design Task), keep the number of sample values small
since the number of simulations grows exponentially with the number of
samples. For example, a grid of 3 parameters with 10 sample values for
each parameter requires 10°=1000 simulations per iteration.

Why are the optimization results with and without using parallel
computing different?.

® When you use parallel computing, different numerical precision on the
client and worker machines can produce marginally different simulation
results. Thus, the optimization method takes a completely different
solution path and produces a different result.

Note Numerical precision can differ because of different operating systems
or hardware on the client and worker machines.

® When you use parallel computing, the state of the model on the client and
the worker machines can differ, and thus lead to a different result. For
example, the state can become different if you change a parameter value
initialized by a callback function on the client machine after the workers
have loaded the model. The model parameter values on the workers and
the client are now out of sync, which can lead to a different result.

After you change the model parameter values initialized by a callback
function, verify that the parameters exist in the model workspace or
update the callback function so that the remote workers have access to the
changed parameter values.

® When you use parallel computing with the Pattern search method,
the Pattern search method searches for a candidate solution more
comprehensively than when you do not use parallel computing. This more
comprehensive search can result in a different solution. To learn more, see
“Parallel Computing with the Pattern search Method” on page 3-62.
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Why do | not see the optimization speedup | expected using parallel
computing?.

® When you optimize a model that does not have a large number of
parameters or does not take long to simulate, the resulting optimization
time may not be any faster. In such cases, the overheads associated with
creating and distributing the parallel tasks outweighs the benefits of
running the simulations during optimization in parallel.

¢ Using Pattern search method with parallel computing may not speed
up the optimization time. When you do not use parallel computing, the
method stops searching for a candidate solution at each iteration as soon as
it finds a solution better than the current solution. The candidate solution
search is more comprehensive when you use parallel computing. Although
the number of iterations may be larger, the optimization without using
parallel computing may be faster.

To learn more about the expected speedup, see “Parallel Computing with
the Pattern search Method” on page 3-62.

Why does the optimization using parallel computing not make
any progress?. In some cases, the gradient computations on the remote
worker machines may silently error out when you use parallel computing.
In such cases, the Optimization Progress window shows that the f (x) and
max constraint values do not change, and the optimization terminates
after two iterations with the message Unable to satisfy constraints.
To troubleshoot the problem:

1 Run the optimization for a few iterations without parallel computing to
see if the optimization progresses.

2 Check if the remote workers have access to all model dependencies.
To learn more, see “Making Model Dependencies Accessible to Remote
Workers” on page 3-66.

Why do | receive an error “Cannot save model

tpe5468c55 910c_4275 94ef 305e2eeeeefd”?. When you

select Refined as the Gradient type, the software may error out when it
saves a temporary model to a nonwriteable folder, and then displays this error
message. Change the Gradient type to Basic to clear this error. To learn
more, see “Gradient Type” on page 3-31.
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Why does the optimization using parallel computing not stop when |
click the Stop optimization button?. When you use parallel computing,
the software has to wait till the current iteration completes before it notifies
the workers to stop the optimization. The optimization does not terminate

immediately when you click the Stop optimization button u , and appears
to continue to run.

Undesirable Parameter Values

® “What to do if the optimization drives the tuned compensator elements and
parameters to undesirable values?” on page 3-79

® “What to do if the optimization violates bounds on parameter values?”
on page 3-79

What to do if the optimization drives the tuned compensator
elements and parameters to undesirable values?.

® When a tuned compensator element or parameter is positive, or when its
value is physically constrained to a given range, enter the lower and upper
bounds (Minimum and Maximum) in one of the following:

= Tuned Parameters dialog box (from a Signal Constraint block)
= Compensators pane (in a SISO Design Task)

This information helps guide the optimization method towards a reasonable
solution.

¢ In the Tuned Parameters dialog box (from a Signal Constraint block) or the
Compensators pane (in a SISO Design Task), specify initial guesses that
are within the range of desirable values.

¢ In the Compensators pane in a SISO Design Task, verify that no
integrators/differentiators are selected for optimization. Optimizing the
pole/zero location of integrators/differentiators can result in drastic changes
in the system gain and lead to undesirable values.

What to do if the optimization violates bounds on parameter

values?. The Gradient descent optimization method fmincon violates
the parameter bounds when it cannot simultaneously satisfy the signal
constraints and the bounds. When this happens, try one of the following:
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Specify a different value for the parameter bound and restart the
optimization. A guideline is to adjust the bound by 1% of the typical value.

For example, for a parameter with a typical value of 1 and lower bound of
0, change the lower bound to 0.01.

Relax the signal constraints and restart the optimization. This approach
results in a different solution path for the Gradient descent method.

Restart the optimization immediately after it terminates by using the Start
optimization button in the Signal Constraint window. This approach
uses the previous optimization results as the starting point for the next
optimization cycle to refine the results.

Use the following two-step approach to perform the optimization:

1 Run an initial optimization to satisfy the signal constraints.

For example, run the optimization using the Simplex search method.
This method satisfies the signal constraints but does not support the
bounds on parameter values. The results obtained using this method
provide the starting point for the optimization performed in the next
step. To learn more about this method, see the fminsearch function
reference page in the Optimization Toolbox documentation.

2 Reconfigure the optimization by selecting a different optimization
method to satisfy both the signal constraints and the parameter bounds.

For example, change the optimization method to Gradient descent
and run the optimization again.

Tip If Global Optimization Toolbox software is installed, you can select the
Pattern search optimization method to optimize the model response.

Reverting to Initial Parameter Values

How do | quit an optimization and revert to my initial parameter
values?.

® When using a Signal Constraint block in a Simulink model, click the Stop

button or select Optimization > Stop in the Signal Constraint window
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to stop the optimization. To revert to your initial parameter values, select
Edit > Undo Optimize Parameters.

® When using a SISO Design Task, the Start Optimization button becomes
a Stop Optimization button after the optimization has begun. To quit
the optimization, click the Stop Optimization button. To revert to the
initial parameter values, select Edit > Undo Optimize compensators
from the menu in the SISO Design Tool window.
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Saving and Loading Response Optimization Projects

In this section...

“Saving Response Optimization Projects” on page 3-82
“Saving Additional Settings” on page 3-85

“Reloading Response Optimization Projects” on page 3-86

Saving Response Optimization Projects

Saving a response optimization project lets you reuse your settings during a
later session. These settings include constraint bounds, tuned and uncertain
parameters, and settings for optimization and simulation. The software saves
the settings from all Signal Constraint blocks in the model in a single project.

You can save the response optimization project as a workspace variable or
a MAT-file:

1 Select File > Save in a Signal Constraint window. This action opens the
Save Project dialog box.

il

Save optimization project as:

& Model w orkspace variable:
|proi_model_optim

" MATLAB workspace variable:

|;|'cj_mcce|_c;tim

 MAT-file:
|;|'cj_mccel_c;:tim.n'.at _I

When loading project, use: |path as specified

¥ Save and reload project with Simulink model

ok | cancel| Hep |

2 Save the project using one of the following options in the Save Project
dialog box:
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* Model workspace variable: Specify a variable name. This option
saves the project in the model workspace.

* MATLAB workspace variable: Specify a variable name. The project
no longer exists after you terminate the MATLAB session.

e MAT-file: Type a file name. For example, myproject.mat, which saves
the project in the current MATLAB folder.

To specify a different location for the MAT-file, type the path or click —I
to select a folder. Optionally, you can specify how the software searches
for the path when loading the project in the When loading project,
use drop-down list.

||:| rn:lj_n';;:ll:lel_u ptim.mat _I

When loading project, Use [path az zpecified j

By default, the software uses the path specified in the MAT-file edit
field. For more path options, see “Path Options for Project MAT-files”
on page 3-84.

3 Verify that the Save and reload project with Simulink model check
box is selected.

This option automatically loads the project when you reopen the Simulink
model. If the software cannot find the project, a warning message appears.

4 Click OK to save the project.
To save the response optimization project using a new file name, select

File > Save As from a Signal Constraint window. Then, follow the preceding
instructions.
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Path Options for Project MAT-files

When loading a response optimization project, the software requires the
path of the project MAT-file. You can specify this information in the When
loading project, use drop-down list, using one of the following options:

Path Option | Path Searched | Example
When Loading
a Project

path as Specified in the

specified MAT-file edit Current : \work

(Default) field. MATLAB
folder:
Model :\work\models
location:
Project :\work\projects\proj_model optim.mat
location:
Path :\work\projects\proj_model optim.mat
searched:

path Relative to the

relative location of the Current s \work

to model Simulink model. MATLAB

folder folder:
Model :\work\models
location:
Project :\work\projects\proj_model optim.mat
location:
Path .\projects\proj_model optim.mat
searched:
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Path Option

Path Searched
When Loading
a Project

Example

path
relative
to current
folder

Relative to the
current MATLAB
folder.

Current
MATLAB
folder:

Model
location:

Project
location:

Path
searched:

C:\work

C:\work\models

C:\work\projects\proj_model_optim.mat

projects\proj_model optim.mat

no path
(file name
only)

Current
MATLAB folder.

Current
MATLAB
folder:

Model
location:

Project
location:

Path
searched:

C:\work

C:\work\models

C:\work\projects\proj_model_optim.mat

proj_model_optim.mat

Saving Additional Settings

In addition to settings that you save with the response optimization project,
the software automatically saves several other settings with the model. These

settings include the following:

® The position of the Signal Constraint window on the screen

® The axis limit settings within the Signal Constraint window
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® The location where the response optimization project, either a workspace
variable or a MAT-file, is saved

® The name of the response optimization project

You must save the Simulink model to retain the settings when reloading
the model in a subsequent session. To save the model, select File > Save
in the model window.

Reloading Response Optimization Projects

To reload a response optimization project from the MATLAB workspace,
model workspace, or a file, select File > Load in a Signal Constraint window
in the model. In the Load Project dialog box (shown next), enter the name of
the MATLAB workspace variable, model workspace variable, or MAT-file
that contains the project, and then click OK. Alternatively, you can load the
project from an existing file by clicking the button to the right of MAT-file
and selecting a file from the folder.

Load optimization praject from:

=101 ]

¥ MATLAB workspace variable:

" Model workspace variable:
feido_moadett

£ MAT-file:

| L

oK I Cancell

Help I

Although the load command is issued from a single Signal Constraint window,
the constraints are loaded into all Signal Constraint blocks in the model.
Additionally, tuned parameters, uncertain parameters, and optimization and
simulation setup options are loaded into the model.

Note Loading a project cannot be undone.
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Optimizing Parameters at the Command Line

In this section...

“Workflow for Optimizing Parameters at the Command Line” on page 3-87
“Configuring a Simulink Model for Optimizing Parameters” on page 3-88
“Creating or Extracting a Response Optimization Project” on page 3-88
“Specifying Design Requirements” on page 3-89

“Specifying Parameter Settings” on page 3-93

“Configuring Optimization and Simulation Settings” on page 3-94

“Running the Optimization” on page 3-95

Workflow for Optimizing Parameters at the
Command Line

The workflow for optimizing model parameters at the command line includes
the following tasks:

1 “Configuring a Simulink Model for Optimizing Parameters” on page 3-88
2 “Creating or Extracting a Response Optimization Project” on page 3-88
3 “Specifying Design Requirements” on page 3-89

4 “Specifying Parameter Settings” on page 3-93

5 “Configuring Optimization and Simulation Settings” on page 3-94

6 “Running the Optimization” on page 3-95

For a tutorial on how to optimize parameters at the command line, see
“Tutorial — Optimizing Parameters to Meet Time-Domain Requirements
Using the Command Line”.

Tip To learn how to optimize parameters using the GUI, see “Optimizing
Parameters Using the GUI” on page 3-3.
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Configuring a Simulink Model for Optimizing
Parameters
To optimize parameters of a Simulink model, first configure the model:

1 Open the Simulink model by typing the model name at the MATLAB
prompt.

2 Open the Simulink Design Optimization library by typing sdolib at the
MATLAB prompt.

3 Drag and drop the Signal Constraint block into the Simulink model window.
To learn more about the block, see Signal Constraint block reference page.

4 Connect the Signal Constraint block to the signal to which you want to
add specific design requirements.

Creating or Extracting a Response Optimization
Project

Simulink Design Optimization provides the following commands for creating
or extracting a response optimization project from a Simulink model that
contains at least one Signal Constraint block:

Command Use for

newsro Create a new response optimization
project with default settings

getsro Extract a response optimization
project

When you add a Signal Constraint block to the Simulink model, as described in
“Configuring a Simulink Model for Optimizing Parameters” on page 3-88, the
software creates a response optimization project for this model automatically.
This response optimization contains default settings for design requirements,
parameter values, optimization options, and simulation options.

Use the newsro command to extract this default response optimization project
from the model.
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Note When you use newsro, you also specify the model parameters for
optimization. See the reference page for more information.

After extracting the default response optimization project, you can modify the
requirements, as described in “Specifying Design Requirements” on page 3-89.

When a Simulink model already contains specific design requirements and
settings, use the getsro command to extract the response optimization
project from this model.

Tip You can also use newsro to create a new response optimization project
with default settings for the model that already contains specific design
requirements and settings.

The response optimization project, proj, returned by newsro and getsro
has the following structure:

Name: 'sldo_modell’
Parameters: [3x1 ResponseOptimizer.Parameter]
OptimOptions: [1x1 sroengine.OptimOptions]
Tests: [1x1 ResponseOptimizer.SimTest]
Model: 'sldo_modeld'

Response Optimization Project.

Specifying Design Requirements
After you create a response optimization project, as described in “Creating
or Extracting a Response Optimization Project” on page 3-88, use the

findconstr function to extract the constraints specified in the Signal
Constraint block of the Simulink model.

The constraint object constr returned by findconstr contains data defining
the design requirements. Design requirements include positions of the
constraint bound segments and reference signals specified in the Signal
Constraint block. The constraints define the region in which the response
signal must lie.
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The constraint object constr has the following structure:

ConstrEnable: 'on'
isFeasible: 1
CostEnable: 'off'

Enable: 'on'
Name: 'Signal Constraint'
SignalSize: [1 1]
LowerBoundX: [3x2 double]
LowerBoundY: [3x2 double]
LowerBoundWeight: [3x1 double]
UpperBoundX: [2x2 double]
UpperBoundY: [2x2 double]
UpperBoundWeight: [2x1 double]
ReferenceX: []
ReferenceY: []
ReferenceWeight: []

Signal Constraint.

To learn how to modify design requirements specified in the constraint object,
see the following sections:

e “Specifying Signal Bounds” on page 3-90
® “Specifying a Reference Signal” on page 3-92

Specifying Signal Bounds

The LowerBoundX, LowerBoundY, UpperBoundX, and UpperBoundY properties
of the constraint object represent numeric values of design requirements

on a signal, specified in the Signal Constraint block of the model. These
properties define the amplitude and time for the beginning and end points of
each segment in the Signal Constraint block:

® LowerBoundY and UpperBoundY properties specify the start and end
amplitude of the lower- and the upper-constraint bound segments.

LowerBoundX, and UpperBoundX properties specify the time segments
corresponding to the LowerBoundY and UpperBoundY amplitude properties,
respectively.
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Modify the properties UpperBoundX, UpperBoundY, LowerBoundX, and
LowerBoundY to specify new signal bounds. For example:

constr.UpperBoundY=[1.1 1.1;1.01 1.01];
constr.UpperBoundX=[0 30;30 50];
constr.LowerBoundY=[0 0;0.9 0.9;0.99 0.99];
constr.LowerBoundX=[0 15;15 30;30 50];

Note When you specify time values for the constraint bound segments, make
sure that two consecutive time values do not overlap or have gaps between
them.

If you add these constraints graphically in the Signal Constraint block, the
constraints appear as shown in the following figure.

Input to srotut1 Signal Constraint
1 2 e —

0 feo B b i

1] S o s

Amplitude

O feeeeenee ............ ...........

oz T S ;

a 5 10 15 20 25 30 35 40 45 50
Time (sec)

Note The Signal Constraint block in the Simulink model does not update
to display the modified constraints. However, the software uses the updated
constraint bounds specified in the constraint object when you optimize the
parameters from the command line.
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To view the updated value of the property, type constr.PropertyName. For
example:

constr.LowerBoundY

Specifying a Reference Signal

ReferenceX and ReferenceY properties contain the time and amplitude
vectors of the reference signal, respectively. Modify these properties to specify
a new reference signal to track. For example:

constr.CostEnable='on';
constr.ReferenceX=1linspace(0,50,1000);
constr.ReferenceY=1-exp(-linspace(0,50,1000));

If you include the reference signal graphically in the Signal Constraint block,
the reference signal appears as shown in the following figure.

Input to srotut1 Signal Constraint

1] ST —

1) A T S

Amplitude

Qi b ooeeeeeend ............. .............

1FY R S :

1] 5 10 15 20 25 30 35 40 45 50
Time (=ec)
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Note The Signal Constraint block in the Simulink model does not update
to display the reference signal. However, the software uses the reference
signal specified in the constraint object when you optimize the parameters
from the command line.

To view the updated value of the property, type constr.PropertyName. For
example:

constr.ReferenceX

Specifying Parameter Settings

After you create a response optimization project, as described in “Creating or
Extracting a Response Optimization Project” on page 3-88, you can specify
the parameters settings to use for optimization:

1 Use the findpar command to retrieve the parameter object param from the
response optimization project proj.

The parameter object param has the following structure:

Name: 'Kd'
Value: O
InitialGuess: O
Minimum: -Inf
Maximum: Inf
TypicalValue: 0
ReferencedBy: {Ox1 cell}
Description: "'
Tuned: 1

Tuned parameter.

The Value property specifies a value for the parameter in the Simulink
model. Use the following properties to specify the parameter settings:
e InitialGuess — Initial value

® Minimum and Maximum — Parameter bounds

® TypicalValue — Scaling factor
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To learn more about these properties, see the findpar reference page.
2 To specify parameter settings, edit the properties using dot notation.
For example:

param.Minimum=0;

Configuring Optimization and Simulation Settings

After you specify the design requirements and parameters for optimization, as
described in “Specifying Design Requirements” on page 3-89 and “Specifying
Parameter Settings” on page 3-93, you can optionally modify the optimization
and simulation settings.

To modify the current optimization settings:

1 Extract the current optimization settings opt_options from the response
optimization project using the optimget command.

The options object opt_options has the following structure:

Method: 'fmincon'
Algorithm: 'active-set'
Display: 'iter'
GradientType: 'basic'
MaximallyFeasible: O
MaxIter: 100
TolCon: 1.0000e-003
TolFun: 1.0000e-003
TolX: 1.0000e-003
Restarts: O
UseParallel: 'never'
ParallelPathDependencies: {Ox1 cell}
SearchMethod: []

2 Modify the object properties using the optimset command.
For example:

optimset(proj, 'MaxIter',150)
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To learn more, see the corresponding reference pages.

Similarly, use the simget and simset commands to extract and modify the
simulation settings, respectively. To learn more, see the corresponding
reference pages.

Running the Optimization

Use the optimize command to optimize the response optimization project.
After the optimization completes, you see the optimized parameter
values displayed at the MATLAB prompt and also update in the response
optimization project.

Tip To run another optimization using the updated parameter values as their
initial values, use initpar. See the reference page for more information.
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Optimization-Based Linear
Control Design

® “Overview of Optimization-Based Compensator Design” on page 4-2
e “Supported Time- and Frequency-Domain Requirements” on page 4-4
® “Designing Optimization-Based Controllers for LTI Systems” on page 4-8

® “Designing Linear Controllers for Simulink Models” on page 4-30
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Overview of Optimization-Based Compensator Design

When you have Control System Toolbox software installed, you can design
and optimize control systems by tuning controller elements or parameters
within a SISO Design Task in the Control and Estimation Tools Manager.
You can tune elements or parameters such as poles, zeros, and gains within
any controller in the system and optimize the open and closed loop responses.

Optimize the responses of systems in the SISO Design Task to meet both
time- and frequency-domain performance requirements by graphically
constraining signals:

* Add frequency-domain design requirements to plots such as root-locus,
Nichols, and Bode in the SISO Design Task graphical tuning editor called
SISO Design Tool.

* Add time-domain design requirements to plots such as step or impulse
response (when displayed within the LTI Viewer as part of a SISO Design
Task).

You can use optimization methods in a SISO Design Task in the Control and
Estimation Tools Manager to tune both command-line LTI models as well
as Simulink models:

® Create an LTI model using the Control System Toolbox command-line
functions and use the sisotool function to create a SISO Design Task
for the model.

e Use a Simulink Compensator Design task (from Simulink Control Design
software) to automatically analyze the model and then create a SISO
Design Task for a linearized version of the model. You can then use the
optimization techniques in the SISO Design Task to tune the response
of the linearized Simulink model.

Note When using response optimization within a SISO Design Task you
cannot add uncertainty to system parameters.

When using a SISO Design Task, Simulink Design Optimization software
automatically sets the model’s simulation start and stop time and you cannot
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directly change them. By default, the simulation starts at 0 and continues
until the SISO Design Task determines that the dynamics of the model have
settled out. In addition, when the design requirements extend beyond this
point, the simulation continues to the extent of the design requirements.
Although you cannot directly adjust the start or stop time of the simulation,
you can adjust the design requirements to extend further in time and thus
force the simulation to continue to a certain point.
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Supported Time- and Frequency-Domain Requirements

In this section...

“Root Locus Diagrams” on page 4-4

“Open-Loop and Prefilter Bode Diagrams” on page 4-6
“Open-Loop Nichols Plots” on page 4-6

“Step/Impulse Response Plots” on page 4-7

This section lists the time- and frequency-domain requirements that you can
specify for optimization-based control design in Simulink Design Optimization
software:

Root Locus Diagrams

Settling Time

If you specify a settling time in the continuous-time root locus, a vertical line
appears on the root locus plot at the pole locations associated with the value
provided (using a first-order approximation). In the discrete-time case, the
constraint is a curved line.

It is required that Re{pole} < —4.6/Tgey;y, for continuous systems and

log(abs(pole))/ Tyiscrete < —4-6/ Tyetsiing for discrete systems. This is an
approximation of the settling time based on second order dominant systems.

Percent Overshoot

Specifying percent overshoot in the continuous-time root locus causes two
rays, starting at the root locus origin, to appear. These rays are the locus of
poles associated with the percent value (using a second-order approximation).
In the discrete-time case, the constraint appears as two curves originating at
(1,0) and meeting on the real axis in the left-hand plane.

The percent overshoot p.o constraint can be expressed in terms of the damping
ratio, as in this equation:
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p.o.= 100e ™/ V1L
where { is the damping ratio.

Damping Ratio

Specifying a damping ratio in the continuous-time root locus causes two rays,
starting at the root locus origin, to appear. These rays are the locus of poles
associated with the damping ratio. In the discrete-time case, the constraint
appears as curved lines originating at (1,0) and meeting on the real axis in
the left-hand plane.

The damping ratio defines a requirement on —Re{pole}/abs(pole) for
continuous systems and on

r = abs(pSys)
t = angle(pSys)

¢ = —log(r)/(log(r))? + ¢

for discrete systems.

Natural Frequency

If you specify a natural frequency, a semicircle centered around the root locus
origin appears. The radius equals the natural frequency.

The natural frequency defines a requirement on abs(pole) for continuous
systems and on

r = abs(pSys)
t = angle(pSys)

¢ =\ og()? +12 1 TS ool

for discrete systems.
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Region Constraint

Specifies an exclusion region in the complex plane, causing a line to appear
between the two specified points with a shaded region below the line. The
poles must not lie in the shaded region.

Open-Loop and Prefilter Bode Diagrams

Gain and Phase Margins
Specify a minimum phase and or a minimum gain margin.

Upper Gain Limit

You can specify an upper gain limit, which appears as a straight line on the
Bode magnitude curve. You must select frequency limits, the upper gain limit
in decibels, and the slope in dB/decade.

Lower Gain Limit
Specify the lower gain limit in the same fashion as the upper gain limit.

Open-Loop Nichols Plots

Phase Margin

Specify a minimum phase amount.

While displayed graphically at only one location around a multiple of -180
degrees, this requirement applies to phase margin regardless of actual phase
(i.e., it is interpreted for all multiples of -180).

Gain Margin

Specify a minimum gain margin.

While displayed graphically at only one location around a multiple of -180
degrees, this requirement applies to gain margin regardless of actual phase
(i.e., it 1s interpreted for all multiples of -180).
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Closed-Loop Peak Gain

Specify a peak closed-loop gain at a given location. The specified value can be
positive or negative in dB. The constraint follows the curves of the Nichols plot
grid, so it is recommended that you have the grid on when using this feature.

While displayed graphically at only one location around a multiple of -180

degrees, this requirement applies to gain margin regardless of actual phase
(i.e., it is interpreted for all multiples of -180).

Gain-Phase Requirement

Specifies an exclusion region for the response on the Nichols plot. The
response must not pass through the shaded region.

This only applies to the region (phase and gain) drawn.

Step/Impulse Response Plots

Upper Time Response Bound
You can specify an upper time response bound.

Lower Time Response Bound
You can specify a lower time response bound.
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Designing Optimization-Based Controllers for LTI Systems

In this section...

“How to Design Optimization-Based Controllers for LTI Systems” on page
4-8

“Example — Frequency-Domain Optimization for LTI System” on page 4-9

How to Design Optimization-Based Controllers for
LTI Systems

To design optimization-based linear controller for an LTI model:

1 Create and import a linear model into a SISO Design Task. You can create
an LTI model at the MATLAB command line, as described in “Creating
an LTI Plant Model” on page 4-10.

2 Create a SISO Design Task with design and analysis plots, as described in
“Creating Design and Analysis Plots” on page 4-11.

To learn more about SISO Design Tool, see “Using the SISO Design Task in
the Controls & Estimation Tools Manager” in the Control System Toolbox
documentation.

3 Under Automated Tuning select Optimization based tuning as the
Design Method and then click the Optimize Compensators button to
create a Response Optimization task within the Control and Estimation
Tools Manager. See “Creating a Response Optimization Task” on page
4-14 for more information.

4 Within the Response Optimization node, select the Compensators
pane to select and configure the compensator elements you want to tune
during the response optimization. See “Selecting Tunable Compensator
Elements” on page 4-16 for more information.

5 Under Design requirements in the Response Optimization node,
select the design requirements you want the system to satisfy. See “Adding
Design Requirements” on page 4-17 for more information.
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6 Click the Start Optimization button within the Response Optimization
node. The optimization progress results appear under Optimization. The
Compensators pane contains the new, optimized compensator element
values. See “Optimizing the System’s Response” on page 4-25 for more
information.

Example — Frequency-Domain Optimization for LTI
System

® “Introduction” on page 4-9

¢ “Design Requirements” on page 4-10

® “Creating an LTI Plant Model” on page 4-10

® “Creating Design and Analysis Plots” on page 4-11

e “Creating a Response Optimization Task” on page 4-14

® “Selecting Tunable Compensator Elements” on page 4-16

¢ “Adding Design Requirements” on page 4-17

* “Optimizing the System’s Response” on page 4-25

® “Creating and Displaying the Closed-Loop System” on page 4-28

Introduction

When you have Control System Toolbox software, you can place Simulink
Design Optimization design requirements or constraints on plots in the SISO
Design Tool graphical tuning editor and analysis plots that are part of a SISO
Design Task. This allows you to include design requirements for response
optimization in the frequency-domain in addition to the time-domain. This
section guides you through an example using frequency-domain design
requirements to optimize the response of a system in the SISO Design Task.

You can specify frequency-domain design requirements to optimize response
signals for any model that you can design within a SISO Design Task:

¢ Command-line LTI models created with the Control System Toolbox
commands
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¢ Simulink models that have been linearized using Simulink Control Design

software

Design Requirements

In this example, you use a linearized version of the following Simulink model.
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You use optimization methods to design a compensator so that the closed loop
system meets the following design specifications when you excite the system
with a unit step input:

¢ A maximum 30-second settling time

e A maximum 10% overshoot

e A maximum 10-second rise time

e A limit of £0.7 on the actuator signal

Creating an LTI Plant Model

In the srotut1 model, the plant model is composed of a gain, a limited

integrator, a transfer function, and a transport delay.

You want to design the compensator for the open loop transfer function of the
linearized srotut1 model. The linearized srotut1 plant model is composed

of the gain, an unlimited integrator, the transfer function, and a Padé

approximation to the transport delay.
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To create an open loop transfer function based on the linearized srotut1
model, enter the following commands:

wO = 1;

zeta =1;

Kint = 0.5;

Tdelay = 1;

[delayNum,delayDen] = pade(Tdelay,1);
integrator = tf(Kint,[1 0]);

transfer_fcn
delay_block
open_loopTF

tf(w0*2,[1 2*wO*zeta w0"2]);
tf(delayNum,delayDen);
integrator*transfer_fcn*delay_block;

Note It is also possible to directly linearize the Simulink model srotut1
using Simulink Control Design software.

Creating Design and Analysis Plots

This example uses a root locus diagram to design the response of the open loop
transfer function, open_loopTF. To create a SISO Design Task, containing a
root-locus plot for the open loop transfer function, use the following command:

sisotool('rlocus',open_loopTF)

A SISO Design Task is created within the Control and Estimation Tools
Manager, as shown in the following figure.
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=) control and Estimation Tools Manager - 18] x|
File Edit Help
=d| o o
Workspace Architecture | Compensataor Editorl Graphical Tuningl Analysis Plotsl Automated Tuning
= Design Task
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Contral Architeckure ... | Modify architecture, labels and feedback signs.
Loop Configuration. .. | Configure additional loop openings For multi-loop design.
System Data ... | Import data for compensators and fixed systems,
Sample Time Conversion ... | Change the sample time of the design.
Show Architecture Stare Design | Help I
3
=l
3150 Design Task Node, 4

The Control and Estimation Tools Manager is a graphical environment

for managing and performing tasks such as designing SISO systems. The
SISO Design Task node contains five panels that perform actions related to
designing SISO control systems. For more information, see “Using the SISO
Design Task in the Controls & Estimation Tools Manager” in “Control System
Toolbox” documentation.

The Architecture pane, within the SISO Design Task node, lets you choose
the architecture for the control system you are designing. This example uses
the default architecture. In this system, the plant model, G, is the open loop
transfer function open_loopTF, the prefilter, F, and the sensor, H, are set to
1, and the compensator, C, is the compensator that will be designed using
response optimization methods.
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The SISO Design Task also contains a root locus diagram in the SISO Design
Tool graphical tuning editor.

) SIS0 Design Tool —|al x|
File Edit View Designs &nalysis Tools ‘Window Help ]

L xoz 2 &AW

Foot Locus Editar for Open-Loop 1 (OL1)
g T T T T T

Imag Lxiz

-5 | 1 i | |
-6 -4 -2 a 2 4 3
Real Axiz

Fight-click on the plots for mare design options.

In addition to the root-locus diagram, it is helpful to visualize the response of
the system with a step response plot. To add a step response:

1 Select the Analysis Plots pane with the SISO Design Task node of the
Control and Estimation Tool Manager.

2 Select Step for the Plot Type of Plot 1.

3 Under Contents of Plots, select the check box in column 1 for the response
Closed Loop r to y.
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A step response plot appears in an LTI Viewer. The plot shows the response
of the closed loop system from r (input to the prefilter, F) to y (output of the
plant model, G):

) LTI Yiewer for SISO Design Tool ': =1of x|

File Edit ‘Window Help

EIECYE

Step Response
T T

Amplitude

0z I I I 1 I I I 1
1] 10 20 an 40 al G0 7n an a0

Time [(Fec)

LTI iewer [V Real-Time Update

Creating a Response Optimization Task

There are several possible methods for designing a SISO system; this example
uses an automated approach involving response optimization methods. After
creating the design and analysis plots as discussed in “Creating Design and
Analysis Plots” on page 4-11, you are ready to start a response optimization
task to design the compensator.

To create a response optimization task:

1 Select the Automated Tuning pane within the SISO Design Task node
in the Control and Estimation Tools Manager.
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2 In the Automated Tuning pane, select Optimization based tuning as
the Design Method.

3 Click the Optimize Compensators button to create the Response
Optimization node under the SISO Design Task node in the tree
browser in the left pane of the Control and Estimation Tools Manager.

The Response Optimization node contains four panes as shown in the
next figure.

Response Cptimization

E! Control and Estimation Tools Manager 1Ol x|
File Edit Help
Bl o o
ﬂ Workspace Owerview I Compensatars | Design requirements | Optimization
(=4 ] 5150 Design Task Cwvervia
iﬁ Design History
! | Response Cptimization
| I
| 1
Step 1 I Step 2 1 Step 3
| 1
| 1
! Set optimization I
| options I
| 1
| I
Selact 1 1
compensalors to 1 I
optimize | I
| r ]
| 1
| I
Optimize ' - View results
| 1
| I
| 1
Select design 1 1
requirements : :
| 1
| I
| 1
Start Optimization | Help |
-
=
4

With the exception of the first pane, each corresponds to a step in the response
optimization process:

® Overview: A schematic diagram of the response optimization process.
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e Compensators: Select and configure the compensator elements that you
want to tune. See “Selecting Tunable Compensator Elements” on page 4-16.

* Design requirements: Select the design requirements that you want
the system to meet after tuning the compensator elements. See “Adding
Design Requirements” on page 4-17.

e Optimization: Configure optimization options and view the progress of
the response optimization. See “Optimizing the System’s Response” on
page 4-25.

Note When optimizing responses in a SISO Design Task, you cannot add
uncertainty to parameters or compensator elements.

Selecting Tunable Compensator Elements

You can tune elements or parameters within compensators in your system so
that the response of the system meets the design requirements you specify.
To specify the compensator elements to tune:

1 Select the Compensators pane within the Response Optimization node.

2 Within the Compensators pane, select the check boxes in the Optimize
column that correspond to the compensator elements you want to tune.

In this example, to tune the Gain in the compensator C, select the check
box next to this element, as shown in the following figure.
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Note Compensator elements or parameters cannot have uncertainty when
used with frequency-domain based response optimization.

Adding Design Requirements

You can use both frequency-domain and time-domain design requirements
to tune parameters in a control system. The Design requirements pane
within the Response Optimization node of the Control and Estimation
Tools Manager provides an interface to create new design requirements and
select those you want to use for a response optimization.
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This example uses the design specifications described in “Design
Requirements” on page 4-10. The following sections each create a new design
requirement to meet these specifications:

e “Settling Time Design Requirement” on page 4-18

® “Overshoot Design Requirement” on page 4-19

¢ “Rise Time Design Requirement” on page 4-21

e “Actuator Limit Design Requirement” on page 4-22

After you add the design requirements, you can select a subset of requirements

for controller design, as described in “Selecting the Design Requirements to
Use During Response Optimization” on page 4-25.

Settling Time Design Requirement. The first design specification for this
example 1s to have a settling time of 30 seconds or less. This specification
can be represented on a root-locus diagram as a constraint on the real parts
of the poles of the open loop system.

To add this design requirement:

1 Select the Design requirements pane within the Response
Optimization node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button. This opens the New
Design Requirement dialog box.

Within this dialog box you can specify new design requirements and add
them to a new or existing design or analysis plot.

3 Add a design requirement to the existing root-locus diagram:

a Select Pole/zero settling time from the Design requirement type
menu.

b Select Open-Loop L from the Requirement for response menu.
¢ Enter 30 seconds for the Settling time.
d Click OK.
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A vertical line should appear on the root-locus diagram, as shown in the
following figure.

) SIS0 Design Tool —|al x|
File Edit View Designs &nalysis Tools ‘Window Help ]

L xoz2n RN

Foot Locus Editar for Open-Loop 1 (0L1)
g T T 1

Imag Axis

-6 -4 -2 u] 2 4 5]
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Fight-click on the plots for mare design options.

Overshoot Design Requirement. The second design specification for this
example is to have a percentage overshoot of 10% or less. This specification is
related to the damping ratio on a root-locus diagram. In addition to adding a
design requirement with the Add new design requirement button, you can
also right-click directly on the design or analysis plots to add the requirement,
as shown next.

To add this design requirement:
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1 Right-click anywhere within the white space of the root-locus diagram in
the SISO Design Tool window. Select Design Requirements > New to
open the New Design Requirement dialog box.

2 Select Percent overshoot as the Design requirement type and enter 10
as the Percent overshoot.

3 Click OK to add the design requirement to the root-locus diagram. The
design requirement appears as two lines radiating at an angle from the
origin, as shown in the following figure.

) SIS0 Design Tool - ol x|
File Edit View Designs analysis Tools Window Help £

RS

Foot Locus Editor for Open-Loog 1 (0L

Imag &xiz

i 4 = o 7 4 B
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Rigjtt-click %the plots for maore design options.
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Rise Time Design Requirement. The third design specification for this
example is to have a rise time of 10 seconds or less. This specification is
related to a lower limit on a Bode Magnitude diagram.

To add this design requirement:

1 Select the Graphical Tuning pane in the SISO Design Task node of the
Control and Estimation Tools Manager.

2 For Plot 2, set Plot Type to Open-Loop Bode.

3 Right-click anywhere within the white space of the open-loop bode diagram
in the SISO Design Tool window. Select Design Requirements > New to
open the New Design Requirement dialog box.

4 Create a design requirement to represent the rise time and add it to the
new Bode plot:

a Select Lower gain limit from the Design requirement type menu.
b Enter 1e-2 to 0.17 for the Frequency range.

¢ Enter 0 to 0 for the Magnitude range.

d Click OK.

A Bode diagram appears within the SISO Design Tool window. The

magnitude plot of the Bode diagram includes a horizontal line representing
the design requirement, as shown in the following figure.
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Actuator Limit Design Requirement. The fourth design specification for
this example is to limit the actuator signal to within +£0.7. To add this design
requirement:

1 Select the Design requirements pane in the Response Optimization
node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button to open the New Design
Requirement dialog box.

3 Create a time-domain design requirement to represent the upper limit

on the actuator signal, and add it to a new step response plot in the LTI
Viewer:
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a Select Step response upper amplitude limit from the Design
requirement type menu.

b Select Closed Loop r to u from the Requirement for response
menu.

¢ Enter 0 to 10 for the Time range.
d Enter 0.7 to 0.7 for the Amplitude range.

e Click OK. A second step response plot for the closed loop response from
r to u appears in the LTI Viewer. The plot contains a horizontal line
representing the upper limit on the actuator signal.

f To extend this limit for all times (to =), right click on the black edge of
the design requirement, somewhere toward the right edge, and select
Extend to inf. The diagram should now appear as shown next.

LTI Yiewer for SISO Design Tool -0 x|
File Edit ‘Wwindow Help
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30 40 a0 &0 70 a0 a0
Time (sec)

Step Response
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LTI Wigweer ¥ Real-Time Update
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To add the corresponding design requirement for the lower limit on the
actuator signal:

1 Select the Design requirements pane in the Response Optimization
node of the Control and Estimation Tools Manager.

2 Click the Add new design requirement button to open the New Design
Requirement dialog box.

3 Create a time-domain design requirement to represent the lower limit on
the actuator signal, and add it to the step response plot in the LTI Viewer:

a Select Step response lower amplitude limit from the Design
requirement type menu.

b Select Closed Loop r to u from the Requirement for response
menu.

¢ Enter 0 to 10 for the Time range.
d Enter -0.7 to -0.7 for the Amplitude range.

e Click OK. The step response plot now contains a second horizontal line
representing the lower limit on the actuator signal.

f To extend this limit for all times (to =), right-click in the yellow shaded
area and select Extend to inf. The diagram should now appear as
shown in the following figure.
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Selecting the Design Requirements to Use During Response
Optimization. The design requirements give constraints on the dynamics
of the system and the values of response signals. The table in the Design
requirements tab lists all design requirements in the design and analysis
plots. Select the check boxes next to the design requirements you want to
use in the response optimization. This example uses all the current design
requirements.

Optimizing the System’s Response
After selecting the compensator elements to tune and adding design

requirements for the response signals to satisfy, you are ready to being the
response optimization.

The Optimization pane within the Response Optimization node of the
Control and Estimation Tools Manager displays the progress of the response
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optimization. The pane also contains options to configure the types of progress
information displayed during the optimization and options to configure the
optimization methods and algorithms.

To optimize the response of the system in this example, click the Start
Optimization button.

The Optimization pane displays the progress of the optimization, iteration
by iteration, as shown next. Termination messages from the optimization
method and suggestions for improving convergence also appear here.
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=
Constructing optimization problem... ;I

Optimization started 07-Aug-2008 10:07:44

Optimization finished 07-Aug-2008 10:07:53

Successful termination. Found a feasible or optimal solution within the specified
tolerances.

Export

\ L L

The optimized signals in the design and analysis plots appear as follows:
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Creating and Displaying the Closed-Loop System

After designing a compensator by optimizing the response of the system, you
can export the compensator to the MATLAB workspace, and create a model of

the full closed-loop system.

1 Within the SISO Design Tool window, select File > Export to open the

SISO Tool Export dialog box.

2 Select the compensator you designed, Compensator C, and then click

the Export to Workspace button.

At the command line, enter the following command to create the closed-loop
system, CL, from the open-loop transfer function, open_loopTF, and the

compensator, C:
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CL=feedback(C*open_loopTF,1)
This returns the following model:

Zero/pole/gain from input to output "Output":
-0.19414 (s-2)

(s"2 + 0.409s + 0.1136) (s"2 + 3.591s + 3.418)

To create a step response plot of the closed loop system, enter the following
command:

step(CL);

This produces the following figure:
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Designing Linear Controllers for Simulink Models

When you have Control System Toolbox and Simulink Control Design
software, you can perform frequency-domain optimization of Simulink models.

You can use Simulink Control Design software to configure SISO Design Tool
with compensators, inputs, outputs, and loops computed from a Simulink
model. For more information, see “Creating a SISO Design Task” in Simulink
Control Design documentation.

After you configure the SISO Design Tool, use Simulink Design Optimization
software to optimize the controller parameters of the linearized Simulink
model. For an example of optimization-based control design for a model
linearized using Simulink Control Design software, see “Tutorial — Designing
a PID Controller Using Optimization-Based Tuning” in the Simulink Design
Optimization getting Started Guide..

There is only one difference when tuning compensators derived from Simulink
Control Design software: The tuning of compensators from a Simulink
model is done through the masks of the Simulink blocks representing each
compensator. When selecting parameters to optimize, users can tune the
compensator in the pole, zero, or gain format, or in a format consistent with
the Simulink block mask as shown in the following figure. Changing the
compensator format is not possible when optimizing pure SISO Tool models
(those not derived using Simulink Control Design software).
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Lookup Tables

¢ “What Are Lookup Tables?” on page 5-2
¢ “Estimating Values of Lookup Tables” on page 5-5

e “Capturing Time-Varying System Behavior Using Adaptive Lookup Tables”
on page 5-37
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In this section...

“Static Lookup Tables” on page 5-2
“Adaptive Lookup Tables” on page 5-3

Static Lookup Tables

Lookup tables are tables that store numeric data in a multidimensional
array format. In the simpler two-dimensional case, lookup tables can be
represented by matrices. Each element of a matrix is a numerical quantity,
which can be precisely located in terms of two indexing variables. At higher
dimensions, lookup tables can be represented by multidimensional matrices,
whose elements are described in terms of a corresponding number of indexing
variables.

Lookup tables provide a means to capture the dynamic behavior of a physical
(mechanical, electronic, software) system. The behavior of a system with

M inputs and N outputs can be approximately described by using N lookup
tables, each consisting of an array with M dimensions.

You usually generate lookup tables by experimentally collecting or artificially
creating the input and output data of a system. In general, you need as
many indexing parameters as the number of input variables. Each indexing
parameter may take a value within a predetermined set of data points, which
are called the breakpoints. The set of all breakpoints corresponding to an
indexing variable is called a grid. Thus, a system with M inputs is gridded by
M sets of breakpoints. The software uses the breakpoints to locate the array
elements, where the output data of the system are stored. For a system with
N outputs, the software locates the N array elements and then stores the
corresponding data at these locations.

After you create a lookup table using the input and output measurements as
described previously, you can use the corresponding multidimensional array
of values in applications without having to remeasure the system outputs. In
fact, you need only the input data to locate the appropriate array elements in
the lookup table because the software reads the approximate system output
from the data stored at these locations. Therefore, a lookup table provides a
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suitable means of capturing the input-output mapping of a static system in
the form of numeric data stored at predetermined array locations. For more
information, see “About Lookup Table Blocks” in the Simulink documentation.

You can use Simulink Design Optimization software to estimate lookup table
values, as described in “Estimating Values of Lookup Tables” on page 5-5.

Adaptive Lookup Tables

Statically defined lookup tables, as described in “Static Lookup Tables” on
page 5-2, cannot accommodate the time-varying behavior (characteristics) of a
physical plant. Static lookup tables establish a permanent and static mapping
of input-output behavior of a physical system. Conversely, the behavior of
actual physical systems often varies with time due to wear, environmental
conditions, and manufacturing tolerances. With such variations, the static
mapping of input-output behavior of a plant described by the lookup table
may no longer provide a valid representation of the plant characteristics.

Adaptive lookup tables incorporate the time-varying behavior of physical
plants into the lookup table generation and maintenance process while
providing all of the functionality of a regular lookup table.

The adaptive lookup table receives the input and output measurements of a
plant’s behavior, which are then used to dynamically create and update the
content of the underlying lookup table. In addition to requiring the input data
to create the lookup table, the adaptive lookup table also uses the output
data of the plant to recalculate the table values. For example, you can collect
the output data of the plant by placing sensors at appropriate locations in a
physical system.

The software uses the input measurements to locate the array elements by
comparing these input values with the breakpoints defined for each indexing
variable. Next, it uses the output measurements to recalculate the numeric
value stored at these array locations. However, unlike a regular table, which
only stores the array data before the actual use of the lookup table, the
adaptive table continuously improves the content of the lookup table. This
continuous improvement of the table data is referred to as the adaptation
process or learning process.
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The adaptation process involves statistical and signal processing algorithms
to recapture the input-output behavior of the plant. The adaptive lookup
table always tries to provide a valid representation of the plant dynamics
even though the plant behavior may be time varying. The underlying signal
processing algorithms are also robust against reasonable measurement noise
and they provide appropriate filtering of noisy output measurements. To
learn more about how to model systems using adaptive lookup tables, see
“Capturing Time-Varying System Behavior Using Adaptive Lookup Tables”
on page 5-37.
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Estimating Values of Lookup Tables

In this section...

“How to Estimate Values of a Lookup Table” on page 5-5
“Example — Estimating Lookup Table Values from Data” on page 5-6

“Example — Estimating Constrained Values of a Lookup Table” on page
5-20

How to Estimate Values of a Lookup Table

You can use lookup table Simulink blocks to approximate a system’s behavior,
as described in “Working with Lookup Tables” in the Simulink documentation.
After you build your system using lookup tables, you can use Simulink Design
Optimization software to estimate the table values from measured I/0 data.

Estimating lookup table values is an example of estimating parameters
which are matrices or multi-dimensional arrays. The workflow for estimating
parameters of a lookup table consist of the following tasks:

1 Creating a Simulink model using lookup table blocks.

2 Importing the measured input and output (I/0) data from which you want
to estimate the table values.

3 Analyzing and preparing the I/O data for estimation.
4 Estimating the lookup table values.

5 Validating the estimated table values using a validation data set.
The following examples illustrate how to estimate the lookup table values:

¢ “Example — Estimating Lookup Table Values from Data” on page 5-6

¢ “Example — Estimating Constrained Values of a Lookup Table” on page
5-20
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Example — Estimating Lookup Table Values from
Data

® “Objectives” on page 5-6

e “About the Data” on page 5-6

¢ “Configuring a Project for Parameter Estimation” on page 5-6

¢ “Estimating the Table Values Using Default Settings” on page 5-8
® “Validating the Estimation Results” on page 5-15

Objectives
This example shows how to estimate lookup table values from time-domain
input-output (I/0) data.

About the Data

In this example, you use the I/O data in lookup_regular.mat to estimate the
values of a lookup table. The MAT-file includes the following variables:

® xdatal — Consists of 63 uniformly-sampled input data points in the range
[0,6.5].

¢ ydatal — Consists of output data corresponding to the input data samples.

e time1 — Time vector.

You use the I/O data to estimate the lookup table values in the
lookup_regular Simulink model. The lookup table in the model contains ten
values, which are stored in the MATLAB variable table. The initial table
values comprise a vector of 0s. To learn more about how to model a system
using lookup tables, see “Working with Lookup Tables” in the Simulink
documentation.

Configuring a Project for Parameter Estimation

To estimate the lookup table values, you must first configure a Control and
Estimation Tools Manager project.



Estimating Values of Lookup Tables

1 Open the lookup table model by typing the following command at the
MATLAB prompt:

lookup_regular

This command opens the Simulink model, and loads the estimation data

into the MATLAB workspace.

E!k:okup_regular _ 10l x|
File Edit View Simulation Format Tools Help

D=EH&S| fB2R|E= 4[5 & F =00 |[Nomal =l

D > 1

input ocutput

Lockup Table

To Weordkspaos1 To Weorkspacs

Ready [100% [ Jode45 v
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2 In the Simulink model, select Tools > Parameter Estimation to open a

new project named lookup_regular in the Control and Estimation Tools
Manager GUI.

=] Control and Estimation Tools Manager

=0l
File View Help
ERIECEl

{\ ‘Waorkspace r~Task settings
- Project - lookup_regular
= tio

Title:

ansient Data Subject:

|
|
Authar: |
I

Ea Validation Company:

Description:

Bl

Model: lookup_regular Open Model Update Task I

-
=l
Select the nodes below to configure and run estimations.

VA

Estimating the Table Values Using Default Settings

After you configure a project for parameter estimation, as described in
“Configuring a Project for Parameter Estimation” on page 5-6, use the
following steps to estimate the lookup table values.

1 Import the I/O data, xdatal and ydatatl, and the time vector, time1, into

the Control and Estimation Tools Manager GUI. For more information, see
“Importing Data into the GUI” on page 1-5.

You can also load a preconfigured project that already contains the imported
data. To do so, type the following command at the MATLAB prompt:

lookup_regular;
explorer.loadProject('lookup_regular_import',...
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'Project - lookup_regular',

'"Estimation Data');

5] control and Estimation Tools Manager =10l x|
File View Help
=hall=nc)
. workspace Input Data | Qutput Dat | State Data|
EG Project - lookup_reqular ~Assign data to blacks
=+ 2] Estimation Task - -
EI Transient Data Black Name I Data I Time | Ts I Weight I Length
stimation Data lookup_regularinput
3 variables Channel - 1 [ xdatal [ time1 [ 1 [ 63/63
+|-Leg Estimation
g validation
Impart... Pre-process... Plot Dats Clear all |
E
[
Select the tabbed panels ta configure the transient data set. &
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2 Run an initial simulation to view the I/O data, simulated output, and the

initial table values. To do so, type the following commands at the MATLAB
prompt:

sim('lookup_regular')
figure(1); plot(xdatatl,ydatatl, 'm*', xout, yout,'b"')
hold on; plot(linspace(0,6.5,10), table, 'k', 'LineWidth', 2)

il x4
File Edit View Insert Tools Deskiop Window Help £
Ddde b ARRAOD9DLEL -2/ 0R | a0

15 T T T T

The x- and y-axes of the figure represent the input and output data,
respectively. The figure shows the following plots:

¢ Measured data — Represented by the magenta stars (¥).
¢ Initial table values — Represented by the black line.
e Initial simulation data — Represented by the blue deltas (A).

3 Select the table values to estimate.

a In the Control and Estimation Tools Manager GUI, select the Variables
node under the Estimation Task node.
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b Click Add to open the Select Parameters dialog box, which shows the
Simulink model parameters.

¢ Select table, and click OK to add the table values to the Estimated
Parameters tab.

=] Control and Estimation Tools Manager N =] 3}
Fie View Help
-
ERaN ==
[ workspace Estimated Parameters | Estimated States |
28] Praject - loolap_regular ~Selected parameter ~Default setting
Sl e e
{77 Transient Data LB
= 1] Estimation Data Value: [0000000000]
Variables Initial guess: ~ |table
Estimation . . -
g validation inimum: Jn
Maximum: [+Inf

Typical valus: |table

Referenced by:

lookup_regular/Tookup Table |

Delete j

s L Ll

Select the tab panels to configure your estimation parameters and states.

The Default settings area of the GUI displays the default settings
for the table values. The Value field displays the initial table values,
which comprise a vector of ten Os.

d Select the Estimation node, and click New to add a New Estimation
node.
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e Select the New Estimation node. In the Parameters tab, select
the Estimate check box to specify the lookup table values, table, for

estimation.

E! ‘Control and Estimation Tools Manager i =] 3]
File View Help
g0 (S d|

4:\ Workspace Data Sets Parameters I States I Estimat\onl

- W Project - lookup_regular

¥ Estimation parameters
- B8] Estimation Task

£ [ Transient Data Name Valug Initial Guess IMinimum Maximum | Typical Valug
Eﬁ] Estimation Data [00DO0DD. table +Inf table

b Variables

=] Estimation
E@ Mew Estimation
Ea Vigws

Ea Validation

Use Value as Initial Guess Reset bo Default Settings Save as Default Settings |
- New Estimation nade has been added to Estimation, il
- Mew View node has been added to Views.
[
Select the tab panels to configure your estimation. v
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4 In the Data Sets tab of the New Estimation node, select the Selected

check box to specify the estimation data set.

il
File View Help
S50[S | |[[E
‘4 Workspace Data Sets I Parametersl States I Estimat\onl
=W Praject - lookup_regular rData sets used for estimation rOutput data weights
E|- Estimation Task - — =
Transient Daka I Transient estimation j Block Mame I Length I Weight
E -[j,%i] Estimation Data e e _regularowtput
Variables Channel-1 [ &3l63 | 1
B % Estimation stimation Data

Select Al | Clear all

- Mew Estimation node has been added ta Estimation.
- Mew View node has been added to Views,

Select the tab panels ko configure your estimation.

s L

5 Estimate the table values using the default settings.

5-13



5 Lookup Tables

5-14

a In the Estimation tab of the New Estimation node, click Start to

start the estimation.

The Control and Tools Manager GUI updates at each iteration, and
provides information about the estimation progress. After the estimation
completes, the Control and Estimation Tools Manager GUI looks similar
to the following figure.

E! ‘Control and Estimation Tools Manager -0l x|

File View Help

=
S50[S W |[E
ﬂ Workspace Data Sets | Parameters | States Estimation |
E“ Project - lookup_regular imation progr
E|" stimation Task
T Transient Data Iteration Function Co...| Cost Function Step Size Procedure Estimation Options... |
~.[14] Estimation Dat: [| |2 1 33.84 L |
Variables 1 2 0.18337 2.1675 Display Optios. .. |
—I-{ g} Estimation

By New Estimatior

[ views
Validation Start |

I~ Show progress views

Performing transient estimation... Bl
Active experiments: Estimation Data

Estimated parameters: table

Local minimum found.
Optimization completed because the size of the gradient is less
than the selected value of the function tolerance.

dl | 2]
Iteration 1 complete
Estimation completed.

s 13

Select the tab panels to configure your estimation.




Estimating Values of Lookup Tables

b Select the Parameters tab in the New Estimation node to view the
estimated table values, which appear in the Value field.

E! ‘Control and Estimation Tools Manager =] 3]

File View Help
&G0 (S aA|E

‘4 Warkspace Data Sets Parameters | Stakes | Estimation |
=Tl Project - lockup_ragular
(=31 Estimation Task

E" Transient Data Mame Valuz Estimate Initial Guess Minimurm Maximur
'----[j,%i] Estimation Data table table
Variables
E| Estimation
B@ Mew Estimation
[E Views
Ea Validation

Estimation parameters

1 | ol

Use Value as Initial Guess Reset to Default Settings Save as Default Settings |

]

Iteration 1 complete
Estimation completed.

4

Select the tab panels ta configure your estimation.

RN

Validating the Estimation Results

After you estimate the table values, as described in “Estimating the Table
Values Using Default Settings” on page 5-8, you must use another data set to
validate that you have not overfitted the model. You plot and examine the
following plots to validate the estimation results:

® Residuals plot

¢ Measured and simulated data plots

To validate the estimation results:
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1 Import the validation I/O data, xdata2 and ydata2, and time vector, time2,
in the Control and Estimation Tools Manager GUI.

You can also load a project that already contains the estimated parameters,
and the validation data set. To do so, type the following commands at the

MATLAB prompt:

lookup_regular;

explorer.loadProject('lookup_regular_val',...
'Project - lookup_regular',

E! Control and Estimation Tools Manager

'Validation Data');

=100 x]
File View Help
=
&5 0[S |
. worlspace Input Data | Qutput Data | State Data |
B G Project - lookup_regular ~Assign data to blacks
-] Estimation Task - -
B iﬁ; Transient Data Block Mame | Data | Time | Ts | Weight Length
| Estimation Data lookup_regularinput
I hE Charnel - 1 [ xdata2 [ time2 I 1 63/63
Variables
Estimation
Ea Validation
Import. .. Pre-process. .. Plot Data Clear all |
4
[
Select the tabbed panels to configure the transient data set. v

This project also contains the Residuals plot already configured in the
Select plot types area of the GUI, as shown in the next figure. For more
information on how to configure this plot, see “Performing Validation”

on page 2-43.
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E! Control and Estimation Tools Manager =] 3]
File Wiew Help

s il Y = = N )

(l Wiorkspace alidation Setup I
=- Mgl Project - lookup_reqular
E|- Estimation Task.

~Select plok bype:

Transiert Data Flok Murnber Flok Type Plat Title
i E] Estimation Data Flot 1 Residuals |
1] walidation Diata Plot 2 (none) a3
‘ariables Flot 3 (none)
Estimation Flot 4 (none)
Plot 5 (none)
Plot & (none)
~Opkion:
validation data set: | Estimation Data =l
Estimation | Plat 1 |
Mew Estimation | [cd |

Show Plots |

s L

Configure validation plats.

2 Plot and examine the residuals:

a Select the New Validation node under the Validation node.
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set drop-down list.

E! ‘Control and Estimation Tools Manager

b In the Options area, select Validation Data from the Validation data

=10 x|
File View Help
ﬂ Workspace Validation Setup I
=- gl Project - lookup_ragular ~Select plot types
(=[] Estimation Task
[T} Transient Data Plok Mumber Plok Type Plat Title
Variables Plok 1 Residuals

Estimation Plat 2 none)

E@ Mew Estimation Plot 3 nang)

] Ea Views Plat 4 none)

=1-Lg validation Plot 5 none)

@ Mew Validation Plot & none)

~Option
Validation data set:  |[SiUENLIOEE]
Estimation Data |
Estimation
Mew Estimation v
Show Plats |

e
[
Configure validation plats. y
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¢ Click Show Plots to open the residuals plot.

) New Validation - Plot 1 (Residuals) : i m] 4
File Edit View Insert Tools Deskiop Window Help ]
NS KRR De L 2|08 a0
Residuals
Walidation Data
0.2 T T T T T T T T T
015 -
01r B
0.05 B
= 5
o u -
£ 3
005} -
01 r B
015} .
_02 1 1 1 1 1 1 1 1 1
0 1 2 3 4 5 [ ¥ 3 9 10
Time (sec)

The residuals, which show the difference between the simulated
and measured data, lie in the range [-0.15,0.15]— within 15% of the
maximum output variation. This indicates a good match between the
measured and the simulated table data values.

5-19



5 Lookup Tables

d Plot and examine the estimated table values against the validation data

set and the simulated table values by typing the following commands
at the MATLAB prompt.

sim('lookup_regular')
figure(2); plot(xdata2,ydata2, 'm*', xout, yout,'b"')
hold on; plot(linspace(0,6.5,10), table, 'k', 'LineWidth', 2)

=lolx|
A

File Edit View Insert Tools Deskiop Window Help

Qo de

%|+'\- '\W@@£'|@|D@|DE

15

051

0

The plot shows that the table values, displayed as the black line, match
both the validation data and the simulated table values. The table data
values cover the entire range of input values, which indicates that all
the lookup table values have been estimated.

Example — Estimating Constrained Values of a
Lookup Table

® “Objectives” on page 5-21
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e “About the Data” on page 5-21
e “Configuring a Project for Parameter Estimation” on page 5-21

¢ “Estimating the Monotonically Increasing Table Values Using Default
Settings” on page 5-24

e “Validating the Estimation Results” on page 5-31

Objectives

This example shows how to estimate constrained values of a lookup table. You
apply monotonically increasing constraints to the lookup table values, and
use the GUI to estimate the table values.

About the Data

In this example, you use lookup_increasing.mat, which contains the
measured /O data for estimating the lookup table values. The MAT-file
includes the following variables:

e xdatal — Consists of 602 uniformly-sampled input data points in the
range [-5,5].

e ydatal — Output data corresponding to the input data samples.

Note The output data is a monotonically increasing function of the input
data.

e time1 — Time vector.

You use the I/0 data to estimate the values of the lookup table in the
lookup_increasing Simulink model. The table contains eleven values, which
are stored in the MATLAB variable table. To learn more about how to
specify the table’s values, see “Entering Breakpoints and Table Data” in the
Simulink documentation.

Configuring a Project for Parameter Estimation

To estimate the monotonically increasing lookup table values, you must first
configure a Control and Estimation Tools Manager project.
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1 Open the lookup table model by typing the following command at the
MATLAB prompt:

lookup_increasing

This command opens the Simulink model, and loads the estimation data
in the MATLAB workspace.

E! lookup_increasing _ 10l x|
File Edit View Simulation Format Tools Help
D=EH&S| fB2R|E= 4[5 & F =00 |[Nomal =l

o >
input output

Lockup Table
44 xout ‘ yout
To Weordspacs1 To Weorkspacs
Ready [100% [ Jode45 v
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2 Double-click the Lookup Table block to view the monotonically increasing
constraint applied to the table output values.

=] Function Block Parameters: Lookup Table x|

Lookup
’7Perﬁurm 1-D linear interpolation of input values using the specified table.

Extrapolation is performed outside the table boundaries.

Main | Signal Attributes |

Vector of input values: I [-5:5] Edit... |

Table data: | al=Rnlien =)

Lookup method: IInherpoIaﬁon-ExtrapoIaﬁon ;I

Sample time (-1 for inherited): I -1

CK I Cancel | Help | Apply |

The Table data field of the Function Block Parameters dialog box
shows the constraint. The cumulative sum function, cumsum, applies a
monotonically increasing constraint on the table output values. This
function computes the cumulative sum of the table values based on
estimation of the individual table elements from the I/O data.
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3 In the Simulink model, select Tools > Parameter Estimation to open a

new project named lookup_increasing in the Control and Estimation
Tools Manager GUI.

E! ‘Control and Estimation Tools Manager =] 3]
File View Help
=1 N =N
ﬂ Waorkspace rTask setting:
=gl Project - lookup_incraasing Title: I
ER
Subject: |
Authar: |
Company: I
Description: ;I
=
Madel: laolup_increasing Open Madel Update Task |
2

[
Z

Select the nodes below ko configure and run estimations.

Estimating the Monotonically Increasing Table Values Using
Default Settings

After you configure a project for parameter estimation, as described in
“Configuring a Project for Parameter Estimation” on page 5-21, use the
following steps to estimate the constrained lookup table values:

1 Import the estimation data, as described in the “Importing Data into the

GUT” section of “Tutorial — Preparing Data for Parameter Estimation
Using the GUT”.
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You can also load a preconfigured project that already contains the imported
data. To do so, type the following commands at the MATLAB prompt:

lookup_increasing;
explorer.loadProject('lookup_increasing_import',...
'Project - lookup_increasing', 'Estimation Data')

E! ‘Control and Estimation Tools Manager

~ol |
File View Help
5 0S|
Q Warkspace Input Data I Qutput Datal State Daka |
=gl Project - lookup_incraasing ~Assign data to blacks
E|- Estimation Task
T Block Name I Data I Time | Ts | ‘Weight I Length
; _increasing/input
.3 varisbles Channel - 1 [ xdatal [ time1 [ 1 [ 602602
[#-L g Estimation
Ea WValidation
Import. .. Pre-process. .. Flot Data Clear all |
E
[
Select the tabbed panels ta configure the transient data set. 4
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2 Run an initial simulation to view the measured data, simulated table

values and the initial table values by typing the following commands at
the MATLAB prompt:

sim('lookup_increasing')
figure(1); plot(xdatal,ydatatl, 'm*', xout, yout,'b"')
hold on; plot(-5:5, cumsum(table), 'k', 'LineWidth', 2)

ioix
.

Fil= Edit View Insert Tools Desktop Window Help

Odde | |[RRXO9E L -

2|0EB 8O0

100 T T T T

50+

-50
-5

The x- and y-axes represents the input and output data, respectively. The
figure shows the following plots:

¢ Measured data — Represented by the magenta stars (¥).

Note As described in “About the Data” on page 5-21, the output data is
a monotonically increasing function of the input data.

¢ Initial table values — Represented by the black line.
e Initial simulation data — Represented by the blue deltas (A).
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3 Select the table output values to estimate.

a In the Control and Estimation Tools Manager GUI, select the Variables
node under the Estimation Task node.

b Click Add to open the Select Parameters dialog box, where you see the
Simulink model parameters.

¢ Select table, and click OK to add the table values to the Estimated
Parameters tab.

E! Control and Estimation Tools Manager ] 3]

File View Help
&5 0(S a|E

ﬂ:\ Waorkspace Estimated Parameters | Estimated Statesl
- M| Project - lookup_inereasing

B2 1] Estimation Task ~Selected parameters ~Defaulk settings
E=1] Estimation Tasl
0 B%E] Estimation Data Walue: 5% 3-2-1012345]
%V&riahles Initial guess: Itable
Estimation »
Ea Validation A I-InF
Maximum: |+Inf

Typical value: |tab|e

Referenced by:

lookup_increasingTookup Table ]

Delete | LI

x 1

Select the tab panels to configure your estimation parameters and states.

The Default settings area of the GUI displays the default settings for
the table values. The Value field displays the initial table values.

d Select the Estimation node, and click New to add a New Estimation
node.
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e Select the New Estimation node. In the Parameters tab, select
the Estimate check box to specify the lookup table values, table, for

estimation.

E! Control and Estimation Tools Manager

File View Help

I [=[ 3]

G0 (S ||

4:\ Warkspace Data Sets Parameters | States | Estimation |

B G Praject - lockup_increasing ~Estimation parameters

1B Estimation Task

=] iﬁ; Transient Data S Value
[},53] Estimation Data

b Variables
=] Estimation

E@ Mew Estimation

Ea Views

Ea Validation

Use Value as Initial Guess

Initial Guess Winimum Maximum Typical Value
table -Inf +1Inf

Reset bo Default Settings

table

Save as Default Settings |

- New Estimation nade has been added to Estimation,

Select the tab panels to configure your estimation.

4
=

4

B
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4 In the Data Sets tab of the New Estimation node, select the Selected
check-box to specify the estimation data set.

E! ‘Control and Estimation Tools Manager =] 3]

File View Help

=
G508 | |[[E
ﬂ Workspace Data Sets I Parameters | Statesl Estimation I
=W/ Project - lookup_increasing | pata sets used for estimation ~Output data weights
E|- Estimation Task - —
Transient Daka I Transient estimation ;I Black Name | Length I ‘Weight
: -[j,%i] Estimation Data locted _incr i
Varizbles S5 =ick S Chamnel-1 | eozjenz | 1
B Estimation Estimation Data

Select Al | Clzar all

- Mew Estimation node has been added to Estimation.

s L

Select the tab panels ko configure your estimation,

5 Estimate the parameters using the default settings.
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a In the Estimation tab of the New Estimation node, click Start to
start the estimation.

The Control and Tools Manager GUI updates at each iteration, and
provides information about the estimation progress. After the estimation
completes, the Control and Estimation Tools Manager GUI looks similar
to the following figure.

=] Control and Estimation Teols Manager —|of x|
File View Help
S0 dE
ﬂ.‘k\"iurhpacﬁ Data Sets | Parameters | States Eshmaﬁuﬂ|
= 8| Project - lookup_increasing T
(-] Estimation Task
21 [ Transient Data Iteration | Function C... | Cost Function| Stepsize | Procedure Estimation Options... |
4] Estimation Data ] 1 1.8596e+006 |1 o
Variables 1 2 7.6008e+005 (10 Display Options...
21l Estmation 2 3 L146e+005 |20
- Ep New Estimation 3 [+ 9780.4 [42.85
3 views

3 Vo

ﬂ I~ Show progress views

Performing transient estimation... &l
Active experiments: Estimation Data
Estimated parameters: table

Local minimum found.
Optimization completed because the size of the gradient is less
than the selected value of the function tolerance.

[

o
Tteration 3 complete
IEstimation completed,

L b

Select the tab panels to configure your estmation.
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b Select the Parameters tab of the New Estimation node to view the

estimated table values. The Value field displays the estimated table
values.

E! Control and Estimation Tools Manager

~=ol =]
File View Help
850G a|E

ﬂ Workspace Data Sets Parameters | States | Estimation |

- M| Project - lookup_inereasing

(1 E) Estimation Task
B ransient Data MName Valug Estimate Initial Guess
Pt EE] Estimation Data

Variables

=] Estimation

E@ Mew Estimation

Ea Views

Ea Validation

~Estimation parameters

Minimum Maximum | Typic

4

| ©
Use Value as Initial Guess Reset bo Default Settings Save as Default Settings |
Ireration 1 completz ;I
Estimation completed.
-
Select the tab panels to configure your estimation. v

Validating the Estimation Results

After you estimate the table values, as described in “Estimating the
Monotonically Increasing Table Values Using Default Settings” on page 5-24,
you must use another data set to validate that you have not overfitted the

model. You plot and examine the following plots to validate the estimation
results:

® Residuals plot

e Measured and simulated data plots

To validate the estimation results:
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1 Import the validation I/O data, xdata2 and ydata2, and time vector, time2,

in the Control and Estimation Tools Manager GUI.

You can load a project that already contains the estimated parameters,
validation data set, and residuals plot. To do so, type the following
commands at the MATLAB prompt:

lookup_increasing;
explorer.loadProject('lookup_increasing_val',...
'Project - lookup_increasing', 'Validation Data')

E! Control and Estimation Tools Manager

=100 x]
File View Help
=
S50 (S ||
. worlspace Input Data | Qutput Data | State Data |
B G Project - lookup_increasing ~Assign data to blacks
-] Estimation Task - -
B nsient Data Block Name | Data | Time | Ts | Weight | Length
. ] Estimation Data lookup_incr finput
: bvalidation Data Channel - 1 [ xdata2 [ time2 [ 1 [ 602/602
riables
Estimation
=] Ea WValidation
H @ Mew Validation
Import. .. Pre-process. .. Plot Data Clear all |
4
[
Select the tabbed panels to configure the transient data set. v

This project also contains the Residuals plot already configured in the

Select plot types area of the GUI, as shown in the next figure. For more

information on how to configure this plot, see “Performing Validation”
on page 2-43.
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E! Control and Estimation Tools Manager =] 3]

File Wiew Help

s il Y = = N )

{\ Wiorkspace alidation Setup I
=- Mgl Project - lookup_increasing
E|- Estimation Task.

~Select plok bype:

Transiert Data Flok Murnber Flok Type Plat Title
+..[141] Estimation Data Plot 1 Residuals N
E] Validation Data Plot 2 (none) 3
‘ariables Flot 3 (none)
Estimation Flot 4 (none)
Plot 5 (none)
Plot & (none)
~Opkion:
validation data set: | Estimation Data =l
Estimation | Plat 1 |
Mew Estimation | [cd |

Show Plots |

s L

Configure validation plats.

2 Plot and examine the residuals.

a Select the New Validation node under the Validation node.
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set drop-down list.

E! ‘Control and Estimation Tools Manager

b Inthe Options area, select Validation Data from the Validation data

=10 x|
File View Help
@ Workspace Validation Setup I
=1l Project - lookup_increasing ~Select plot types
(=[] Estimation Task :
[T} Transient Data Plok Mumber Flok Type Plak: Title
Variables Plot 1 Residuals

Estimation Plat 2 none)

E@ Mew Estimation Plot 3 nong)

] Ea Views Plat 4 none)

=1-Lg validation Plot 5 nane)

@ ew Validation Flot & nong)

~Option
Validation data set: | Estimation Data =l
Estimation Data |
Estimation
New Estimation v
Show Plats |

e
[
Configure validation plats. y
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¢ Click Show Plots to open the residuals plot.

W=
File Edit View Insert Tools Deskiop Window Help ]
OCde bR DEL- 20880
Residuals
New Data
20 T T T T T T T T T
15 -
10 B
c I
52 |
[= 8 u |
E3
=10 B
5k _
_20 1 1 1 1 1 1 1 1 1
0 1 2 % 4 5 [ 7 3 9 10
Time (sec)

The residuals, which show the difference between the simulated and
measured data, lie the range [-15,15]— within 20% of the maximum
output variation. This indicates a good match between the measured
and the simulated table data values.
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3 Plot and examine the validation data, simulated data and estimated table
values.

sim('lookup_increasing')
figure(2); plot(xdata2,ydata2, 'm*', xout, yout,'b"')
hold on; plot(-5:5, cumsum(table), 'k', 'LineWidth', 2)

ol
File Edit View Insert Tools Deskiop Window Help ]
AEE R A EREEE
100 T T T T T
501 B
ok 4
-50
-5 6

The plot shows that the table values, shown as the black line, match both
the measured data and the simulated table values. The table data values
cover the entire range of input values, which indicates that all the lookup
table values have been estimated.
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Capturing Time-Varying System Behavior Using Adaptive
Lookup Tables

In this section...
“Building Models Using Adaptive Lookup Table Blocks” on page 5-37

“Configuring Adaptive Lookup Table Blocks” on page 5-41

“Example — Modeling an Engine Using n-D Adaptive Lookup Table” on
page 5-44

“Using Adaptive Lookup Tables in Real-Time Environment” on page 5-60

Building Models Using Adaptive Lookup Table Blocks

Simulink Design Optimization software provides blocks for modeling systems
as adaptive lookup tables. You can use the adaptive lookup table blocks to
create lookup tables from measured or simulated data. You build a model
using the adaptive lookup table blocks, and then simulate the model to adapt
the lookup table values to the time-varying I/0O data. During simulation,

the software uses the input data to locate the table values, and then uses
the output data to recalculate the table values. The updated table values
are stored in the adaptive lookup table block. For more information, see
“Adaptive Lookup Tables” on page 5-3.

The Adaptive Lookup Table library has the following three blocks:

e Adaptive Lookup Table (1D Stair-Fit) — One-dimensional adaptive lookup
table

e Adaptive Lookup Table (2D Stair-Fit) — Two-dimensional adaptive lookup
table

e Adaptive Lookup Table (nD Stair-Fit) — Multidimensional adaptive lookup
table

Note Use the n-D Adaptive Lookup Table block to create lookup tables of
three or more dimensions.
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To access the Adaptive Lookup Tables library:
1 Type the following command at the MATLAB prompt:

sdolib

The Simulink Design Optimization library opens as shown in the next
figure.

S Library: sdolib =10l

File Edit View Format Help

DSHE +BR|e 4|2 hnE D

Simulink Design Optimization

Design
RKS Optimization
Blocks Demos

Signal Constraint

Attach this block to Usa thess blocks to Double click_on thi block
the signaks to be constmined build signal ensmy . to =28 available demos
in your SIMULINK mads! constraints Adaptive Lookup Tables
Ready 100% Locked v

2 Double-click the Adaptive Lookup Tables block to open the Adaptive
Lookup Tables library, as shown in the next figure.
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E! Library:sdolib/Adaptive Lookup Tables - |E||ﬂ
File Edit View Format Help
DSHE BB (¢ 4|2 cnEE|
Adaptive Lookup Tables
1-0 Tiu) 2-D T(u) n-0 T{u)
u _ u _ ¥ u
s i
¥ Y N Y
Adaptive Lookup Adaptive Lookup Adaptive Lookup
Table (1D Stair-Fit) Table (2D Stair-Fit) Table (nD Stair-Fit)
Ready [100% |Locked v

By default, the Adaptive Lookup Table blocks have two inputs and outputs

as shown in the next figure.

2D T(u)

Adaptive Lookup
Table (2D Stair-Fit)

You can display additional inputs and outputs in a block by selecting the

corresponding options in the Function Block Parameters dialog box. To learn

more about the options, see Chapter 8, “Block Reference”.
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u 2.0 Tiu) o
ki

Tin M B
Enahlel

Lock Tout p

Adaptive Lookup
Table (20 Stair-Fit)

Adaptive Lookup Table Block Showing Inputs and Outputs
The 2-D Adaptive Lookup Table block has the following inputs and outputs:

¢ yand y — Input and output data of the system being modeled, respectively

For example, to model an engine’s efficiency as a function of engine rpm
and manifold pressure, specify u as the rpm, y as the pressure, and y as
the efficiency signals.

® Tin — The initial table data

® Enable — Signal to enable, disable, or reset the adaptation process
® Lock — Signal to update only specified cells in the table

e y — Value of the cell currently being adapted

¢ N — Number of the cell currently being adapted

® Tout — Values of the adapted table data

For more information on how to use adaptive lookup tables, see “Example —
Modeling an Engine Using n-D Adaptive Lookup Table” on page 5-44.

A typical Simulink diagram using an adaptive lookup table block is shown in
the next figure.
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-ioix
File Edit WYiew Simulation Format Tools Help
D& L BB|c 4 [0 50| [Nomal [=| =
Experimental Data Adaptive Table Outputs
. " 2.0 T

Cell Number

1 Q
. % Enable Tout

NOT Adapted Table Values
Adaptive Lookup
Table (D Stair-Fit)

Ready 100% FixedStepDiscrete
4

Simulink® Diagram Using an Adaptive Lookup Table

In this figure, the Experiment Data block imports a set of experimental data
into Simulink through MATLAB workspace variables. The initial table is
specified in the block mask parameters. When the simulation runs, the initial
table begins to adapt to new data inputs and the resulting table is copied

to the block’s output.

Configuring Adaptive Lookup Table Blocks

® “Setting Adaptive Lookup Table Parameters” on page 5-41
e “Selecting an Adaptation Method” on page 5-42

Setting Adaptive Lookup Table Parameters

You can configure the Adaptive Lookup Table parameters in the Function
Block Parameters dialog box. Double-click the block to open the dialog box
shown in the next figure.

5-41



5 Lookup Tables

5-42

=] Function Block Parameters: Adaptive Lookup T3 x|

— &daptive Lookup T able (D] [mazk] [link)

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data iz uzed to dwnamically update the cell walues at
these locations.

r— Parameter

Mumber of table dimensions:
|21 Adaptive lookup
table dimensions

T able breakpoints [cell aray]:

I{[-ID 22.31,40), [10,22,31,40 BlOCk Input values for Input
- variables

[~ Make initial table an input
T able data (initial):
f[4 561615 20,10 16 23] Initial table output values

T able numbering data:

23456789 Number values assigned to cells
Adaptation method: ISampIe mean [with forgetting) :! Algorithm for adaptation
Adaptation gain (0ta 1)

[E - Assign weight to new data

™ Make adapted table an output

[ Add adaptation enable/disable/reset port

[~ Add cell lock enable/disable port Customize block I/O channels
Action bar out-of-range input || grare ﬂ Allow adaptation for out-of-range

data

Ok I Cancel | Help Apply

n-D Adaptive Lookup Table Dialog Box

For details on how to set these parameters, see the individual Chapter 8,
“Block Reference” pages.

Selecting an Adaptation Method

You can select an adaptation algorithm from the Adaptation Method
drop-down list in the Function Block Parameters dialog box. This section
discusses the details of these algorithms.
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Sample Mean. Sample mean provides the average value of n output data
samples and is defined as:

NOEES Y0
=

where y(i) is the i* measurement collected within a particular cell. For each
input data u, the sample mean at the corresponding cell is updated using
the output data measurement, y. Instead of accumulating n samples of data
for each cell, a recursive relation is used to calculate the sample mean. The
recursive expression is obtained by the following equation:

n-1 _ n-1 —1A
y(n) = llz y(i)+y(n)] = n_l[ 1 2y(i)]+ly(n) =n—1y(n—1)+ly(n)
n n n n n

i=1 n-1:3
where y(n) is the nt* data sample.

Defining a priori estimation error as e(n) = y(n)— y(n—1), the recursive
relation can be written as:

y(n) =yn-1)+ %e(n)

where n >1 and the initial estimate 3/(0) is arbitrary.

In this expression, only the number of samples, n, for each cell— rather than
n data samples—is stored in memory.

Sample Mean with Forgetting. The adaptation method “Sample Mean”
on page 5-43 has an infinite memory. The past data samples have the same
weight as the final sample in calculating the sample mean. Sample mean
(with forgetting) uses an algorithm with a forgetting factor or Adaptation
gain that puts more weight on the more recent samples. This algorithm
provides robustness against initial response transients of the plant and an
adjustable speed of adaptation. Sample mean (with forgetting) is defined
as:
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y(n) = ;Zx”—i (@)

2?:1 M i

n-1 . 1)
S S o Y ] e W S o)
27—1 y Rl o s(n) s(n)

where Ae [0,1] is the Adaptation gain and s(k) = Zleln_i .

Defining a priori estimation error as e(n) = y(n)— &(n —1), where n>1 and

the initial estimate 3/(0) is arbitrary, the recursive relation can be written as:

1-A

7\‘71

e(n)

y(n)=y(n-1)+ Le(n) =y(n-1+
s(n)

A small value of A results in faster adaptation. A value of 0 indicates short
memory (last data becomes the table value), and a value of 1 indicates long
memory (average all data received in a cell).

Example — Modeling an Engine Using n-D Adaptive
Lookup Table

® “Objectives” on page 5-44
e “About the Data” on page 5-45
¢ “Building a Model Using Adaptive Lookup Table Blocks” on page 5-45

® “Adapting the Lookup Table Values Using Time-Varying I/O Data” on page
5-57

Objectives

In this example, you learn how to capture the time-varying behavior of an
engine using an n-D adaptive lookup table. You accomplish the following
tasks using the Simulink software:
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® Configure an adaptive lookup table block to model your system.

® Simulate the model to update the lookup table values dynamically.
e Export the adapted lookup table values to the MATLAB workspace.
® Lock a specific cell in the table during adaptation.

® Disable the adaptation process and use the adaptive lookup table as a
static lookup table.

About the Data

In this example, you use the data in vedata.mat which contains the following
variables measured from an engine:
® X — 10 input breakpoints for intake manifold pressure in the range [10,100]
e Y — 36 input breakpoints for engine speed in the range [0,7000]
® Z — 10x36 matrix of table data for engine volumetric efficiency

To learn more about breakpoints and table data, see “Anatomy of a Lookup

Table” in the Simulink documentation.

The output volumetric efficiency of the engine is time varying, and a function
of two inputs—intake manifold pressure and engine speed. The data in the
MAT-file is used to generate the time-varying input and output (I/0) data for
the engine.

Building a Model Using Adaptive Lookup Table Blocks
In this portion of the tutorial, you learn how to build a model of an engine
using an Adaptive Lookup Table block.

1 Open a preconfigured Simulink model by typing the model name at the
MATLAB prompt:

enginetablei_data

The Experimental Data subsystem in the Simulink model generates
time-varying I/0 data during simulation.
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E! enginetablel_data ;lﬂlll

File Edit View Simulaton Format Tools Help

OSR&E| + 28| 4|22 > =0 | [Nm =]

Experiments| Data

u

Ready [100% [ [ |ode4s v

This command also loads the variables X, Y and Z into the MATLAB
workspace. To learn more about this data, see “About the Data” on page
5-45.

2 Add an Adaptive Lookup Table block to the Simulink model.

a Open the Simulink Design Optimization library by typing the following
command at the MATLAB prompt:

sdolib

E}Librarv: sdolib ;Iglil

File Edit View Format Help

D& i=r(ecs |0 raE

Simulink Design Optimization

Design
RMS Optimization
Blocks Demos

Signal Constraint

: Uss thess blocks to Double click on this block
Attach this block to o ese availabls demos

i . buid signal enemgy
"'i: :f:':’;m'ﬁ"c: ':i:e""sd constraints Adaptive Lookup Tabks

Ready 100% Locked &
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b Double-click the Adaptive Lookup Tables block to open the Adaptive
Lookup Tables library.

E! Library:spelookup =10l xl

File Edit Yew Format Help

Adaptive Lookup Tables

1-D Tiu) 20 T
u b u b u ¥
Y il W M y M
Addaptive Lookup Adaptive Lookugp Adaptive Lookup
Table (10 Stair-Fit) Tahle (20 Stair-Fit) Tahle (nD Stair-Fit)

Simulink Parameter Estimation 1.0
Copyright (o] 2001-2004 The MathWorks, Inc.

Simulink Design Optimization software provides three Adaptive Lookup
Table blocks. In this example, you use the Adaptive Lookup Table (nD
Stair-Fit) block to model your system. To learn more about the blocks,
see Chapter 8, “Block Reference”.

¢ Drag and drop the Adaptive Lookup Table (nD Stair-Fit) block from the
Simulink Design Optimization library to the Simulink model window.
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=loix|
File Edit View Simulaton Format Tools Help
DS BB 4 [ 2E b =1oo | [nma =

Experiments| Data

u

Adaptive Lookup
Table (nD Stair-Fit)

Ready [100% [ [ |ode4s i

3 Double-click the Adaptive Lookup Table (nD Stair-Fit) block to open the
Function Block Parameters: Adaptive Lookup Table (nD Stair-Fit) dialog
box.
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E! Function Block Parameters: Adaptive Lookup Ta

—Adaptive Lookup Table (nD) {mask) (link)

b |x

Perform adaptive table lookup. Breakpaints relate the coordinate inputs to
cell locations in the table. The data is used to dynamically update the cell
values at these locations.

—Parameters
Mumber of table dimensions:

Table breakpoints (cell array):

| {[10,22,31,40], [10,22,31,40]}

I~ Make initial table an input
Table data (initial):

|[456,' 16 19 20;10 18 23]

Table numbering data:

[[123; 456,789

Adaptation method: ISampIe mean (with forgetting) ;I
Adaptation gain (0 to 1):
jo.g

[~ Make adapted table an output
I~ Add adaptation enable/disable reset port

[ Add cell lock enable/disable port —

Action for out-ofrange input |Ign0re ;I

OK I Cancel | Help | Apply |

4 In the Function Block Parameters dialog box:
a Specify the following block parameters:

¢ Table breakpoints (cell array) — Enter {[X; 110], [Y; 7200]}
to specify the range of input breakpoints.

¢ Table data (initial) — Enter rand(10,36) to specify random
numbers as the initial table values for the volumetric efficiency.

¢ Table numbering data — Enter reshape(1:360,10,36) to specify
a numbering scheme for the table cells.

b Verify that Sample mean (with forgetting) is selected in the
Adaptation method drop-down list.
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Enter 0.98 in the Adaptation gain (0 to 1) field to specify the forgetting
factor for the Sample mean (with forgetting) adaptation algorithm.

An adaptation gain close to 1 indicates high robustness of the lookup
table values to input noise. To learn more about the adaptation gain, see
“Sample Mean with Forgetting” on page 5-43 in “Selecting an Adaptation
Method” on page 5-42.

Select the Make adapted table an output check box.
This action adds a new port named Tout to the Adaptive Lookup Table

block. You use this port to plot the table values as they are being
adapted.

Select the Add adaptation enable/disable/reset port check box.

This action adds a new port named Enable to the Adaptive Lookup Table
block. You use this port to enable or disable the adaptation process.
Select the Add cell lock enable/disable port check box.

This action adds a new port named Lock to the Adaptive Lookup Table
block. You use this port to lock a cell during the adaptation process.
Verify that Ignore is selected in the Action for out-of-range drop-down
list.

This selection specifies that the software ignores any time-varying
inputs outside the range of input breakpoints during adaptation.

Tip To learn more about the Adaptive Lookup Table (nD Stair-Fit)
block parameters, see the Adaptive Lookup Table (nD Stair-Fit) block
reference page.

After you configure the parameters, the block parameters dialog box
looks like the following figure.
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E! Function Block Parameters: Adaptive Lookup Table (i x|

—Adaptive Lookup Table (nD) (mask) {Jink)

Perform adaptive table lookup. Breakpoints relate the coordinate inputs to cell
locations in the table. The data is used to dynamically update the cell values at
these locations.

—Parameters

Number of table dimensions:

|2

Table breakpoints {cell array):
[{D¢; 110], [v; 72007}

™ Make initial table an input

Table data (initial):
I rand(10,36)

Table numbering data:

| reshape(1:350,10,36)

Adaptation method: ISampIe mean {with forgetting) j

Adaptation gain (0 to 1):
0.8

[ Make adapted table an output
| Add adaptation enable/disable reset port
[+ Add cell lock enable/disable port

Action for out-ofrange input IIgnUrE j

OK. I Cancel | Help | Apply |

h Click OK to close the Function Block Parameters dialog box.

The Simulink model now looks similar to the following figure.
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E! enginetablel_data * ;IEIEI

File Edit View Simulation Format Tools Help

O SEHES fER|E= 4|22 r 5o | [Noml

Experimantal Data
u 2-0 Tiup
u ¥
¥
M
¥ :
Enable
Tout
Lock
Adaptive Lookup
Table (nD Stair-Fit)
Ready [100% [ [ [FixedStepDiscrete 4

5 Assign the input and output data to the engine model by connecting the
U and Y ports of the Experimental Data block to the u and y ports of the
Adaptive Lookup Table block, respectively.

-loix]

File Edit View Simulaton Format Tools Help

DSES BRI 4|22 r =fioo | [m

Expermenial Data

U 2-DT(u)

h
3

Enable

Tout
Lock

Adaptive Lookup
Table (nD Stair-Fit)

Ready 100% [ [FixedStepDiscrete 4
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Tip To learn how to connect blocks in the Simulink model window, see
“Connecting Blocks in the Model Window” in the Simulink documentation.

6 Design a logic using Simulink blocks to enable or disable the adaptation
process. Connect the logic to the Adaptive Lookup Table block, as shown in
the following figure.

E! enginetablel_data * ;Iglil

File Edit View Simulaton Format Tools Help

NDSEHE| 4 E2R|Ee 3|22 r 5fion | [rom

Exparimental Data

U »lu 2-D T{u)

=)

- ¢ Enable
Manual Switch

Lock Tout

Adaptive Lookup
Table (nD Stair-Fit)

Ready [100% [ [ |FixedStepDiscrete 4

This logic outputs an initial value of 1 which enables the adaptation process.

7 Design a logic to lock a cell during adaptation. Connect the logic to the
Adaptive Lookup Table block, as shown in the following figure.
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E! enginetablel_data * i =]
File Edit View Simulation Format Tools Help
O ZEH& s8¢ r = | [Nom
Exparimental Data
U »lu 2.0 T(u)
¥
¥ Wy
N
- h "
Enable
Lock Tout
Manual Switzh1 Adaptive Lookup
Table (nD Stair-Fit)
Ready [100% [ [ |FixedstepDiscrete v

8 In the Simulink Library Browser, select the Simulink > Sinks library,
and drag Display blocks to the model window. Connect the blocks, as
shown in the following figure.

E! enginetablel_data * 5 =] 3

File Edit View Simulation Format Tools Help

D& & B2R|(E= 4 <22 » =m0 [Nma ]| L

Experimental Data

u »u 2.0 Tiw)

]

Display

Enable Dip lay 1

NOT Manual Switch
L o
Manual Switchi

Lock Tout

Adaptive Lookup
Table (nD Stai-Fit)

Ready |100% [ [ [FixedstepDiscrete v

During simulation, the Display blocks show the following:
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® Display block — Shows the value of the current cell being adapted.
e Display1 block — Shows the number of the current cell being adapted.

9 Write a MATLAB function to plot the lookup table values as they adapt

during

Alternatively, you can type enginetable at the MATLAB prompt to open
a preconfigured Simulink model. The Efficiency Surface subsystem
contains a function to plot the lookup table values, as shown in the next

simulation.

figure.

_nix]
File Edit Yiew Simulation Format Tools Help
DID”E@I&%EI@@?IDCH) II'ID.D INorrnaI jlé

N

Exparimental Data

u

Ready

Enable

0 Lock

2-D Tiup

Tout

Adaptiva Table Outputs

GCall Number

Graph Triggar h J
E

_l—p |Adapied Tabls

Adaptive Lookup

Table (nD Stair-Fit}

Efficiancy Surface

[100%

|FixedStepDiscrete

4

10 Connect a To Workspace block to export the adapted table values:

a In the Simulink Library Browser, select the Simulink > Sinks library,

and drag the To Workspace block to the model window.

To learn more about this block, see the To Workspace block reference

page in the Simulink documentation.

b Double-click the To Workspace block to open the Sink Block Parameters

dialog box, and type Tout in the Variable name field.
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E! Sink Block Parameters: To Workspace

— To Workspac

D |x

‘Write input ko specified array or struckture in MATLAE's main workspace, Data is
not available until the simulation is stopped or paused.

—Parameter:

Wariahle name:

k)

Limit daka points ta last:

I inf

Dedmation:

[1

Sample kime -1 For inherited):
-1

Save Format: [Structure =l

™ Log fixed-point data as an fi abject

oK I Cancel Help | Apply |

¢ Click OK.

d Connect the To Workspace block to the adaptive lookup table output
signal Tout, as shown in the next figure.

=] enginetable1 * -3 x|
File Edit WView Simulaton Format Tools Help
= » m I‘IDD INnrrnaI < E

DeEH&| BR|Es 42

Experimental Data

u o 2.0 Tiw) Adaptivs Tabk Outputs

Cell Number

ON
Enabke
B Enable
-
Graph Trigge

Lock Tout F
[Ackapted Table

Adaptive Lookup
Table (nD Stair-Fity

Effiziency Surface

To Workspace

Ready 100% FixedStepDiscrete
A4
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You have now built the model for updating and viewing the adaptive lookup
table values. You must now simulate the model to start the adaptation, as
described in “Adapting the Lookup Table Values Using Time-Varying I/0
Data” on page 5-57.

Adapting the Lookup Table Values Using Time-Varying 1/0
Data

In this portion of the tutorial, you learn how to update the lookup table values
to adapt to the time-varying input and output values.

You must have already built the Simulink model, as described “Building a
Model Using Adaptive Lookup Table Blocks” on page 5-45.

To perform the adaptation:

1 In the Simulink model window, enter inf as the simulation time.

File Edit View Simulation Format Tools Help

D|ﬁﬂ§|éﬁﬁ|4==ﬁ>{f|f>@|} l'ii INDrrnaI 'Il

The simulation time of infinity specifies that the adaptation process
continues as long as the input and output values of the engine change.

2 In the Simulink model window, select Simulation > Start to start the
adaptation process.

A figure window opens that shows the volumetric efficiency of the engine as
a function of the intake manifold pressure and engine speed:

¢ The left plot shows the measured volumetric efficiency as a function of
intake manifold pressure and engine speed.

¢ The right plot shows the volumetric efficiency as it adapts with the
time-varying intake manifold pressure and engine speed.

5-57



5 Lookup Tables

~=1olx|

File Edit View Insert Tools Desktop Window Help

Dods | FRAODEL- 0| D

Plant Surface using Measured Data Plant Surface using Adaptive Lookup Table {Stairfit

Waolumetric Efficiency
Wolumetric Efficiency

6000
4000
2000

Intake Manifold Pressure 0o E Speed Intake Manifold Pressure 00
(kPa) ngine Speed {rpm) (kPa)

Engine Speed {rpm)

During simulation, the lookup table values displayed on the right plot
adapt to the variations in the I/0O data. The left and the right plots resemble
each other after a few seconds, as shown in the next figure.

T ol

File Edt View Insert Tools Desktop Window Help
Ocde s [RRO9EL - |2/0EaD

Plant Surface using Measured Data Plant Surface using Adaptive Lookup Table (Stair-fit)

“olumetric Efficiency
Volumetric Efficiency

6000
4000

4000

2000 2000

Intake Manifold Pressure 0 o Intake Manifold Pressure (1)
B Engine Speed {rpm) Engine Speed (rpm)

(kPa) (kPa)
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Tip During simulation, the Ce1l Number and Adaptive Table Outputs
blocks in the Simulink model display the cell number, and the adapted
lookup table value in the cell, respectively.

3 Pause the simulation by selecting Simulation > Pause.

This action also exports the adapted table values Tout to the MATLAB
workspace.

Note After you pause the simulation, the adapted table values are stored
in the Adaptive Lookup Table block.

4 Examine that the left and the right plots match. This resemblance
indicates that the table values have adapted to the time-varying I/O data.

5 Lock a table cell so that only one cell adapts. You may find this feature
useful if a portion of the data is highly erratic or otherwise difficult for the
algorithm to handle.

a Select Simulation > Start to restart the simulation.

——
b Double-click the Lock block. This action toggles the switch to +

You can view the number of the locked cell in the Cell Number block in
the Simulink model.

6 After the table values adapt to the time-varying I/0O data, you can continue
to use the Adaptive Lookup Table block as a static lookup table:

a In the Simulink model window, double-click the Enable block. This
action toggles the switch, and disables the adaptation.

b Select Simulation > Start to restart the simulation, if it is not already
running.

During simulation, the Adaptive Lookup Table block works like a
static lookup table, and continues to estimate the output values as the
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input values change. You can see the current lookup table value in the
Adaptive Table Outputs block in the Simulink model window.

Note After you disable the adaptation, the Adaptive Lookup Table block
does not update the stored table values, and the figure that displays the
table values does not update.

Using Adaptive Lookup Tables in Real-Time
Environment

You can use experimental data from sensor measurements collected by
running various tests on a system in real time. The measured data is then
sent to the adaptive table block to generate a lookup table describing the
relation between the system inputs and output.

You can also use the Adaptive Lookup Table block in a real-time environment,
where some time-varying properties of a system need to be captured. To do
so, generate C code using Real-Time Workshop® code generation software
that can then be run in an xPC Target™ or dSPACE® software. Because
you can start, stop, or reset the adaptation if you want, use logic to enable
the adaptation of the table data only when it is desired. The cell number
output N, and the Enable and Lock inputs facilitate this process. Use the
Enable input to start and stop the adaptation and the Lock input to update
only one of the table cells. The Lock input combined with some logic using
the cell number output N provide the means for updating only the desired
table cells during a simulation run.



Function Reference

Parameter Estimation (p. 6-2) Parameter estimation using
measured data

Parameter Optimization (p. 6-3) Optimize model parameters to meet
time-domain requirements
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Parameter Estimation

spetool Create Estimation Task in Control
and Estimation Tools Manager GUI
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Parameter Optimization

Parameter Optimization

Response Optimization Projects Work with response optimization
(p. 6-3) projects

Design Requirements (p. 6-3) Manage design requirements
Parameters (p. 6-4) Manage parameters to optimize

Model Dependencies (p. 6-4)

Model Robustness (p. 6-4) Specify uncertain parameter values

Optimization Options (p. 6-4) View and modify optimization
settings

Simulation Options (p. 6-4) View and modify simulation settings

Response Optimization Projects
getsro Extract response optimization
project for given Simulink model

ncdupdate Upgrade models with Nonlinear
Control Design Blockset blocks

newsro New response optimization project
with default settings

optimize Run response optimization project

Design Requirements

findconstr Extract design requirements
specified in Signal Constraint block
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Parameters

findpar

initpar

Model Dependencies

finddepend

Model Robustness

gridunc
randunc

setunc

Optimization Options

optimget

optimset

Simulation Options

simget

simset

Find specifications for given tuned
parameter

Specify initial parameter values in
response optimization project

List of model path dependencies

Multi-dimensional grid of uncertain
parameter values

Random values of uncertain
parameters

Specify parameter uncertainty in
response optimization project

Current optimizer settings

Modify optimization settings

Current simulation settings

Modify simulation settings
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findconstr

Purpose Extract design requirements specified in Signal Constraint block
Syntax constraints=findconstr(proj, 'blockname')
Descripl‘ion constraints=findconstr(proj, 'blockname') extracts design

requirements specified in the Signal Constraint block blockname of
the Simulink model associated with the response optimization project
proj. constraints contains data that defines the design requirements.
Modify the UpperBoundX, UpperBoundY, LowerBoundX and LowerBoundY
properties of constraints to specify new design requirements, and the
ReferenceX and ReferenceY properties to add a reference signal. The
Simulink model associated with proj must be open.

Note The Signal Constraint block does not update to display the
modified constraints and reference signal. However, the updated
constraint bounds and reference signal specified in the constraint object
are used when you optimize the parameters from the command line.

Exumple Retrieve the constraints specified in the Signal Constraint block of the
model associated with the response optimization project:

% Open the Simulink model

srotuti

Create a response optimization project with default settings and
% parameters to optimize

proj=newsro( 'srotuti’', 'Kint');

% Retrieve the constraints for this project
constraint=findconstr(proj, 'srotut1/Signal Constraint');

o°

Change the positioning of the constraint bounds by editing the upper-
and lower-bound matrices:

constraint.UpperBoundY=[1.1 1.1;1.01 1.01];
constraint.UpperBoundX=[0 30;30 50];
constraint.LowerBoundY=[0 0;0.9 0.9;0.99 0.99];
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constraint.LowerBoundX=[0 15;15 30;30 50];

If you add these constraints graphically in the Signal Constraint block,
the constraints appear as shown in the following figure. To learn
more about how to add constraints graphically, see “Specifying Design
Requirements” on page 3-5.

Imput to srotut] iSignal Constraint
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Include a reference signal using the following commands:

constraint.CostEnable="'on"';
constraint.ReferenceX=1linspace(0,50,1000);
constraint.ReferenceY=1-exp(-linspace(0,50,1000));

If you include the reference signal graphically in the Signal Constraint
block, the reference signal appears as shown in the following figure.
To learn more about how to specify a reference signal, see “Tracking
Reference Signals” on page 3-18.
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Imput to srotut] iSignal Constraint
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See Also getsro, newsro, optimize



finddepend

Purpose
Syntax

Description

Examples

List of model path dependencies
dirs=finddepend(proj)

dirs=finddepend(proj) returns paths containing Simulink model
dependencies required for parameter optimization using parallel
computing. proj is a response optimization project for the model
created using newsro or getsro. dirs is a cell array, where each
element is a path string. dirs is empty when finddepend does not
detect any model dependencies. Append paths to dirs when the list
of paths is empty or incomplete.

finddepend does not return a complete list of model dependency paths
when the dependencies are undetectable.

List model path dependencies required for parallel computing:

% Copy Simulink boiler library to temporary folder.
pathToLib = boilerpressure_setup;

% Add folder to search path.
addpath(pathTolLib);

% Open Simulink model.

boilerpressure_demo

% Extract response optimization project.
proj=getsro('boilerpressure_demo');

% Enable parallel computing.

optimset(proj, 'UseParallel’', 'always');

% Get model dependency paths.
dirs=finddepend(proj)

% Add paths to optimization project.
optimset(proj, 'ParallelPathDependencies’',dirs)

Make local paths accessible to remote workers:

% Copy Simulink boiler library to temporary folder.
pathToLib = boilerpressure_setup;
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% Add folder to search path.

addpath(pathTolLib);

% Open Simulink model.

boilerpressure_demo

% Extract response optimization project.
proj=getsro('boilerpressure_demo');

% Enable parallel computing.

optimset(proj, 'UseParallel’', 'always');

% Get model dependency paths.
dirs=finddepend(proj)

% The resulting path is on a local drive, C:/.

% Replace C:/ with valid network path accessible to remote workers.
dirs = regexprep(dirs,'C:/"','"\\\\hostname\\C$\\")
% Add paths to optimization project.
optimset(proj, 'ParallelPathDependencies',dirs)

Append path to model path dependency list:

% Copy Simulink boiler library to temporary folder.
pathToLib = boilerpressure_setup;

% Add folder to search path.
addpath(pathTolLib);

% Open Simulink model.

boilerpressure_demo

% Extract response optimization project.
proj=getsro('boilerpressure_demo');

% Enable parallel computing.

optimset(proj, 'UseParallel’', 'always');

% Get model dependency paths.
dirs=finddepend(proj)

% Append an additional path.
dirs=vertcat(dirs, '\\hostname\C$\matlab\work")
% Add paths to optimization project.
optimset(proj, 'ParallelPathDependencies’',dirs)
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Alternatives Identify model path dependencies using the GUI:

1 In the Simulink model, double-click the Signal Constraint block to
open the Block Parameters: Signal Constraint window.

2 In the Block Parameters window, select Optimization > Parallel
Options to open the Parallel Options tab.

3 Select the Use the matlabpool during optimization option to
identify the model dependencies automatically.

See Also newsro | getsro | optimget | optimset

Tutorials * Improving Optimization Performance Using Parallel Computing

How To + “Speeding Up Response Optimization Using Parallel Computing”
on page 3-60

+ “Model Dependencies”



findpar

Purpose Find specifications for given tuned parameter
Syntax p=findpar(proj, 'param')
Description p=findpar(proj,'param') returns a tuned parameters object for

the parameter with the name param within the response optimization
project, proj. The tuned parameters object defines specifications for
each tuned parameter that the optimization method uses, such as initial
guesses, lower bounds, etc.

The properties of each tuned parameter object are

Name A string giving the parameter’s name.
Value The current value of the parameter. This
changes during the optimization.
InitialGuess The initial guess for the parameter value
for the optimization.
Minimum The minimum value this parameter can
take. By default, it is set to - Inf.
Maximum The maximum value this parameter can
take. By default, it is set to Inf.
TypicalValue A value that the tuned parameter is scaled
by during the optimization.
ReferencedBy The block, or blocks, in which the

parameter appears.

Description An optional string giving a description of
the parameter.

Tuned Set to 1 or 0 to indicate if this parameter
is to be tuned or not.

Edit these properties to specify additional information about your
parameters.
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Exumple Create a response optimization project for srotuti.

proj=newsro('srotutl', 'Kint');

Find the tuned parameters object for the parameter Kint.

p=findpar(proj, 'Kint')

This command returns the following result:

Name: 'Kint'
Value: 0
InitialGuess: O
Minimum: -Inf
Maximum: Inf
TypicalvValue: 0
ReferencedBy: {0x1 cell}
Description: ''
Tuned: 1

Tuned parameter.

Change the initial guess to 0.5, and the minimum value to 0 with the
set function.

set(p, 'InitialGuess',0.5, 'Minimum',0)

See Also getsro, newsro, optimize
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Purpose
Syntax

Description

Example

See Also

7-10

Extract response optimization project for given Simulink model
proj=getsro('modelname')

proj=getsro('modelname') returns the response optimization project,
proj, currently associated with the Simulink model with name,
modelname. The model should be open and contain Simulink Design
Optimization blocks. Use the project with the optimize function to
optimize response signals in the model by tuning specified parameters.

Open the model pidtune_demo by typing the model name at the
MATLAB prompt:

pidtune_demo

Extract the response optimization project from this model by typing the
following command at the MATLAB prompt:

proj=getsro('pidtune_demo')

This command returns the following result:

Name: ‘'pidtune_demo'
Parameters: [3x1 ResponseOptimizer.Parameter]
OptimOptions: [1x1 sroengine.OptimOptions]
Tests: [1x1 ResponseOptimizer.SimTest]
Model: 'pidtune_demo'

Response Optimization Project.

Use the findpar and findconstr functions to specify signal constraints
and tuned parameters.

findconstr, findpar, newsro, optimize



gridunc

Purpose Multi-dimensional grid of uncertain parameter values
Syntax uncpar=gridunc(’ParameterName’,Values,...)
Description uncpar=gridunc(’ParameterName’ ,Values,...) constructs a

multi-dimensional grid that contains all value combinations of
uncertain parameters ParameterName. uncpar contains the uncertain
parameter values.

Inputs ParameterName_n

Name of the uncertain parameter in a response optimization
project.

Values_n

Values of corresponding uncertain parameter ParameterName_n:

e {first value,...,last_value} for vector- or matrix-valued
parameters. Dimensions of each cell element of
{first value,...,last value} must match the dimensions
of the parameter.

e {first_value,...,last_value} or
[first _value,...,last _value] for scalar-valued parameters.

Examples Create a grid of values for vector-valued uncertain parameters:

uset=gridunc('Kp',{[1;4]1,[1;4]},'Kd",...
{[0.1;0.3;0.2],[0.1;0.3;0.2],[0.1;0.3;0.21});

Create and enable a grid of values for uncertain parameters to test
model robustness:

% Create a grid of values for the uncertain parameters P, I and D.
uset=gridunc('P',[1,2,3,4],'I',[0.1,0.2,0.3],'D"',[30,35,40]);

% View values for the uncertain parameter P.

uset.P

% The default value of the Optimized property of uset is false.
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% This implies that the uncertain parameter values are not
enabled for testing model robustness.

% Set the value to true to enable uncertain parameter values.
uset.Optimized(1:end)=true;

[)
)

Algorithm For parameters with values specified as
{first_value,...,last_value} or [first_value,...,last_value],
gridunc creates a hypercube which consists of:

e 25 vertices, where S is the number of parameters. first value and
last_value of each parameter form the vertices of the hypercube.
¢ Number of samples equal to the product of number of values specified

for each parameter.

Alternatives To create a grid of uncertain parameter values using the GUI:

1 In the Simulink model, double-click the Signal Constraint block to
open the Block Parameters: Signal Constraint window.

2 In the Block Parameters window, select Optimization > Uncertain
Parameters to open the Uncertain Parameters dialog box.

3 Select Grid as the Sampling method.

4 Specify the uncertain parameters and their values:
a Click Add to open the Add Parameters dialog box.

b Select the uncertain parameters and click OK to add them to the
Uncertain Parameters dialog box.

¢ Specify the values for the corresponding parameter in the Sample
Values column.

See Also setunc | randunc
How To + “Sampling Methods for Computing Uncertain Parameter Values”
on page 3-43
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+ “Optimizing Parameters for Model Robustness” on page 3-42
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Purpose Specify initial parameter values in response optimization project
Syntax initpar(proj)
Description initpar(proj) updates the parameters’ initial guess in proj with the

current parameter values in the model or base workspace. proj is a
response optimization project, created using getsro or newsro.

Before using initpar, open the Simulink model associated with proj.

Examples Initialize a response optimization project with updated parameter
values:

1 Run an optimization to meet step response requirements.

% Open Simulink model.

sldo_model1_constrblk

% Create response optimization project to optimize

% parameters Kd, Ki and Kp.
proj=newsro('sldo_modeli1_constrblk',{'Kd','Ki','Kp'})

% Extract design requirements from Signal Constraint block.
constr=findconstr(proj,...

'sldo_modeli_constrblk/Signal Constraint')

% Specify step response requirements.
constr.LowerBoundX=[0 10;10 15;15 50];
constr.LowerBoundX=[0 10;10 30;30 50];
constr.UpperBoundX=[0 30;30 50];

constr.UpperBoundY=[1.1 1.1;1.01 1.01];

% View initial value of Kd.
proj.parameter(1).InitialGuess

% Optimize parameters to meet step response requirements.
optimize(proj);

2 Specify a reference signal, and initialize proj with updated
parameter values before running a new optimization.

% Specify reference signal.
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constr.CostEnable='on';
constr.ReferenceX=1linspace(0,50,200)"';
constr.ReferenceY=1-exp(-0.3*1linspace(0,50,200))";
% The values of Kd, Ki and Kp are not updated

% in proj. For example:
proj.parameter(1).InitialGuess

% Update proj with updated parameter values.
initpar(proj);

% View the updated initial value of Kd, which is now updated.
% The same is true for Ki and Kp.
roj.parameter(1).InitialGuess

% Rerun optimization to meet step requirements and
% track the reference signal simultaneously.
optimize(proj);

©

See Also newsro | findpar | findconstr | optimize

Tutorials + “Tutorial — Optimizing Parameters to Meet Time-Domain
Requirements Using the Command Line”

How To + “Optimizing Parameters at the Command Line” on page 3-87
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Purpose
Syntax

Description

See Also

Upgrade models with Nonlinear Control Design Blockset blocks
ncdupdate('modelname’)

ncdupdate ('modelname') searches the Simulink model specified by the
string 'modelname' for Nonlinear Control Design Blockset Outport
blocks and replaces them by the equivalent Signal Constraint block
from Simulink Design Optimization library. The model must be open
prior to calling ncdupdate.

When your Nonlinear Control Design Blockset settings are stored in a
ncdStruct variable that automatically load when you open the model,
this variable changes in the workspace during the update so that it is
compatible with Simulink Design Optimization software. You must
resave this variable after the update.

When your Nonlinear Control Design Blockset settings are stored in
an ncdStruct variable that do not automatically load with the model,
first load the ncdStruct variable into the workspace before calling
ncdupdate. Then resave the variable after the update.

To retain the upgraded blocks, save the model after running ncdupdate.

slupdate



newsro

Purpose New response optimization project with default settings
Syntax proj=newsro(’modelname’ ,params)
Description proj=newsro(’modelname’ ,params) creates a response optimization

project proj for the Simulink model modelname. params is a cell array of
strings that specifies model parameters for optimization. proj contains
default design requirements, parameter settings, and optimization
options in the Signal Constraint block. The model must contain at least
one Signal Constraint block.

Examples Create a response optimization project with default settings and specify
parameters for optimization:

% Create a new response optimization project and specify parameters
% Kp, Ki and Kd for optimization.
proj = newsro('pidtune_demo',{'Kp' 'Ki' 'Kd'})

Alternatives Create a response optimization project with default settings using the
GUL

1 Drag and drop a Signal Constraint block from the Simulink Design
Optimization library into the Simulink model.

2 Connect the Signal Constraint block to the signal that must meet
specific design requirements.

3 Double-click the Signal Constraint block to create a response
optimization project with default settings.

See Also findconstr | findpar | getsro | optimize

Tutorials + “Tutorial — Optimizing Parameters to Meet Time-Domain
Requirements Using the Command Line”

How To + “Constraining Model Signals” on page 3-3
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+ “Optimizing Parameters at the Command Line” on page 3-87
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optimget

Purpose
Syntax

Description

Example

Current optimizer settings
opt_settings=optimget(proj)

opt_settings=optimget(proj) returns the current optimization
settings object, opt_settings, for the response optimization project
proj.

Use optimset to modify the optimization options.

For more information on the settings and their possible values, see the
optimset reference page.

Create a new default response optimization project for the model
srotuti.

proj=newsro('srotutl', 'Kint');

Get the optimization settings for this project.

opt_settings=optimget(proj)

This command returns the following list of optimization settings and
their current values.

Method: 'fmincon'
Algorithm: 'active-set'
Display: 'iter'
GradientType: 'basic’
MaximallyFeasible: O
MaxIter: 100
TolCon: 1.0000e-003
TolFun: 1.0000e-003
TolX: 1.0000e-003
Restarts: O
UseParallel: 'never'
ParallelPathDependencies: {Ox1 cell}
SearchMethod: []
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See Also optimset, simget, simset
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Purpose
Syntax

Description

Example

Run response optimization project
result=optimize(proj)

result=optimize (proj) optimizes the responses specified in the
response optimization project, proj, with the constraints, parameters,
and settings. The response optimization results are displayed after each
iteration. The tuned parameters are changed in the workspace. Enter
the parameter name at the MATLAB prompt to see its new value.

A results object, result, is also returned. The properties of this object
are

® Cost: The final value of the cost function.

® ExitFlag: 1if the optimization terminated successfully, 0 if it did not.
e Iteration: The number of iterations.

For more information on the results properties, see the reference pages

for the Optimization Toolbox functions fmincon and fminsearch and
the Global Optimization Toolbox function patternsearch.

Open the pitchrate_demo model.

pitchrate_demo

Create a response optimization project based on the current settings in
the model.

proj=getsro('pitchrate_demo');

Run the optimization with the following command.

results=optimize(proj)
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The expected results are displayed as follows.

max Directional First-order
Iter S-count f(x) constraint Step-size derivative optimality Procedure

0 1 0 1803
1 14 0 160 0.0287 0 0.0152
2 21 0 0.2607 0.0327 0 0.00598 Hessian modified
3 28 0 0.04203 0.071 0 0.0122 Hessian modified
4 35 0 0.001894 0.0164 0 0.00112 Hessian modified
5 42 0 7.631e-006 0.000804 0 5.01e-006 Hessian modified

Successful termination.

Found a feasible or optimal solution within the specified tolerances.

k1 =
0.8674
k2 =
-0.1513
k3 =
-0.5003
results =
Cost: 0O
X: [4x1 double]
ExitFlag: 1
Iteration: 5
See Also findconstr, findpar, getsro, newsro, optimget, optimset

7-22



optimset

Purpose Modify optimization settings
Syntax optimset(proj, 'Property1',Valuel, 'Property2',Value2,...)
Description optimset(proj, 'Property1',Valuel, 'Property2',vValue2,...)
modifies the optimization settings within the response optimization
project, proj. The value of the optimization setting, Property, is set to
Valuel, Property2 is set to Value2, etc.
Property Description Possible Settings
Method The optimization method used. | {'fmincon'} |
The following methods are 'patternsearch' |
available: 'fminsearch'
® fmincon — Optimization
Toolbox function fmincon
® patternsearch — Global
Optimization Toolbox
function patternsearch
® fminsearch — Optimization
Toolbox function fminsearch
Algorithm The algorithm used by the For fmincon

optimization method.

optimization method:

e {'active-set'}
® 'trust-region-reflective'

® 'interior-point'

7-23



optimset

7-24

Property

Description

Possible Settings

Display

The level of information that
the optimization displays:
e off — No output

® jiter — Output at each
iteration

e final — Final output only

® notify — Output only if the
function does not converge

‘off' | {'iter'} |
"final' | 'notify'

GradientType

Method used to calculate
gradients when using
"fmincon' as the Method.

Use one of the following finite
difference methods for gradient
calculation:

® pbasic — Default method for
computing the gradients

e refined — Offers a more
robust and less noisy
gradient calculation method
than 'basic'

The refined method is
sometimes more expensive,
and does not work with
certain models such as
SimPowerSystems models.

{'basic'} | 'refined'




optimset

Property

Description

Possible Settings

MaximallyFeasible

Option to specify that the

optimization continue after an

initial, feasible solution has

been found:

¢ 0 — Terminate the
optimization as soon as an
initial solution that satisfies
the constraints is found. The
resulting response signal
may lie very close to the
constraint segment.

e 1 — Continue the
optimization after an initial
solution is found. The
optimization can continue
to search for a maximally
feasible solution that is
typically located further
inside the constraint region.

Note The software ignores
this option when you track a
reference signal.

{o} | 1

MaxIter

Maximum number of iterations
allowed

Positive integer value

TolCon

Termination tolerance on the
constraints

Positive scalar value

TolFun

Termination tolerance on the
function value

Positive scalar value

TolX

Termination tolerance on the
parameter values

Positive scalar value
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Property

Description

Possible Settings

Restarts

In some optimizations,

the Hessian may become
ill-conditioned, and the
optimization does not
converge. In these cases,

it is sometimes useful to restart
the optimization after it stops,
using the endpoint of the
previous optimization as the
starting point for the next one.
To automatically restart the
optimization, use this option to
indicate the number of times
you want to restart.

Nonnegative integer
value

UseParallel

7-26

Parallel computing option for
the following optimization
methods:

® fmincon

® patternsearch

Note Parallel Computing
Toolbox software must be
installed to enable parallel
computing for the optimization
methods.

When set to 'always', the
methods compute the following
in parallel:

e fmincon — Computes finite
difference gradients

‘always' | {'never'}
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Property

Description

Possible Settings

® patternsearch — Performs
population evaluation

Disable the option by setting to
‘never’.

ParallelPathDependencies

Option to store model path
dependencies when using
parallel computing

Cell array of strings

SearchMethod

Search options for use with the
patternsearch method

See “Search Options” in
the Global Optimization
Toolbox documentation.

For more information on the possible settings and the values they
can take, see the reference page for optimset in the MATLAB
documentation.

Example

proj=newsro('srotutl', 'Kint');

Get the optimization settings for this project.

opt_settings=optimget(proj)

Create a default response optimization project for the model srotuti.

This command returns the following list of optimization settings and
their current values.

Method: 'fmincon'
Algorithm: 'active-set'
Display: 'iter'
GradientType: 'basic'
MaximallyFeasible: O
MaxIter: 100
TolCon: 1.0000e-003
TolFun: 1.0000e-003
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See Also

TolX:

Restarts:

UseParallel:
ParallelPathDependencies:
SearchMethod:

1.0000e-003
0

"never'
{0x1 cell}
[]

Use optimset to change the maximum number of iterations to 150.

optimset(proj, 'MaxIter',150)

To view the changes to opt_settings, enter the variable name at the

MATLAB prompt.

opt_settings

This command returns

Method: 'fmincon'
Algorithm: 'active-set'
Display: 'iter'
GradientType: 'basic'
MaximallyFeasible: O
MaxIter: 150
TolCon: 1.0000e-003
TolFun: 1.0000e-003
TolX: 1.0000e-003
Restarts: 0
UseParallel: 'never'
ParallelPathDependencies: {Ox1 cell}
SearchMethod: []

optimget, simget, simset



randunc

Purpose Random values of uncertain parameters
Syntax uncpar=randunc (N, ’ParameterName’ ,Range, .. .)
Description uncpar=randunc (N, ’ParameterName’ ,Range, ...) generates random

values of uncertain parameters, specified as comma separated
’ParameterName’ and Range value pairs. Range specifies the lower
and upper bounds for the uncertain parameter. Enter Range as a cell
array {[Min], [Max]} for vector- and scalar-valued parameters or
vector [Min,Max] for scalar-valued parameters. Dimensions of each cell
element must match the corresponding parameter dimension. N is the
number of samples inside the hypercube formed by Min and Max of each
parameter. uncpar contains the uncertain parameter values.

Examples Generate random values for vector-valued uncertain parameters Kp
and Kd:

uset=randunc(10, 'Kp',{[1,4,3,0],[4,10,7.5,6]}, 'Kd"',{[2,2],[8,7]})

Generate random values for scalar-valued uncertain parameters w0
and zeta:

uset=randunc(4,'w0',[0.45,0.55], 'zeta',[0.45,0.55])

Generate random values for uncertain parameters and test model
robustness:

% Open the Simulink model.

sldo_model1_desreq_optim

% Extract response optimization project from the model.
proj=getsro('sldo_modeli_desreq_optim');

% Create random values for uncertain parameters w0 and zeta.
uset=randunc(4,'w0',[0.45,0.55], 'zeta',[0.45,0.55])

% View values for the uncertain parameter woO.
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Algorithm

Alternatives

uset.wO

The default value of the Optimized property of uset is false.
This value implies that the uncertain parameter values are not
enabled for testing model robustness.

Set the value to true to enable all uncertain parameter

values for testing model robustness.
uset.Optimized(1:end)=true;

% Specify parameter uncertainty in response optimization project.
setunc(proj,uset);

% Test model robustness.

optimize(proj);

d® o° o° o°

o°

For parameters p with range specified as [Min,Max] or {[Min], [Max]}
, randunc interprets the range of the uncertain parameters as:

Min(i,j) <= p(i,j) <= Max(i,j)

randunc generates a set of uncertain parameter values consists of the
following:

e All vertices of the hypercube specified by Min and Max values of the
parameters. The total number of vertices of the hypercube is 25,
where S is the number of uncertain parameters.

* N random samples inside the hypercube.

To generate random values of uncertain parameters using the GUI:

1 In the Simulink model, double-click the Signal Constraint block to
open the Block Parameters: Signal Constraint window.

2 In the Block Parameters window, select Optimization > Uncertain
Parameters to open the Uncertain Parameters dialog box.

3 Select Random (Monte Carlo) as the Sampling method.

4 Specify the number of samples in the Number of samples field.



randunc

5 Specify the uncertain parameters and their range:
a Click Add to open the Add Parameters dialog box.

b Select the uncertain parameters and click OK to add them to the
Uncertain Parameters dialog box.

¢ Specify the range for the corresponding parameter in the Min
and Max columns.

See Also setunc | gridunc
How To + “Sampling Methods for Computing Uncertain Parameter Values”
on page 3-43

+ “Optimizing Parameters for Model Robustness” on page 3-42
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Purpose
Syntax

Description

Example

See Also

Specify parameter uncertainty in response optimization project
setunc(proj,unc_settings)

setunc(proj,unc_settings) sets the parameter uncertainty
specifications for the response optimization project, proj. Use the
function gridunc or randunc to specify the uncertainty settings,
unc_settings.

Create a response optimization project.

proj=newsro('srotutl', 'Kint');

Specify uncertain parameter settings using gridunc.

uset=gridunc('zeta',[0.9,1,1.1],'Ww0"',[0.95,1,1.05]);

Set the uncertain parameters in the project.

setunc(proj,uset)

gridunc | randunc
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Purpose
Syntax

Description

Example

Current simulation settings
simoptions=simget('proj')

simoptions=simget('proj') returns a object containing the current
simulation settings, simoptions, used by the response optimization
project, proj. To modify the project’s simulation settings, use the
simset function.

The project’s simulation settings are a subset of the parameters that
you can set for Simulink models and blocks. For a detailed list of
these settings and the possible values they can take, see “About Model
Parameters” in the Simulink documentation. The default values of the
simulation settings are the same as those used by the Simulink model
the project is associated with. Changes that are made to the project’s
simulation settings are only used during simulations that are run as
part of the optimization, and they do not affect the simulation settings
for the model.

Create a response optimization project for the srotut1 model:
proj=newsro('srotutl’', 'Kint');

Get the simulation settings for this project:
simoptions = simget(proj)

This returns

simoptions =
AbsTol: 1.0000e-006
FixedStep: 'auto'
InitialStep: 'auto'
MaxStep: 'auto’
MinStep: ‘'auto’
RelTol: 1.0000e-003
Solver: 'auto'
ZeroCross: 'on'
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StartTime: '0.0'
StopTime: '50'

See Also optimget | optimset | simset

How To + “Specifying the Simulation Options” on page 3-32
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Purpose
Syntax

Description

Example

Modify simulation settings
simset(proj, 'setting1',valuel, 'setting2',value2,...)

simset(proj, 'settingl',valuel, 'setting2',value2,...) modifies
the simulation settings within the response optimization project,
proj. The value of the simulation setting, setting1, is set to value1,
setting2 is set to value2, etc.

The project’s simulation settings are a subset of the parameters that
you can set for Simulink models and blocks. For a detailed list of
these settings and the possible values they can take, see “About Model
Parameters” in the Simulink documentation. The default values of the
simulation options for the project are the same as those used by the
Simulink model the project is associated with. Changes that are made
to the project’s simulation settings are only used during simulations
that are run as part of the optimization, and they do not affect the
simulation settings for the model.

Create a response optimization project for the srotut1 model:
proj=newsro('srotutl’', 'Kint');

Get the simulation settings for this project:
simoptions = simget(proj)

This returns

simoptions =
AbsTol: 1.0000e-006
FixedStep: 'auto'
InitialStep: 'auto'
MaxStep: 'auto’
MinStep: ‘'auto’
RelTol: 1.0000e-003
Solver: 'auto'
ZeroCross: 'on'
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StartTime: '0.0'
StopTime: '50'

Use simset to change the solver type to ode23 and the absolute
tolerance to 1e-7.

simset(proj, 'Solver', 'ode23', 'AbsTol',1e-7)

Check the new values:

sim_settings=simget(proj);
sim_settings.Solver

This shows that the solver is now set to ode23.

ans =
ode23

Check the absolute tolerance:

sim_settings.AbsTol

This value is now set to 1e-7.

ans =
1.0000e-007
See Also optimget | optimset | simget
How To + “Specifying the Simulation Options” on page 3-32
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spetool

Purpose Create Estimation Task in Control and Estimation Tools Manager GUI
Syntax spetool('modelname')
Description spetool('modelname') opens the Simulink model with the name

modelname and creates an estimation task in the Control and
Estimation Tools Manager GUI.

Example Create an estimation task by typing the following command at the
MATLAB prompt:

spetool('engine_idle_speed')
This command opens the following:

e Simulink model

Elengine_idle_speed - ol =|

File Edit “ew Simulation Format Taools Help

DS 2R (e 4|92y sfin [om |He@sy nEE®

Idle Speed Engine Model
Copyright (0] 2002-2004 The MathWarks, Inc

4>|§| Manlinearities Linear Dynamics
. -

Walve
Woltage

Idle
Speed

Engine Speed

BRAW

Transport
Delay
Double click hare =3 Transfer Fen?
o open
Farameter Estim ation
Ul with preload data Click on the Start button in the GUI to
run an estimatian.
Ready 100% |ode4s 4
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See Also

¢ Control and Estimation Tools Manager containing a project with
an estimation task

E! Control and Estimation Tools Manager
File Wiew Help

i =] .
e 0| &
ﬂ Workspace - Task setting:
=T Project - engine_idle_speed Title: I
[ER=] |Estimation Task
(1) Transient Data Subject: I
Wariables Author: I
stimation
Ea Walidation Campany! I
Description: ;I
=
Madel: engine_idle_speed Open Maodel Update Task |
4
[
Select the nodes below ko configure and run estimations. v

“Importing Data into the GUI” on page 1-5, “Configuring Parameter
Estimation in the GUI” on page 2-3
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Adaptive Lookup Table (1D Stair-Fit)

Purpose
Library

Description

1-0 Tiu)

Adaptive Lookup
Table (1D Stair-Fit)

Data Type
Support

8-2

Perform one-dimensional adaptive table lookup
Simulink Design Optimization

The Adaptive Lookup Table (1D Stair-Fit) block creates a
one-dimensional adaptive lookup table by dynamically updating the
underlying lookup table. The block uses the outputs, y, of your system
to do the adaptations.

Each indexing parameter u may take a value within a set of adapting
data points, which are called breakpoints. Two breakpoints in each
dimension define a cell. The set of all breakpoints in one of the
dimensions defines a grid. In the one-dimensional case, each cell has
two breakpoints, and the cell is a line segment.

You can use the Adaptive Lookup Table (1D Stair Fit) block to model
time-varying systems with one input.

Doubles only



Adaptive Lookup Table (1D Stair-Fit)

Dialog
Box

L[] Function Block Parameters: Adaptive Lookup Tz |

— Adaptive Lookup Table [10] [mazk] [link)

Perfarm adaptive table lookup. Breakpoints relate the coordinate inputs to cell
lozations in the table. The data is used to dynamically update the cell values at
these locations.

— Parameter

First itiput [raowe] breakpoint set:
f[10.2231.40]

[ Make initial table an input
T able data [initial):

J[458]

Table numbering data:
nzs

Adaptation method: ISampIe mean [with forgetting) j

Adaptation gain [0 to 1]
jng

[~ Make adapted table an output
[~ &dd adaptation enable/disablesreset port
[~ Add cell lock enable/disable port

Action for out-of-range input {lgnore j

QK I Cancel Help Apply

First input (row) breakpoint set
The vector of values containing possible block input values. The
input vector must be monotonically increasing.

Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (1D
Stair-Fit) block to ignore the Table data (initial) parameter, and
creates a new input port Tin. Use this port to input the table data.



Adaptive Lookup Table (1D Stair-Fit)

Table data (initial)
The initial table output values. This vector must be of size N-1,
where N is the number of breakpoints.

Table numbering data
Number values assigned to cells. This vector must be the same
size as the table data vector, and each value must be unique.

Adaptation method
ChooseSample mean or Sample mean (with forgetting).
Sample mean averages all the values received within a cell.
Sample mean with forgetting gives more weight to the new
data. How much weight is determined by the Adaptation gain
parameter. For more information, see ..

Adaptation gain (0 to 1)
A number between 0 and 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port Tout for
the adapted table.

Add adaptation enable/disable/reset port
Selecting this check box creates an additional input port Enable
that enables, disables, or resets the adaptive lookup table. A
signal value of 0 applied to the port disables the adaptation, and
signal value of 1 enables the adaptation. Setting the signal value
to 2 resets the table values to the initial table data.

Add cell lock enable/disable port
Selecting this check box creates an additional input port Lock
that provides the means for updating only specified cells during a
simulation run. A signal value of 0 unlocks the specified cells and
signal value of 1 locks the specified cells.

Action for out-of-range input
Ignore or Adapt by extrapolating beyond the extreme breakpoints.



Adaptive Lookup Table (1D Stair-Fit)
|

See Also Adaptive Lookup Table (2D Stair-Fit), Adaptive Lookup Table (nD
Stair-Fit), “Capturing Time-Varying System Behavior Using Adaptive
Lookup Tables” on page 5-37
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Adaptive Lookup Table (2D Stair-Fit)

8-6

Purpose
Library

Description

2-0 T{u)

— P
N P}
A

Adaptive Lookup
Table (20 Stair-Fit)

Data Type
Support

Perform two-dimensional adaptive table lookup
Simulink Design Optimization

The Adaptive Lookup Table (2D Stair-Fit) block creates a
two-dimensional adaptive lookup table by dynamically updating the
underlying lookup table. The block uses the outputs, y, of your system
to do the adaptations.

Each indexing parameter u may take a value within a set of adapting
data points, which are called breakpoints. Two breakpoints in each
dimension define a cell. The set of all breakpoints in one of the
dimensions defines a grid. In the two-dimensional case, each cell has
four breakpoints and is a flat surface.

You can use the Adaptive Lookup Table (2D Stair-Fit) block to model
time-varying systems with two inputs.

Doubles only



Adaptive Lookup Table (2D Stair-Fit)

Dialog
Box

E! Function Block Parameters: Adaptive Lookup Ta

— Adaptive Lookup Table [20] [mazk] [link)

Perfarm adaptive table lookup. Breakpoints relate the coordinate inputs to cell
lozations in the table. The data is used to dynamically update the cell values at
these locations.

— Parameter

First itiput [raowe] breakpoint set:

10,2231 40]

Second input [column] breakpoint set:

10,2231 40]

[~ take initial table an input
Table data (initial):

J[456:161920:10 16 23]

Table rumbering data;

123:456:789)

Adaptation methaod: ISampIe mean [with forgetting) :I
Adaptation gain [0 to 1]

jng

™ Make adapted table an output

[~ Add adaptation enable/dizable/reset port
[~ &dd cell lock enable/disable port

Action for aut-of-range input {lgnare :I

QK I Cancel Help Apply

First input (row) breakpoint set

The vector of values containing possible block input values for the
first input variable. The first input vector must be monotonically

increasing.



Adaptive Lookup Table (2D Stair-Fit)

Second input (column) breakpoint set
The vector of values containing possible block input values for
the second input variable. The second input vector must be
monotonically increasing.

Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (2D
Stair-Fit) block to ignore the Table data (initial) parameter, and
creates a new input port Tin. Use this port to input the table data.

Table data (initial)
The initial table output values. This 2-by-2 matrix must be of size
(n-1)-by-(m-1), where n is the number of first input breakpoints
and m is the number of second input breakpoints.

Table numbering data
Number values assigned to cells. This matrix must be the same
size as the table data matrix, and each value must be unique.

Adaptation method
Choose Sample mean or Sample mean with forgetting. Sample
mean averages all the values received within a cell. Sample mean
with forgetting gives more weight to the new data. How much
weight 1s determined by the Adaptation gain parameter. For
more information, see “Selecting an Adaptation Method” on page
5-42.

Adaptation gain (0 to 1)
A number from 0 to 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port Tout for
the adapted table.

Add adaptation enable/disable/reset port
Selecting this check box creates an additional input port Enable
that enables, disables, or resets the adaptive lookup table. A
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Adaptive Lookup Table (2D Stair-Fit)

See Also

signal value of 0 applied to the port disables the adaptation, and
signal value of 1 enables the adaptation. Setting the signal value
to 2 resets the table values to the initial table data.

Add cell lock enable/disable port
Selecting this check box creates an additional input port Lock
that provides the means for updating only specified cells during a
simulation run. A signal value of 0 unlocks the specified cells and
signal value of 1 locks the specified cells.

Action for out-of-range input
Ignore or Adapt by extrapolating beyond the extreme breakpoints.

Adaptive Lookup Table (1D Stair-Fit), Adaptive Lookup Table (nD

Stair-Fit), “Capturing Time-Varying System Behavior Using Adaptive
Lookup Tables” on page 5-37
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Adaptive Lookup Table (nD Stair-Fit)

Purpose
Library

Description

2-0 T{u})

Adaptive Lookup
Table (nD Stair-Fit)

Data Type
Support

8-10

Create adaptive lookup table of arbitrary dimension
Simulink Design Optimization

The Adaptive Lookup Table (nD Stair-Fit) block creates an adaptive
lookup table of arbitrary dimension by dynamically updating the
underlying lookup table. The block uses the outputs of your system to
do the adaptations.

Each indexing parameter may take a value within a set of adapting data
points, which are called breakpoints. Breakpoints in each dimension
define a cell. The set of all breakpoints in one of the dimensions defines
a grid. In the n-dimensional case, each cell has two n breakpoints and
is an (n-1) hypersurface.

You can use the Adaptive Lookup Table (nD Stair-Fit) block to model
time-varying systems with 2 or more inputs.

Doubles only



Adaptive Lookup Table (nD Stair-Fit)

Dialog
Box

L[] Function Block Parameters: Adaptive Lookup Tz |

— Adaptive Lookup Table [0 [mazk] [link)

Perfarm adaptive table lookup. Breakpoints relate the coordinate inputs to cell
lozations in the table. The data is used to dynamically update the cell values at
these locations.

— Parameter

Murnber of table dimensions:
E

T able breakpaints [cel aray]:
|{[1 0,22,31.40], [10.22,31.40]}

[~ take initial table an input
Table data (initial):
J[456:161920:10 16 23]

Table rumbering data;
123:456:789)

Adaptation methaod: ISampIe mean [with forgetting) :I

Adaptation gain [0 to 1]
jng

™ Make adapted table an output
[~ Add adaptation enable/dizable/reset port
[~ &dd cell lock enable/disable port

Action for aut-of-range input {lgnare :I

QK I Cancel Help Apply

Number of table dimensions
The number of dimensions for the adaptive lookup table.

Table breakpoints (cell array)
A set of one-dimensional vectors that contains possible block
input values for the input variables. Each input row must be
monotonically increasing, but the rows do not have to be the same
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length. For example, if the Number of table dimensions is 3,
you can set the table breakpoints as follows:

{f1t 23], [57], [1357]}

Make initial table an input
Selecting this check box forces the Adaptive Lookup Table (nD
Stair-Fit) block to ignore the Table data (initial) parameter, and
creates a new input port Tin. Use this port to input the table data.

Table data (initial)
The initial table output values. This (n-D) array must be of size
(n-1)-by-(n-1) ... -by- (n-1), (D times), where D is the number of
dimensions and n is the number of input breakpoints.

Table numbering data
Number values assigned to cells. This vector must be the same
size as the table data array, and each value must be unique.

Adaptation method
Choose Sample mean or Sample mean with forgetting. Sample
mean averages all the values received within a cell. Sample mean
with forgetting gives more weight to the new data. How much
weight is determined by the Adaptation gain parameter. For
more information, see “Selecting an Adaptation Method” on page
5-42.

Adaptation gain (0 to 1)
A number from 0 to 1 that regulates the weight given to new
data during the adaptation. A 0 means short memory (last data
becomes the table value), and 1 means long memory (average all
data received in a cell).

Make adapted table an output
Selecting this check box creates an additional output port Tout for
the adapted table.
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See Also

Note The Adaptive Lookup Table (n-D Stair Fit) block cannot
output a table of 3 or more dimensions.

Add adaptation enable/disable/reset port
Selecting this check box creates an additional input port Enable
that enables, disables, or resets the adaptive lookup table. A
signal value of 0 applied to the port disables the adaptation, and
signal value of 1 enables the adaptation. Setting the signal value
to 2 resets the table values to the initial table data.

Add cell lock enable/disable port
Selecting this check box creates an additional input port Lock
that provides the means for updating only specified cells during a
simulation run. A signal value of 0 unlocks the specified cells and
signal value of 1 locks the specified cells.

Action for out-of-range input

Ignore or Adapt by extrapolating beyond the extreme breakpoints.

Adaptive Lookup Table (1D Stair-Fit), Adaptive Lookup Table (2D
Stair-Fit), “Capturing Time-Varying System Behavior Using Adaptive
Lookup Tables” on page 5-37
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CRMS

Purpose

Library

Description

Continuous
RMS

CRMS

See Also

8-14

Compute continuous-time, cumulative root mean square (CRMS) of
signal

Simulink Design Optimization

Attach the CRMS block to a signal to compute its continuous-time,
cumulative root mean square value. Use in conjunction with the Signal
Constraint block to optimize the signal energy.

The continuous-time, cumulative root mean square value of a signal
u(t) is defined as

RM.S =

The R.M.S value gives a measure of the average energy in the signal.

DRMS, Signal Constraint



DRMS

Purpose
Library

Description

Driscrete
RS

DRME

See Also

Compute discrete-time, cumulative root mean square (DRMS) of signal
Simulink Design Optimization
Attach the DRMS block to a signal to compute its discrete-time,

cumulative root mean square value. Use in conjunction with the Signal
Constraint block to optimize the signal energy.

The discrete-time, cumulative root mean square value of a signal u(z,)
is defined as

1Y 2
RM.S = |- |u@)
pvﬁd

The R.M.S value gives a measure of the average energy in the signal.

CRMS, Signal Constraint
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8-16

Purpose
Library

Description

Signal Constraint

See Also

Specify desired signal response
Simulink Design Optimization

Attach a Signal Constraint block to the signal in a Simulink model

to optimize the model response to known inputs. Simulink Design
Optimization software tunes parameters in the model to meet specified
constraints. The constraints include bounds on signal amplitudes and
matching of reference signals. The constraints are applicable to vector-
and matrix-valued ports, in which case the signal bounds and reference
signals apply to all entries of the signal/matrix.

For more information on how to use this block, see “Optimizing
Parameters Using the GUI” on page 3-3.

CRMS, DRMS



Examples

Use this list to find examples in the documentation.



A Examples

Parameter Estimation

“Example — Estimating Initial States of a Mass-Spring-Damper System”
on page 2-67

“Example — Estimating Parameters and Initial States at the Command
Line” on page 2-84

Parameter Optimization

“Example — Optimizing Parameters for Model Robustness Using the GUI”
on page 3-49

Optimization-Based Linear Control Design

“Example — Frequency-Domain Optimization for LTI System” on page 4-9

Lookup Tables

“Example — Estimating Lookup Table Values from Data” on page 5-6
“Example — Estimating Constrained Values of a Lookup Table” on page
5-20

“Example — Modeling an Engine Using n-D Adaptive Lookup Table” on
page 5-44
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